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Getting Started

Welcome to Switchvox, the world’s most powerful, yet easy to configure IP-PBX.

This documentation describes the Switchvox installation process, how to get started, and how to use the Web-based
Switchvox Admin Tool Suite.

Throughout this document, we refer to the Admin Suite menu options as a path, using >’. Instead of saying “select the
Manage Extensions option from the Extensions menu in the navigation bar, we say “select Extensions > Manage
Extensions.”

Installing Switchvox

To install Switchvox, first set up your Appliance according to its instructions. That will include a network connection, and
a power supply. Once you have set up your Appliance, the Switchvox software takes a few moments to start up.

When the LCD Panel displays Press any key, Switchvox is ready to be configured.
1. Press any key.
2. Use the Up and Down arrow keys to select Configure Network, then press the green checkmark.
3. Use the Up and Down arrow keys to select Set DHCP/Static, then press the green checkmark.
4. Use the Left and Right arrow keys to select DHCP or Static, then press the green checkmark.

We recommend using a Static IP address. Because Switchvox is a server, it is important that you assign it an IP
address that does not change after it has been configured and users are connecting to it. For details, see Using a
Static IP Address.

If you use DHCP (Dynamic Host Configuration Protocol), we recommend that you configure your DHCP server to
reserve an |IP address just for Switchvox. For details, see Using DHCP.

5. Use the Up and Down arrow keys to select View System Info. This displays the URL of the Switchvox Admin Tool
Suite. You can go to any computer on your network, open a Web browser, and go to this URL. For details, see About
the Admin Suite.

Using a Static IP Address

If you are using a Static IP address, you need your IP addressing information: |P address, subnet mask, gateway (or
router), and DNS server. If you do not have this information, ask your network administrator.

Note: Tofind an IP address that is not in use on your network and will not be used for another client by the DHCP server
or used by some other devices, go to the following web site and look at the information for your particular router:
http://www.portforward.com/routers.htm

To select each addressing item, use the Up and Down arrow keys on your LCD Panel.

When you are done setting the IP addressing information, use the Up and Down arrow keys to select Save Net Settings.
Now the network is configured, and you can complete the installation process (go back to Installing Switchvox).

IP Address
The IP address provided by your network administrator.

Use the Left and Right arrow keys to place the cursor, and the Up and Down arrow keys to change the numbers.
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Netmask
By default, the netmask is 255.255.255. 0. If your netmask address is different, change it to the correct value.

Use the Left and Right arrow keys to place the cursor, and the Up and Down arrow keys to change the numbers.

Gateway
The address for your gateway is usually the IP address of your router. A common gateway IP address is 192.168.0.1.

Use the Left and Right arrow keys to place the cursor, and the Up and Down arrow keys to change the numbers.

DNS Server
This address is for a server inside your network or a server your Internet Service Provider (ISP) runs for you. If your ISP

runs your DNS, the network administrator there can provide this address.

Use the Left and Right arrow keys to place the cursor, and the Up and Down arrow keys to change the numbers.

Using DHCP

If your router can assign |IP addresses using DHCP, then you can use this method to assign the Switchvox IP address.
Your router needs to know the MAC address of the active network card in the Switchvox server. This MAC address is
displayed on the Switchvox server screen as a series of six number or letter combinations separated by colons (e.g.,
00:11:11:AF:2A:EA). On your router, follow the instructions for entering this MAC address. Each time Switchvox is
rebooted, it gets the IP address. Because DHCP works differently on different routers, we can’t offer instructions for how
to set up your router. We suggest that you contact your router's manufacturer or look in your router’s user manual.

After you select DHCP, use the Up and Down arrow keys to select Save Net Settings. Now the network is configured,
and you can complete the installation process (go back to Installing Switchvox).

Installing the Software from CD-ROM

Place the Switchvox Installation CD-ROM in the Appliance’s CD-ROM drive and then reboot. You are prompted to start
the installation process by pressing enter on your keyboard.

Setting the Time Zone

After you start the installation process, a map is displayed. Select a location on the map that indicates the time zone in
which Switchvox will operate.

If you select the incorrect time zone, or you move to a different time zone later, you can change it after Switchvox is
installed.

Setting the time zone is particularly important for generating accurate call reports.

Formatting the Hard Drive and Installing the Software

After you select a time zone, the system formats the hard drive and installs the software. When that is complete, you are
prompted to reboot. First remove the installation CD from the drive, and then press enter on your keyboard to reboot.
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Basic Server Functions

There are several functions that can or must be done at the Switchvox server; those functions are listed here. Use the
LCD Panel on your Appliance if there is one, or connect a keyboard and monitor to the Appliance.

1. View System Info
This displays the URL of the Switchvox Admin Tool Suite.
2. Configure Network

This lets you change your network settings. These are the same options that you used when you first set up your
Switchvox server (see Installing Switchvox). You can only do this from here at the server.

3. Reboot PBX
This reboots Switchvox. You can also do this from Machine Admin > System Reload (see System Reload).
4. Shutdown PBX

This shuts down Switchvox and turns off the power on the appliance. You can also do this from Machine Admin >
System Reload (see System Reload).

5. Reset HTTPS certificate
This resets your SSL certificate. You can only do this from here at the server.
6. Tech Support Access

This lets Switchvox technical support representatives log into your Switchvox Appliance. You can also do this from
Diagnostics > TSR Report (see Tech Support).
7. 3MB| Restore Web Access

This restores local network access to the Web-based Switchvox Admin Tool Suite. If you tured off this access in
the Local Network rule in Access Control, you can turn it back on using this option. You can only do this from here at
the server.

8. Reset Admin Passwd

This resets the main Admin password (user name ‘admin’) to admin, which is the default password. You can only do

this from here at the server.
9. Unblock Local IPs

This removes the block(s) for the local network. That means any Blocked IPs where the first 3 sets of digits match
the first 3 sets in Switchvox's IP (e.g., a/24 CIDR). You can only do this from here at the server. (See also: Blocked
IPs.)

10Change LCD Passwd

This lets you set or change the password for the LCD Panel. If you cannot remember your LCD password, you can
clear it using the Admin Suite (see Managing Physical Access to the Server). You can only do this from here at the
server, and it is only available if you have an Appliance with an LCD Panel.

11Lock LCD

This immediately puts the LCD Panel in password-request mode. You can only do this from here at the server, and it
is only available if you have an Appliance with an LCD Panel.
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About the Admin Suite

The Switchvox Admin Tool Suite (the Admin Suite) lets you administer Switchvox via a Web browser.

Logging Into the Admin Suite

On a computer that is on the same network as Switchvox, open a Web browser and enter the URL of the Admin Suite
(see The Switchvox Admin Suite URL).

https://YourServerIPaddress/admin

The Login page for the Admin Suite is displayed.

Please log in to use the Tool Suite

dser Mame: |a|:|r'r'|ir‘| |

Fassword: |-----| |

The first time you use the Admin Suite, enter the default User Name and Password, and click Log In.

e User Name: admin
* Password: admin

For security, you are prompted to change the default password to a secure password. The strength of your new password
is indicated as you type, to help you create a good password.

The next time you go to the Admin Suite, log in using the User Name admin and your new password.
After you log in, the main page of the Admin Suite is displayed.
Note: If you have forgotten your password, see Basic Server Functions.

To log out of the Admin Suite, click Logout (in the upper right-hand corner).

Navigating the Admin Suite

The Admin Suite navigation bar contains the following dropdown menus:

Extensions
Manage all of your extensions and extension templates, specify extension settings, and manage extension groups and

permissions.

PBX Features
Set up and manage options such as music on hold, time frames, and IVR menus.

System Setup
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Configure hardware, channels, incoming call rules and routes, and other settings that form the foundation of your
Switchvox PBX.

Diagnostics
See logs and reports, and troubleshoot Switchvox.

Machine Admin
Modify your network settings, manage system backups, apply updates, and more.

Getting Help

Click any help link to open a pop-up window with information about a particular tool. Help links are available as question-
mark icons and as text links.

EI How do I use this page?

If a pop-up window does not display, set your Web browser to allow pop-ups from the domain of your Switchvox server.

Registering Switchvox

After a new install, you are required to register Switchvox to make it fully operational. Select Machine Admin > Product
Registration to display the Product Registration page.

Enter your contact information and Registration Code. The contact information you provide is useful if you need to call on
our technical support services. Your 16-character Registration Code is located on the Switchvox CD-ROM case. Be sure
to enter it exactly as shown, including capitalization, with four characters in each of the four boxes.

Click Submit to register Switchvox with the registration management system.
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Extensions PBE* Features Systermn Setup Diagnostics

Product Registration

IUse the form below to register your PBX.

Company Mame: (required)

Phone Mumber: (required)

Address Line 1: (required)

Address Line 2:

City: (reguired)

State: (required)

—Fleasze selecta country first —

Zip Code: (required)

Updating Switchvox

Before you start using Switchvox to make and receive calls, be sure that you are running the newest version of the
software. Select Machine Admin > Updates.

If the Updates page says that no updates are available for your system, then you already have the newest version of the
software.

If there is an update listed on this page, you should apply the update before you begin to use Switchvox.

For details, see Updates.

Supported Phones

Switchvox supports two general types of handsets: SIP/VOIP phones and standard analog phones (as you might use in
your home). Voice Over Internet Protocol (VOIP) is the generic name for any technology that allows transmission of a
voice telephone conversation over a network, whether it is a local network or over the internet.
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SIP Phones

SIP phones are digital phones that convert and send your phone calls to Switchvox through your Ethernet network.
Outwardly, they look like typical office telephones. Some SIP phones have two Ethernet connections, so that you can
connect your PC to the network through the phone. You can also use a softphone, which is software that acts like a
phone.

Analog Phones

Analog phones need an Analog Telephone Adapter (ATA) to connect to Switchvox. The ATA converts the signals sent by
the handset into a digital signal then sends it the same way a SIP phone sends its signal. An alternative to using ATAs is
to use a channel bank. A channel bank is hardware typically used on legacy phone systems. One channel bank can take
a set of 24 analog phone lines and turn them into one T1 line that can be connected directly to Switchvox via an add-in
card.

Analog phones require no configuration; however, depending on the method you use to connect the analog phones to
Switchvox, you may have to configure either an ATA or a channel bank. If you purchased your ATA with Switchvox, it is
preconfigured. If you are using a channel bank, you need to wire all the phones into the channel bank, configure the
channel bank to communicate with the phones, then add the lines to Switchvox (see Hardware Setup and Channel Admin

).

Video Phones

Video phones are digital phones that convert and send your video calls to Switchvox through your Ethemet network.
Switchvox supports video calling over a SIP provider, and works with a number of video clients including desk phones
and softphones.

Making Your First Call

If you purchased your phones along with Switchvox, then plug each phone into your network and turn it on. When a phone
displays the date and time and its extension number, it is ready for use.

If you did not purchase your phones along with Switchvox, then you need to set them up for use with Switchvox. For
instructions on how to do this, see Phone Setup.

When your phones and extensions are ready, pick up one of the handsets and dial 800, which rings a sample Interactive
Voice Response (IVR) menu. The call should connect and you should hear a recorded voice say “congratulations,
Switchvox has been configured properly.”

s About Faxing

Switchvox lets you send and receive faxes. You can send a fax from your fax machine, or send a file from your computer
to a fax machine. Incoming faxes are sent to a Switchvox extension, and can be found in that extension’s Mailbox.

IMPORTANT: We strongly recommend handling faxes over an analog or PRI channel, or over a SIP provider using T.38.
If this is not possible, then you should set up dedicated extensions for incoming and outgoing faxes. If you do not use
analog, PRI, or T.38 over a SIP provider, incoming fax detection and fax quality could be less than optimal.
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To enable faxing capabilities, you must first install your Fax license and the related Fax software (go to Machine Admin
> Digium Addon Products).

Incoming Faxes

You can enter a Default Fax extension for each Channel Group or SIP Provider. When a fax comes in, the fax is routed
to this extension.

You can set up an Incoming Call Route so that one phone number (DID) can handle someone’s voice calls and faxes.
This sends incoming faxes to the extension’s Fax folder, and incoming voice calls to the extension’s phone.

You can also set up an Incoming Call Route so that all activity on a phone number (DID) is treated as a fax and sent to the
same extension. This is useful if you want or need a dedicated incoming fax extension.

For more details, see Incoming Call Routes.

Outgoing Faxes

If you want to use a fax machine, you can dedicate its extension to just sending faxes. In that case, Switchvox handles
all outgoing activity as a fax (prints a fax-file, puts it in the Fax.Outbox folder in that extensions’s Mailbox, and sends the
fax). For details, see the User Suite This extension only sends faxes. You can also set up a Feature Code extension that
lets you send a fax from your fax machine, and put the fax into another extension’s Outbox. For details, see Feature Code
Extensions.

If you want to fax files from your computer, you need to set up a printer driver on your computer. Each Switchvox user can
set up a printer driver for a dedicated outgoing fax extension, or for their own extension (or both). With the former, outgoing
faxes are found in the dedicated extension’s Mailbox. With the latter, outgoing faxes are found in the user’'s Mailbox. For
details, see the User Suite Creating & Sending a Fax.

s About Chatting

Switchvox includes an XMPP-based Jabber server for presence and real-time communications. You can use your
favorite XMPP-based client to interact with the server, or the Switchboard offers a Chat panel. The main page of the Chat
Panel offers a list of people you can double-click to start a chat.

You may want to set up a DNS entry with a hostname for your Switchvox Jabber server. You can set the Jabber
hostname in the Network Settings (Machine Admin > Network Settings). If you are using peered Switchvoxes, you
can also set the peer's Jabber hostname in its VOIP Provider information.

About Video Calling

Video calling is available over a SIP provider. For call quality, we recommend using the same kind of phone on both ends
of the call. If you are using softphones (software for making telephone calls over the Internet), we recommend using the
same software on both ends. Also, make sure that you have installed the latest updates for your phone.

IMPORTANT: Video calling is not available over IAX. It is available over peered Switchvox servers, but all servers must
be running Switchvox SMB 4.0 (or later). If there is a point in the call where IAX or an older version of the Switchvox
software is involved, the video portion of the call will be dropped and only audio will be available.
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Extensions

The Extensions tools let you manage the extensions on your system, add new ones, and use templates and settings to
customize your extensions.

Manage Extensions

Extensions are the numbers used by Switchvox to send a caller to various destinations. There are many different types of
extensions, including extensions for phones, IVRs, call queues, etc.

The Manage Extensions tool shows the extensions that are currently in Switchvox, and lets you create, edit, and delete
extensions.

When you first set up Switchvox, there are several predefined extensions. We suggest that you leave those extensions in
place until you are sure that you do not want to use them.

Viewing Extensions

There are several ways to view the extensions in Switchvox. By default, you see all of the extensions, listed by extension
number in ascending order, with 50 extensions per page.

To limit the types of extensions in the list, select an extension type from the View dropdown and click Go. The list
redisplays with only extensions of that type.

To find a particular extension, use the Search box. Enter at least 3 numbers of the extension, or at least 3 letters of the
first or last name. The list is narrowed down to just the extensions that match.

To sort the table by a column, click on the column name.

Password Warnings

There are warning icons next to some or all of your extensions because the passwords chosen for these extensions are
weak. Weak passwords can make your Switchvox vulnerable to intrusion.

By default, Switchvox requires that strong passwords are used for extensions and phone-registrations. But, you may
have some passwords that were created prior to that requirement, or you may have turned that requirement off. For details
about requiring strong passwords, see Extension Settings

For details about setting an extension password, see Numeric Password. For details about setting a phone-registration
password, see Phone Password.

)

The extension password and the phone password are weak.

b

The extension password is weak.

a

The phone password is weak.
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Extension Types

There are many different types of extensions in Switchvox.

The three phone and virtual extension types (SIP, Analog, and Virtual) have most of the same settings and they have a
corresponding User Suite account. Other types of extensions do not have a user name and password for a User Suite
account.

* Phone and Virtual Extensions

* IVR (Interactive Voice Response) Extensions
» Simple Conference Room Extensions

» Meet-me Conference Center Extensions
»  Group Pickup Extensions

* Intercom/ Paging Extensions

» Directory Extensions

» Voicemail Access Extension

» Call Parking Extensions

» Dial Tone Extensions

» Feature Code Extensions

» Call Queue Extensions

* Agent Log In Extensions

* Agent Log Out Extensions

Creating One Extension

To create one extension, click Create A New Extension.
Select the type of extension from the dropdown.

If you are creating a phone-type extension, you also need to select the Extension Template to use. Leave this as Default
if you have not created your own templates.

If you are creating a feature-code type of extension, you also need to select the Feature Type.

Click Create at the end of the page to create the new extension and display the settings page. When you have completed
the settings, click Create Extension to save the extension and go back to the Manage Extensions page.

Phone and Virtual Extensions

The settings are mostly the same for SIP phones, analog phones, and virtual extensions. Phone and virtual extensions
have a corresponding User Suite account.

SIP Phone or SIP Adapter for Analog Phone (ATA)
A SIP phone, or an analog phone plugged into a SIP Adapter (e.g., Sipura SPA-1001).

Analog Phone
A regular phone (not VOIP/SIP) that is physically plugged into the Switchvox server. This is an appropriate extension-
type for a fax machine or an intercom.
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We strongly recommend that you do not use this option for your phone extensions. We recommend that you use analog
telephone adapters, or a channel bank. If you choose to use Analog Phone extensions, with phones physically plugged
into Switchvox, those phones will not be able to take full advantage of Switchvox's features.

Virtual Extension

An extension without a phone. This type of extension behaves like a SIP Phone extension,except that it does not have a
Switchboard and it does not show the phone as Unreachable in System Status. This is useful as a general voicemail
box, or for call rules that always cascade to someone’s personal phone (so that the caller doesn’t need to know your
personal number).

Extension Settings
The Extension settings include basic information about the extension and the person who uses it.

Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

FXS Channel

This is for Analog Phone extensions only. Select the channel that the phone is plugged into. If the only option here is
Unconfigured Channel, then you need to configure your hardware device channels before this phone can work (see
Channel Admin).

First Name

Enter the first name of the owner of this extension. This is the name that is used in the caller ID name, and as the
extension’s identification throughout Switchvox. Check the User can edit box if you want the extension owner to be able
to modify this setting.

Last Name

Enter the last name of the owner of this extension. This is the name that is used in the caller ID name, and as the
extension’s identification throughout Switchvox. Check the User can edit box if you want the extension owner to be able
to modify this setting.

Email Address
Enter the email address of the owner of this extension. This is used to send voicemail notification messages. Check the
User can edit box if you want the extension owner to be able to modify this setting.

Numeric Password

Enter a Numeric Password for this extension. The extension owner uses this to log into their account in the User Tool
Suite. The strength of the new password is indicated as you type (although in this case you may be setting a generic
password for the owner to log in for the first time). Re-enter the password for verification.

Check the User can edit box if you want the extension owner to be able to modify this setting. You can require that the
extension-owner enter a strong password. For details, see Require Strong Extension Passwords

Note: This password is numeric because it will be entered from the numeric keypad on a telephone.

Force user to update password on next login

This is a security precaution. It lets you create all extensions with a generic password (such as the extension number),
which lets the extension owner easily log in for the first time. But then it forces that person to create a new password
before continuing to use the software. (See also: Require Strong Extension Passwords.)

Language and Locale

The Switchvox web-based tool suite is available in several languages:
= English for United States
&% English for United Kingdom
— Spanish for Spain

:0 Spanish for Mexico
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[ 1 ltalian
To set your preferred language:
1. Select a language from the dropdown.

2. Select alocale for that language.

If you choose to use a language other than English for US, be aware that all other languages and locales handle dates
with the format of dd/mm/yyyy (as opposed to mm/dd/yyyy).

By default, new extensions are created as English for US, with English as the Sound Prompt Language. If you want new
extensions to default to your preferred language, use Extension Templates.

Force user to confirm language on next login
If you are not sure which language this extension prefers to use, force the owner to choose a language the next time he or

she log in. This way, extension owners can decide for themselves which language to use, and you know that they made a
deliberate choice.

Sound Prompt Language
If there are one or more sound packs available in different languages, those languages are available in this dropdown.

Select the language that this extension hears (e.g., when calling the voicemail access extension, the prompts are in
[talian).

To obtain sound packs for different languages, go to Machine Admin > Digium Addon Products and click Switchvox
Product Addons.

For instructions on using sound packs, see About Sound Packs.

Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an Advanced
Option, click Show Advanced Options.

Voicemail/Fax Mailbox Quota (MB)
Enter a number of megabytes here to set a disk-space quota. This is the maximum number of megabytes that can be

used for voicemail messages and faxes. This value can be set for extensions and extension groups.
* If you leave this blank, it indicates unlimited space.
* If you enter a 0 (zero), it indicates that no voicemail or faxes can be stored.
* If aquotais set for a group or groups, and for an extension in the group, the extension's mailbox quota is used.
« If an extension is a member of multiple groups, the lowest mailbox quota is used.
« If an extension is not allowed to have voicemail, this setting is not relevant.

This extension can be dialed from an IVR
Check this option to let IVRs dial this extension. [VR menus must also have the Allow Extension Dialing option

enabled (see Adding & Modifying IVR Options).

Phone Settings
This section is only for SIP Phone or SIP Adapter for Analog Phone (ATA) extensions.
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ﬂ Phone Settings

DTMF Mode | fc2833 [Default) + |
IEI Whatis DTHMF Mode?

[ Click to Show Advanced Options

DTMF Mode
DTMF tones are the sounds emitted when you press buttons on your phone.

» SIP extensions: Refer to your phone's user manual for the DTMF mode that your phone uses.
» SIP providers: Ask your provider which DTMF mode it supports.

If you are unsure of which DTMF mode to select, use RFC2833 (the most common method).

Phone Password
Enter your phone password and verify it. (See also: Require Strong Phone Passwords.)

This is the Authentication Password that your SIP phone uses for registration with Switchvox.

This password may be different than the password that you use to login to administer your SIP phone through the
manufacturer’s interface. Also, this password does not change when the user changes the voicemail password.

Supported Codecs
Select the codecs your phone supports. Check your phone’s user manual if you do not know them.

For video, H.263 and H.264 are on by default.

For audio, ULAW, ALAW, and G722 generally work with every phone and provide the best sound quality. They are
selected by default.

The following table describes the audio codecs. If you have Switchvox SMB and you have entered a License key for the
G729 Codec in Machine Admin > Digium Addon Products, you will also see G729 in the list of codecs.

Table 1: Audio Codecs

Bandwidth
Codec Usage Sound Quality [CPU Usage
(kbits/s)
ULAW 85 Great None
ALAW 85 Great None
G722 85 Excellent Low
G726 54 Good Low
SPEEX 33 Great High
GSM 35 Good Low
ADPCM 54 Good Low
LPC10 22 Poor Medium
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Phone NAT Traversal
This option controls how Switchvox communicates with the phone if it is behind a router performing Network Address
Translation (NAT). The following options are available:

Always. Select if you are unsure if the phone is behind a router performing NAT.

No. Select if Switchvox is behind NAT but the phone is not.

Never. Select to prevent attempts to translate even if the handset requests it with the rport tag.
Route. Select to send responses symmetrically, but not to include the rport tag in the Via header.

Call API Settings

The call creation API lets external applications originate phone calls via Switchvox. The API is accessed by requesting a
specially formed URL. This request could come from an external program or by typing the URL into your web browser. To
use this feature, check with your Switchvox administrator.

Profile Information

An Extension Profile includes some or all of the following:

Justine Kilean

* Image . .

* Firstand Last Name teotntilanager

- Title Extension: 101 00 &8 &9
* Location Location: San Diego

* Extension Number

Profiles can be shown in the Switchboard and on a phone

that uses a Phone Feature Pack. For details, see Your
Phone Feature Pack.

To add a picture:
1. Click Add an image.

2. Click Browse, and then find the image file on your computer.
Images must be at least 75x100 pixels, and must be in jpg format.

3. Click Upload.
The image is uploaded and displayed with the crop area that will be used to make a 75x100 image. You can move the
crop area around to choose the best portion of the picture. The Preview on the right shows you what the picture will
look like once it is cropped.

4. Click Save Image.
5. Click Save Extension Settings.

To upload a different picture, re-crop the existing picture, or delete the existing picture:
1. Click View Image.

2. Click ReCrop, or Delete.
If you want to upload a different image, Delete this image now, and then click Add an image to start again.

3. Confirm your changes.

4. Click Save Extension Settings.

Check the appropriate boxes if you want the extension owner (user) to be able to change his or her Location, Title, or Pic-
ture.

Enable PBX Features

These settings let you specify which features the extension is allowed to use.
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E Enable PBX Features for sip Extension 201
IEI See a bref descHption of these features

M voicemail VWeb Tool Access Mvoicemail attachments
[ elock Calls [¥] secret Code Unpark Calls
Forward Calls Cascade Calls Ring-all Qption

[voicemail Forwarding [ custom voicemail Email Switchboard Chat

Record Calls SIP Phone &pplications [ mMabile Applications
Lse Ringtones Upload Ringtones
Voicemail

Let this extension send unanswered calls to their voicemail Mailbox.

Web Tool Access

Let this extension log into the Switchvox User Tool Suite. If this is not enabled, this extension cannot connect to Switch-
vox using the Extend API.

Voicemail Attachments
Let this extension attach the voicemail sound file to the voicemail notification email message. Otherwise, the extension-
owner has to use his phone or the User Suite to listen to voicemail messages.

Block Calls
Let this extension set up Call Block Rules for blocking a call by prefix, area code, specific phone numbers, etc.

Secret Code
Let this extension set up Call Rules with a secret code.

Unpark Calls
Let this extension retrieve calls that have been parked.

Forward Calls
Let this extension set up Call Rules that forward a call to another phone number or extension.

Cascade Calls
Let this extension set up Call Rules that cascade a call to another phone number or extension. When you cascade a call,
if the call is not answered then the next Call Rule is applied.

Ringall
Let this extension set up Call Rules that ring several phone numbers or extensions at once.

SMB/| Voicemail Forwarding
Let this extension automatically forward all of its voicemail messages to another extension or extension group.

Custom Voicemail Email
Let this extension customize the email message templates used for its voicemail notifications.

SMB| Switchboard Chat
Let this extension open and use the Switchboard Chat Panel.
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Record Calls
Let this extension record its own calls. An extension-owner can record his or her own calls using the Switchboard Current

Calls panel's Record button. The recording is sent to the extension's voicemail Mailbox.

SIP Phone Applications
Let this extension use the Switchvox tools on its SIP Phone: Directory, Voicemail Mailbox, Parking Lots, Phonebooks,
and Record Call.

SMB| Mobile Applications
Let this extension use the Switchvox Mobile Applications.

For information about Mobile Applications, see the web page Switchvox Add-ons.

Use Ringtones
Let this extension create its own Ring Rules. For details, see the User Suite's Distinctive Ring Rules.

Upload Ringtones.
Let this extension upload its own ringtones. For details, see the User Suite's Distinctive Ringtones.
Outgoing Call Rules

Specify which of the outgoing call rules you want this extension to be able to use. Check Allow to allow this extension to
use the rule. Check Deny to deny this extension use of this rule. Leave both boxes unchecked to let this extension
bypass this rule. For details, see Outgoing Call Rules.

ﬂ Outgoing Call Rules
IEI Help with outgoing call rules

Rule Mame Allows Deny
International [l
1-900 Numbers [
Toll Free A
Long Distance Il
Local A
911 O
Internal A

If you deny access to a rule, the call will not be completed, and the caller will hear a message that they cannot make that
call. If you bypass arule, the call is passed to the next outgoing call rule, if one is available.

SMB| Extension Groups

Select the groups this extension belongs to. To select multiple groups, hold down the CTRL key. For more information,
see Extension Groups.
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IVR (Interactive Voice Response) Extensions

An extension that presents a menu to the caller, or performs an action. (This is also known as ‘Auto-Attendant’ in some
PBX systems.) For example, it could ask the caller to press 1 for directions, or press 2 to hear the company directory. Or,
it could say that everyone is in a meeting, then send the call to voicemail. For informationabout setting up IVRs, see IVR
Editor.

You must have an IVR menu to assign to an IVR extension. The IVR extension 800 is preconfigured with the IVR menu °
Example IVR,” which you can use as a basis for your custom IVRs.

Extensions PB= Features Systermn Setup Ciagnostics

Manage Extensions

IR Extension 200

VR Menu Mame | tain VA v
Which IWR zhould thizs extenszion play?

IR Menu Entry Point | VR Menu Beginning w
Which action should it start plaving?

This extension can be dialed from an IVE.
E What does this mean?

Modify Extension

IVR Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

IVR Menu Name
Select the IVR menu that you want use when this extension is called.

IVR Menu Entry Point
Select an Action that is in the IVR menu. (You don’t have to start at the beginning of the menu.)

This extension can be dialed from an IVR
Check this option to let IVRs dial this extension. [VR menus must also have the Allow Extension Dialing option

enabled (see Adding & Modifying IVR Options).

Simple Conference Room Extensions

This extension provides a single conference room for anyone who calls or is transferred to this extension.
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Extensions PB= Features Systemn Setup Diagnostics

Manage Extensions

Conference Room Extension I:I
4 digitz in length

[] This extension can be dialed from an VR,
E What does this mean?

] play sound when people enter and leave
] Play Music ©n Hold when only 1 person is in the conference

Conference participants may press # to be sent to extension |:| 2

Create Extension

Conference Room Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

This extension can be dialed from an IVR
Check this option to let IVRs dial this extension. IVR menus must also have the Allow Extension Dialing option
enabled (see Adding & Modifying IVR Options).

Play sound when people enter and leave
Check the box if you want this to be true.

Play Music On Hold when only 1 member is in the conference room
Check the box if you want this to be true.

Conference participants may press # to be sent to extension
Enter the extension number if you want this to be true.

sme| Meet-me Conference Center Extensions

This extension provides an access point to each user’s conference room. Callers to this extension are prompted for a PIN
corresponding to a specific user’'s conference room. (See the User Suite Conference Setup.)
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Extensions PB* Features Systern Setup Diagnaostics

Manage Extensions

Meet Me Conference Center Extension I:I
2 digitz in length

[] This extension can be dialed from an IvR.
|E| What does this mean?

after | Unlimited (% | invalid conference room number attempts route caller to extension |:|

Create Extension

Meet Me Conference Center Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

This extension can be dialed from an IVR
Check this option to let IVRs dial this extension. [VR menus must also have the Allow Extension Dialing option

enabled (see Adding & Modifying IVR Options).

After [] invalid conference room number attempts route caller to extension []
Select the number of attempts and enter the extension number if you want this to be true.

sms, Group Pickup Extensions

A Group Pickup extension can pick up a call ringing on another extension. For example, assume that the Group Pickup
extension is 110, the authorized extension is 111, and the group includes extension 112 and 113, in that order. If
extension 112 is ringing, dialing 110 from extension 111 picks up the call ringing on 112. If extensions 112 and 113 are
ringing, extension 112 is picked up (calls are picked up in the same order as the extensions are listed).

Group Pickup Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

Group Pickup Users and Admins
Put individual extensions into the Group Pickup Admins box, or select an extension group to give that entire group
authorization to use this extension.

Extensions that will be picked up
Put individual extensions into the Group Pickup Members box, or select an extension group to make all of the extensions
in the group be members.
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Extensions

Manage Extensions

ﬂ Whatis a group pickup extension?

Bl  Group Pickup Settings

PB= Features

Group Pickup Extension

2 digits in length

L]

Systermn Setup

Fi Group Pickup Users and Admins

Extensions authorized to use this group pickup extension

® Use Individual Extensions

all Available Accounts

Group Pickup Admins

1040 "Shipping " Y
1080 "Accounting "'

1080 "Spencer Flemming''

1081 "Mewton Degenhardt”

1082 "webster S avage"

1083 "Pozey Podaolzky!

1084 "Ortiz Schuster"!

1085 "Harvey Culver"

1086 ""w'ebb Sanderson”

1087 "Marriz Madzen” hd

EaN

2002 "D ave Miller"

-OR-
(O Jse a Predefined Group:

Extensions that will be picked up
&) Use Individual Extensions

all Available Accounts

Group Pickup Members

1083 "Pozey Podolsky ~
1084 "Ortiz Schuster

1085 "Harvey Culver"

1086 "w'ebb Sanderson'

1087 “Morriz Madzen

1088 "Moon Bradley"!

1083 "Corveay b agee"

1090 "Murphy bMeCaig

1432 “Adrian Test"

2002 "Dave Miller b

o

1096 "Direws Palk"

1095 "Jeff b ars"

1094 ""Yance Davenport”
1093 ""Windham Stephens"
1091 "Kruze Lesher"

1092 "Marlow Shumard"

_DR_
O use a Predefined Group:

Diagnostics
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Intercom / Paging Extensions

An Intercom / Paging extension can make an announcement on a group of speaker phones. Phones in the group do not
ring, they answer immediately in speaker-phone mode (the caller can begin talking and be heard over the phone’s
speaker).

Note: You must have compatible and correctly configured handsets to use this option.
Extensions PB= Features System Setup Diagnostics

Manage Extensions

ﬂ More about intercom extensions

“ Intercom Settings

Intercaom Extension |:|

2 digits in length

Alert-Info header |Inter|:|:um |
ﬂ What's this?

Timeout | 2 Minutes w |
ﬂ What's this?

Intercom f Paging ® 2-way Intercom O 1-way Paging

Play beep/sound first  ®ves ONo
il What's this?

Choose sound to play:

Folder: | Miscellaneous % | Sound fo Play: | Besp v

Selected Sound Description:

El Intercom Users and Admins

Extensions authorized to use this intercom extension
&) Use Individual Extensions

all Available Accounts Intercorn Adrins

1022 "Moan Bradley" - 2002 "D ave Miller"

1083 "Conway b ages"
10890 "Murphy McCaig"
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Intercom Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

Alert-Info header
The value that is sent to the phone in the alert info header. This setting is required for Polycom phones to auto-answer
intercom calls.

Use a value of Intercom or SVAutoPickup. If you use Intercom, a ringtone will play before the phone auto-answers the
call. With both values, the phone auto-answers and then you hear a tone announcing the call.

Timeout
Select the length of time that the system attempts to connect an intercom call. After this duration, intercom calls that
have not been answered will be hung up.

Intercom / Paging
Specify whether this extension makes intercom calls (2-way conversations) or paging calls (one-way announcements).

Play beep/sound first
Specify whether or not a beep/sound plays to indicate that the call is beginning. If you choose Yes, then you can also

choose a sound to play (select a folder then select a sound file). The Selected Sound Description tells you about the
sound.

Intercom Users and Admins

Use this section to set up which extensions can use this Intercom/Paging extension, and which extensions are called
when this Intercom/Paging extension is dialed.

Extensions authorized to use this intercom extension
Put individual extensions into the Intercom Admins box, or select an extension group to let that entire group use this
extension.

Extensions that will be called
Put individual extensions into the Intercom Members box, or select an extension group to make all of those extensions
recipients of calls to this extension.

Directory Extensions

A Directory extension presents the caller with a directory of all user-type extensions (extensions with a first and last
name). The caller is prompted to type in the first three letters of the party’s first or last name and is presented with a list of
matching extensions.

The Directory extension 411 is preconfigured, and includes the Default Extension Group (which is all phone-type
extensions).
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Extensions PB= Features Systemn Setup Diagnostics

Manage Extensions
Directory Extension: 411

[] This extension can be dialed from an IvR.
EI What does this mean?

If a caller presses the "0" digit they will exit the directary and be forwarded to extension

Let callers search the directory by member's

Directory Members:
O Use Individual Extensions

all Available Accounts Directory Mermbers

107 “duzting Kilean"
102 “Jane Doeson'
103 "Jahn Smith"
104 "Gilbert Brown'
108 “Agrer Wit L8
106 "Spencer Flemrming'

107 "Mewton Degentandt'

108 "wiebster S avage''

109 "Pogey Podolzky

110 "Ortiz Schuster” W

>

L

-OR-

®Use a Predefined Group: | Default Group v|

Modify Extension

Directory Settings
The Director settings determine how callers can interact with the Directory.

Directory Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

This extension can be dialed from an IVR
Check this option to let IVRs dial this extension. IVR menus must also have the Allow Extension Dialing option
enabled (see Adding & Modifying IVR Options).

If a caller presses the “0” digit they will exit the directory and be forwarded to extension []
Enter an extension if you want this to be true.

Let callers search the directory by member’s []
Select from First Name or Last Name.
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Directory Members

Put individual extensions into the Directory Members box, or select an extension group to make all of those extensions
members of the Directory.

Voicemail Access Extension

A Voicemail extension goes directly to the voicemail system where extension owners can check their voicemail. This is
not an extension to leave a voicemail message, it is strictly for retrieving voicemail.

Voicemail extension 899 is preconfigured for you.

Extensions PB X Features Systemn Setup Diagnostics

Manage Extensions

Yoicernail Access Extension: 899

digits in length

L] This extension can be dialed from an VR,
IE' WWhat does this mean?

] Do not require password as long as caller is calling from their own extension.
EI What does this mean?

Modify Extension

Voicemail Access Extension
Enter a unique number for this extension (if you want to use a different extension than 899, first delete the 899 extension,
then create a new ‘Voicemail Access’ extension).

For information about the extension-number length, see Extension Settings.

This extension can be dialed from an IVR
Check this option to let IVRs dial this extension. [VR menus must also have the Allow Extension Dialing option
enabled (see Adding & Modifying IVR Options).

Do not require password as long as caller is calling from their own extension
Check this box if you want this to be true.

Call Parking Extensions

A Call Parking extension ‘parks’ a call so that it can be retrieved from another phone. Users transfer the call to the ‘main’
Call Parking extension, but the call is parked in one of the extensions in the range specified.

Switchvox Administrator Manual



Extensions PB= Features Systemn Setup Diagnostics

Manage Extensions

Zall Parking Extension: 700

Parking lot will reserve all extansions between through .

Feturn parked calls to the extension that parked the call after seconds,

Modify Extension

Parking lot will reserve all extensions between [] and []
Enter the extension numbers to be used for parked calls. A Call Parking extension 700 is preconfigured, and reserves all

extensions between 707 and 799.
For information about the extension-number length, see Extension Settings.

Return parked calls to the extension that parked the call after
Enter the number of seconds that a call should remain parked before returning the call to the extension that parked the

call. The default is 90 seconds.

Dial Tone Extensions

A Dial Tone extension plays a dial tone when it is called.

Dial Tone Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

smB| Feature Code Extensions

A Feature Code extension lets you perform a certain operation by dialing a *, the two-digit feature code, then another
extension.

Go To Voicemail
Directly dials another extension’s voicemail. For example, if you define 56 as the Go To Voicemail feature code, to

transfer a caller to extension 202’s voicemail, simply transfer them to *56202.

SMB| Directed Pickup
Answers a call that is ringing a different extension. For example, if you define *39 as the Directed Pickup feature code,

dialing *39202 will pick up a call ringing 202’s extension.

Define which extensions or extension groups can use this feature, and define which extensions can be picked by those
authorized extensions.
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IEI More about directed pickup

Feature Code Extension *

2 digitz in length

that can use directed pickup Which calls can they pickup
Ext T | Account Mame I Ext v I Account Marne

Justine Kilean 101 Justine Kilean ~
10z Jane Doeson 10z Jane Doeson
103 Jabn Srmith Jahn Smith
104 Gilbert Brown 104 Gilbert Brown
105 Agner With o Agner Witk o
106 Spencer Flemming 106 Spencer Flemmming
107 Mewton Degenhardt 107
105 wehster Savage 108
109 Fosey Podolsky 109 ols
110 Ortiz Schuster bt 110 Qrtiz Schuster b
Extensions Extensions
101 - Justine Kilean 103 - John Smith

105 - Agner Witk

107 - Mewton Degenhardt
105 - Wwebster Savage
109 - Posey Podalsky

Create Extension

Call Monitor
Silently listens in on another extension’s current call. For example, if you define *92 as the Call Monitor feature code,
dialing *92202 will listen in on 202’s call without either party knowing.

While monitoring a call you can switch to different modes by pressing the corresponding digits on your phone:
* Press 5 for whisper mode. This mode allows you to talk to the extension you're monitoring but does not let the other
party hear you.
* Press 6 for barge mode. This mode allows both parties to hear you.
* Press 4 to return to the default monitor mode.

Use the extension boxes to define which extensions or extension groups can use this feature, and define which
extensions can be monitored by the authorized extensions.
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Extensions PR~ Features Systermn Setup Diagnostics

Manage Extensions

This feature code will allow an extension to silently listen in on another extension's current ca

EI More about call monitoring

Feature Code Extension *

2 digits in length

that can monitor Which they can monitor

Ext © | Account Mame | Group M arne v | Members
Justine Kilean Cefault Group 13
iaz Jane Doeson TermporaryEmployees
103 John Smith
104 Gilbert Brown
105 Agner Wwith B
106 Spencer Flemmming
107 Mewton Degenhardt
108 Webster Savage
109 Posey Podolsky
110 Ortiz Schuster b
Extensions Groups
101 - Justing Kilean TernporaryEmployees

Create Extension

SMB| personal Intercom

Directly dials another extension’s intercom. For example, if you define *55 as the intercom feature code, and you dial
*55202, you will now be talking over the speaker on extension 202’s phone. Note: This feature requires intercom support
on the handset receiving the call.

Define the basic Intercom settings. Define Which extensions can use this feature, and define which extensions can
receive these calls from the authorized extensions.
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EI More about using the intercon

n Intercom Settings

Intercom Extension *

2 digits in length

Alert-Info header |Interu:u:ur‘n |

Elwhat's this?

Timeout | 2 Mirutes v |

Elwhat's this?

Intercom f Paging ® 2-way Intercom O 1-way Paging

Flay beepfsound first ®vas Omo
Elwhat's this?

Choose sound to play:

Folder: | Miscellaneous  »|  Sound to Play: | Beep v

Selected Sound Description:

El Intercom Users and Admins

that can use the intercom Which can they intercom

Ext % | Account Marme I Group Marne v | Members
Justine Kilean Default Group 13

10z Jane Doeson TermporaryEmpl

103 Jobn Smith

104 Gilbert Brown

105 Agner With -

106 Spencer Flermming

107 Mewton Degenhardt

103 Webster Savage

109 Posey Podolsky

110 Ortiz Schuster v

Create Intercom Group

SMB| Fax

Sets a system extension as the sender of the fax, and then sends a fax. The fax is stored in the Sent Faxes of the
designated extension. Check Require extension password if you want to require the sender to enter the password for
the designated extension.
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For example: you have a Fax Feature Code extension of 33. You want to send a fax as if it were from extension 200,
which has a voicemail password of 111. You must dial 9 for an outgoing line, and you are sending the fax to 1-888-555-
1212. You would dial the following from your fax machine: *33200*111*918885551212. If the password is not
required, just leaveit out: *33200%*918885551212. In both cases, the fax is sent to the number 1-888-555-1212 and is

stored in the Sent Faxes of extension 200.

Extensions PB X Features Systemn Setup Diagnostics
Manage Extensions

This feature code is used to set a system extension, and then send a fax, The fax is stored in
designated extension,.
IEI More about the fax feature code

Feature Code Extension *l:l

2 digitz in length

Il Reguired extension password

Create Extension

Call Queue Extensions
A Call Queue extension lets your route calls to a group of extensions so that any one of them can pick up the calls.

For example, a sales queue might be a group of extensions that includes all of the sales people. When a caller wants to
speak with a sales person, he reaches the queue, and the queue rings the queue members as specified. That means the
caller is connected to a sales person as efficiently as possible.

Call Queue Setup

The Setup settings determine the basic information about this queue.

n Call Queue Setup

Queue Extension

2 digits in length

Queue Marme |Custu:ur‘ner Service |

E.g. Tech Support

Ringing Strategy | Riound Fiobin |
EI How do these work?

[ This extension can be dialed from an IVR.
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Queue Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

Queue Name
Enter the name of the queue (e.g., Sales or Customer Service).

Ringing Strategy
Select one of the following strategies:

Ring All. Ring all queue members simultaneously until someone answers.

Round Robin. Take turns ringing each queue member evenly as calls come into the queue.

Least Recently Called. Ring the queue member for whom the most time has passed since taking his last call.
Fewest Calls. Ring queue member who has taken the fewest calls in the queue.

Random. Randomly ring queue members.

In Order. Ring queue members in order, always starting with the first member in the list.

This extension can be dialed from an IVR
Check this option to let IVRs dial this extension. IVR menus must also have the Allow Extension Dialing option
enabled (see Adding & Modifying IVR Options).

Call Queue Member Settings

The Member settings determine how the queue interacts with its members.
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EI Call Queue Member Settings

Seconds to Ring Each Member
ll What does this mean?

Seconds to Wait Between Members
ll What does this mean?

Seconds for Wrap Lp
ll What does this mean?

Pickup announcerment
ll What is this for?

Acknowledge Call
il What does this mean?

Mumnber of Missed Calls Before Auto Log Off
ll What does this mean?

Manage Queles Members
il How does this work?

1 ring approximately equals 4 seconds

(28] n
=

| [Uze Call Language] VI Fickup Announcement |

Oves @®No

o]

all Available Accounts

Call Queue

1071 “Justing Kilean'

102 "Jane Doeson”

103 "Jahn Smith"'

104 "Gilbert Brown'

108 VAgrer Wikt

106 "'Spencer Flemming'
107 "Mewton Degenhardt
108 "webster Savage"
109 "Pogey Podolsky'
110" Orhiz Schuster'

111 "Harvey Culver'
112 "webb Sanderson
113 "Momis Madzen"
114 " oon Bradley'

115 "Corwway Magee"

[

- o

[l queus members can receive calls while already on a call.

il What does this mean?

[* Click to Show User Permission Settings

Seconds to Ring Each Member

Ooenotes
Ooenotes

Enter the maximum number of seconds a queue member’s phone can ring before the system stops ringing that member,

and goes to the next member of the queue.

There are some issues to keep in mind:
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« If a queue member has a call rule that answers sooner than this setting, the call rule is applied. For example, if a
queue member has a call rule that sends the call to voicemail after two rings, and this setting is five, the call goes to
that member’s voicemail and not to the next member of the queue.

» Some phones may stop ringing and give up after some number of seconds or rings. If this setting is a large value
(above 60), and you notice the phones stop before that number of seconds, you might want to try to change your
phone to increase this limit.

Seconds to Wait Between Members
Enter the maximum number of seconds a queue member’s phone can ring before the system goes on to ring the next

member of the queue.

Note: If you set this to a low number and have a large Ring all queue, or a queue where no one is logged in, there is a
potential for system performance issues. This is because the system keeps trying to find someone to answer the queue
call. Unless you have a specific reason for doing so, it is recommended to leave this value at the default of 5.

SMB| Seconds for Wrap Up
Enter the minimum amount of time (in seconds) after disconnecting a call before the agent can receive a new call from the
queue. For example, if this is set to 10, an agent’s phone will not ring again for at least 10 seconds after completing a call.

Pickup Announcement

Select a language and a sound file to play when a queue member answers a queue call. After this sound is played, the
gueue member is connected to the caller. This sound lets the queue member know that the call is from a queue, and
which queue. This is especially useful for people who answer for multiple queues.

To use the language that has been set for this current call, select Use call language. If you are only using one language in
Switchvox, use this setting. To use a specific language for the pickup announcement for this queue, select that language.

The sound-file dropdown automatically lists all of the sound files in the Sound Manager’s Call Queue folder. For more
information, see Sound Manager.

SMB| Acknowledge Call
Select Yes to require members to press the 1 key to accept the call. If the member hangs up, then the call goes to the
next appropriate queue member.

SMB| Number of Missed Calls Before Auto Log Out
This setting controls when members are automatically logged out of this queue. (Permanent queue members can never
be logged out.)

« If amember misses more calls in a row than the number in this setting, he is automatically logged out of this queue.
Calls will not ring this member until he logs in again.

« If you do not want members to be logged out automatically, set this to 0 (zero).
Manage Queue Members

Queue Members are extensions that can log into the queue and receive calls from the queue. Only phone extensions are
valid queue members. Permanent members are permanently logged in, so they can always receive calls to the queue.

To add extensions to the queue, select the extensions on the left, then click one of the right-facing arrow buttons: Add
Login Member (blue) or Add Permanent Member (yellow). The selected extensions are moved to the Call Queue
Members box on the right.

To select multiple extensions, hold down CTRL and then select. To select multiple extensions that are all next to each
other in a block, hold down Shift and select the first and last extensions.

To remove an extension from the queue, select the extension and click the left-facing green arrow button.

The order of members in the list is important. For example, if Round Robin is the ring strategy, it calls the member in the
first position, then the second, and so on. If In Order is the ring strategy, it always tries to call the members in order,
starting with the first member.
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To change the order of the member list, highlight an extension and use the up/down arrows to move the extension up or
down in the list.

Queue members can receive calls while already on a call
Check this box if you want this to be true. By default, queues do not ring members who are already on a call. Note: Your
phone must be able to support multiple simultaneous calls for this feature to work properly.

SMB| User Permission Settings
Set the permission level for extensions to see this queue in the Queue Panel on their Switchboard. To set these
permissions, click the link Click to Show User Permission Settings.

Filter list by Extension Group lets you display all phone extensions, or just the extensions in an extension group.
Highlight an extension and select one of the following permission levels:
My Status: Lets the extension open this queue panel and see his call information for today.

Overview: Lets the extension open this queue panel and see his call information for today, and an overview of all the
queue information for today.

Detailed View: Lets the extension open this queue panel and see his call information for today, an overview of all the
queue information for today, and the members and callers in the queue.

Caller Experience Settings

The Caller Experience settings offer two options for what happens when a caller is waiting in the queue.
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E Caller Experience Settings

O play Ringing In Queue

® Play Music on Hold In Queue
Announce Pasition in Queue

ll More Info

Announce Estimated Haold Time

in Position Announcements,
llhiure Info

Announcement Frequency 40 |

Seconds between announcernents

Language | [Uze Call Language] v|

Manage Announcements

7
2/ More About Announcements Announcement You are next

Zound File | You dre Next v |

Description vour call is now first in line and will be answen

next available representative,

announcerment  Caller Mumber

Sound File | Caller Humber v|

Description Tou are currently caller number

announcement  Calls waiting

Sound File | Callz '/ aiting w |

Description Waiting to speak to a representative

announcement  Hold time

Sound File | Hold Time » |

Description The estimated hold time is currently

Announcement  Minutes

Sound File | Minutes v|

Description Minutes

announcernent Thank you

Zound File | Thank, r'ou w

Description Thank vou for your patience,

Play Ringing in Queue
Let the caller hear the call ringing the queue member(s) phones.
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Play Music on Hold in Queue
Play Music on Hold, and optionally play announcements.

If you select Play Ringing In Queue, then the rest of the settings here are unavailable.

If you select Play Music on Hold In Queue, then you can use the rest of the settings here to customize the caller's
experience.

Announce Position in Queue

Select Yes or No. If this is Yes, the caller hears an announcement when they enter the queue, and the announcement
says what the caller’s position is in the queue. The announcement is repeated depending on the Announcement
Frequency setting.

If this is No, the caller hears Music on Hold with no position announcement.

* Announce Estimated Hold Time in Position Announcements
Select Yes or No. The caller hears an estimated hold time along with his position in the queue. The estimated hold
time is derived from how many other calls are in the queue and the average time it took to answer previous calls.

* Announcement Frequency
Enter number of seconds between announcements.

Manage Announcements

There are various announcement sounds that are played to the caller when he or she is waiting in a queue. All of these
sounds can be customized for this queue. Each announcement listed here has a description, and a sound-file dropdown to
select the sound that plays when this announcement is triggered.

The sound-file dropdown automatically lists all of the sound files in the Sound Manager's Call Queue folder. For more
information, see Sound Manager.

Make the following selections for the announcements:

Language: Play all announcements from sound files of this language. To use the language that has been set for this
current call, select Use call language. If you are only using one language in Switchvox, use this setting. To use a specific
language for these announcements in this queue, select that language.

You are next: Your call is now first in line and will be answered by the next available representative
Caller Number: You are currently caller number

Calls waiting: Waiting to speak to a representative

Hold time: The estimated hold time is currently

Minutes: Minutes

Thank you: Thank you for your patience

In Queue Call Routing Settings

The In Queue Call Routing settings determine any alternative call routing. Enter values in the boxes (shown as blanks
here) to define queue call routing.
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ﬂ In Queue Call Routing

If a caller has been waiting in the queue for |:| seconds, route the caller to extension |:

Leave this blank to leave callers in the queue indefinitaly,

If there aren't any members logged into the quewe, route all incoming quewe calls to extensi

Leave blank to keep callers waiting in the queue until a2 queue mermber logs in,

If there are |:| unanswered calls in the queue, route all new incoming queue calls to exte

Leave blank to have an unlimited queue length,

If a gueus call has passed through the Ringing Strategy til‘l‘lES withiout being answe

toextension| | &

While in a gueue allow callers to dial 2 0 to be routed to extension |:| 2

Create Call Queue

If a caller has been waiting in the queue for [] seconds, route the caller to extension []
Enter a number of seconds, and the extension. If this is left blank, callers remain in the queue indefinitely.

SME| |f there aren't any members logged into the queue, route all incoming queue calls to exten-
sion []
Enter an extension. If this is left blank, callers are kept waiting in the queue until a queue member logs in.

SMB/ If there are [] unanswered calls in the queue, route all new incoming queue calls to extension

[

Enter a number and an extension. If this is left blank, there can be any numbers of callers waiting in the queue.

SMB| |f 3 queue call has passed through the Ringing Strategy [] times without being answered then

route that call to extension []
Enter a number and an extension. If this is left blank, callers remain in the queue indefinitely. The effect of this setting

depends on the Ringing Strategy. For example, if the Ringing Strategy is Ring All, then the call rings all queue members
and that is considered one pass through the strategy. If the Ringing Strategy is Round Robin, then the call rings each
queue member, and once all queue members have been tried, that is considered one pass through the strategy.

While in a queue allow caller to dial a 0 to be routed to extension []
Enter an extension if you want this to be true. Note: Click the People icon to select from a list of available extensions.

sus! Agent Log In Extensions

An Agent Log In extension is used to log an extension into call queues, and/or to log a virtual extension into a phone. This
extension can also be used to toggle logging in and logging out, so that you do not have to have a separate Agent Log out
extension.
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Manage Extensions

fgent Log In Extension

3 digits in length

Queues To Affect:
Customer Service [5171

T echnical Suppaort [612]

D Affect All Queues

[] Do not require password to login

] Login/Logout toggle

] Always prompt agents to enter their login extension
(] affect virtual extension login/logout status

Create Extension

Agent Log In Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

Queues to Affect
Highlight the queues that a caller should be logged into when calling this extension. Hold down CTRL to highlight multiple

queues. Check Affect All Queues if you want that to be true. If you don’t want to affect call queues with this Agent Log In
, do not select any queues.

Do not require password to login
Check this box if you want this to be true. When people call this extension, they are logged in without having to enter a

password.

Login/Logout toggle
Check this box if you want people to call this extension to be logged in or out. If already logged in, callers are logged out. If

logged out, they are logged in. Using this option, you do not need a separate Agent Log Out extension.

Always prompt agents to enter their login extension
Check this box if you want people to enter their extension to log in. This is useful if you have people who share work areas

and phones, or if you have virtual extensions that are used by different people.

Affect virtual extension login/logout status
Check this box if you want this log-in action (or log out, if toggling) to affect virtual extensions. For example, if a virtual

extension is logged into a phone and into a queue, should the action of logging out apply to the virtual extension, or just the
queue?
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sus| Agent Log Out Extensions

An Agent Log Out extension is used to log an extension out of call queues, and/or to log a virtual extension out of a phone.

Extensions PB X Features Systermn Setup Diagnostics

Manage Extensions

Agent Log Out Extension |:|

2 digitz in length

Queues To Affect:

Custorner Service [611]
Technical Support [B12]

|:| Affect All Queues

] oo not require passwiord to logoff
[ affect virtual extension loginflogout status

Create Extension

Agent Log Out Extension
Enter a unique number for this extension. For information about the extension-number length, see Extension Settings.

Queues to Affect

Highlight the queues that a caller should be logged out of when calling this extension. Hold down CTRL to highlight
multiple queues. Check Affect All Queues if you want that to be true. If you don’t want to affect call queues with this
Agent Log Out, do not select any queues.

Do not require password to log out
Check this box if you want this to be true. When people call this extension, they are logged out without having to enter a
password.

Affect virtual extension login/logout status
Check this box if you want this log-out action to affect virtual extensions. For example, if a virtual extension is logged into
a phone and into a queue, should the action of logging out apply to the virtual extension, or just the queue?

Modifying one Extension

To modify an extension, click on Modify for that extension. You can modify all of the extension information except for the
extension number. If you want to change the extension number, you must delete this extension and create a new one.
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Log in as this user

Use the Log in as this user button to open the Switchvox User Tool Suite for an extension. This lets you view and edit
the extension's Tool Suite without knowing and entering the password. The extension-user can be logged in at the same
time, so be careful when either of you are making changes.

Deleting one Extension

To delete an extension, click on Delete for that extension. To keep a copy of the extension’s voicemail, click Download
Voicemail Archive and save a copy of that file. Be sure that you do indeed want to delete the extension and its
voicemail, then click Yes, Delete Extension.

sws Creating & Updating Multiple Extensions

The Bulk Import Extension tool lets you create and update multiple SIP or Virtual extensions.

To do this, you need to create an Extension File that is formatted correctly with specific extension information. Then, you
can use the Bulk Import Extension tool to identify that file, evaluate the extensions that will be created or modified, and
then perform the import.

The Bulk Import Extensions File
The Bulk Import Extensions File must be in Comma Separated Value (CSV) format.

The first line of the file must be a header line that labels each column. Each subsequent line should be an extension line
that contains the values of an extension.

Depending on the type of extensions you are working with (SIP or Virtual) different information is required or accepted.
You can use a file that has additional columns of information (Switchvox ignores this information), as long as the required
extension information is included correctly, The order of the labels in the header is not important, but the values of each
extension must match the order of the labels.

If you are working with SIP extensions, the value of phone_password cannot be the same as extension.

If you are updating an existing extension and you have some information that you do not want to change, leave that value
empty. If you want to make it blank, put a space in that column.

When your Extension File is ready, go to Extensions > Manage Extensions and click Bulk Import Extensions (see
Bulk Import Extensions Settings).

File Information

This table describes the data for each type of import:

ext fname Iname email title location password phone_password
SIP: New v Y v v v v v

SIP: Update s v + + v < v
Virtual: New < -' oy - + o X
+ + + + + X

Virtual: Update + +
+ = Required ::: + = Accepted ::: X = Not Used
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File Examples

Example: SIP Extension File

ext,fname,Iname,email,password,phone_password
100,Joe, Smith,jsmith@home.com, 100,s3CurEp@S$
101,Jane,Doe,jdoe@home.com,101,c@nT6ueSS
102,Dan,Jackson,djackson@home.com, 102,g00ODP @ $$

Example: Virtual Extension File with location and other information

fname,lname,email,dept,ext,password,location

Joe, Smith,jsmith@home.com,sales, 100,100,3A
Jane,Doe,jdoe@home.com,sales,101,101,3B
Dan,Jackson,djackson@home.com,facilities, 102,102,9A

Example: SIP Extension Updates File without passwords with a location

ext,fname,Iname,email,password,phone_password,location
100,Joe,Smith,jsmith@home.com,,,2A
101,Jane,Doe,jdoe@home.com,,,3B
102,Dan,Jackson,djackson@home.com,,,2C

Bulk Import Extensions Settings
The Bulk Import Extensions settings determine how to manage this bulk import.

When the settings are correct, click Evaluate Import to evaluate the Extension File and see what will happen if you
import the file.

Extensions PB= Features Systerm Setup Diagnostics

Manage Extensions

Bulk Import Extensions
ll Howr do I use this page?

Extension File; | |[ Browse..

Extension Type:
Extension Termplate: Diefault »

2n Duplicate Extension: | Skip w

Evaluate Import

The Extension File
Browse your machine to find your Extension File.

For details about creating this file, see Creating & Updating Multiple Extensions.

Extension Type
This is the extension type that is used for all of the extensions that are created.

Extension Template
This is the Extension Template that is used to create or update all of the extensions. All of the values in the template are
used for each of the extensions in the Extension File.
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On Duplicate Extension
This option specifies how to respond when an extension in the Extension File already exists on the system.

Skip: Do nothing with the extension data in the file, and skip to the next extension in the file.

Delete and Recreate: Delete the existing extension in the system, then create the extension with the values from the file
and the chosen extension template. Note: only SIP, Analog and Virtual extensions are affected by this. For example, if
you have a Call Queue extension of 333 and have a line in your file to create an extension of 333, this line in the file is
skipped even if you have Delete and Recreate chosen.

Update Information: Update the existing extension with the values from the file and the chosen extension template.
Note: the update is only applied if the extension types are the same. For example, if you have an existing Virtual
extension of 100, and have a line in your file to create a SIP extension of 100, this line in the file is skipped even if you
have Update Information chosen.

Bulk Import Extensions Evaluation

When you click Evaluate Import, Switchvox opens your Extension File and evaluates it against the extensions that
already exist. The results are shown, with how many extensions will be created, how many are duplicates and what will
be done with those duplicates, and how many are invalid and cannot be created.

If you have invalid extensions, check your Extension File for formatting problems or errors. Be sure that your extension
numbers are the same length as specified in Extensions > Extension Settings.

If you want to proceed with the import, click Yes, Process Extensions.
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Manage Extensions
Bulk Import Extensions

The following is an evaluation of the Extension File import, The actual nurmber of extensions t
be less if there are validation errors with the data in the file,

Extension Creation

Extensions that will be created: 22
Mew Extension Type: Virtual Extension
Extension Template: Default

Extension Duplicates
Cuplicate extensions that will be updated: O

Creation Exceptions
Invalid extensions that will not be created: 0

Duplicate extensions that cannot be updated: 1

Only extenzions that are the sarme type 2z the tvpe choszen for the creation process can be updated by
|> Showr Extensions

Are you sure you want to process this bulk extension file?

¥es, Process Extensions

Extension Templates

Extension Templates contain most of the same settings that you use when you create phone or virtual extensions, and
the templates help you manage the settings for all of those extensions. You can modify the Default template to suit your
needs, or create multiple templates for different types of extensions. For example, you might want all sales staff to have a
similar setup: a SIP phone with Voicemail Forwarding that belongs in the call group Sales. You can use that template to
create all of the sales staff extensions, which saves you time and ensures consistency.

An extension created with a template can always be changed. If you have a special case, you can create the extension
with a template, and then modify the extension.
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Extension Templates

Create, modify and delete extension templates to streamling the administration of extensions
Elwhat are extension templates?

Create A Mew Extension Template

Template Mame: hempnraryEmpIDyeeﬂ Create Hew

Modify Existing Templates (1to1)1ofl

Template Hame = Date Created Madify L

Default 12/11/08, 3:29 PM Modify [

Creating an Extension Template

On the Extension Templates page, enter a unique name for the new template then click Create New. The new template is
created and the settings page is displayed with the original Switchvox default settings. Make your changes, then click
Modify Template to save your changes and return to the Extension Templates page.

An Extension Template has all of the same details as Phone and Virtual Extensions.

Deleting an Extension Template

To delete an Extension Template, click its Delete button. Be sure that you do indeed want to delete the template, then
click Yes, Delete Template.

Modifying an Extension Template

To modify an Extension Template, click its Modify button. The settings page for the template is displayed. Make your
changes, then click Modify Template to save your changes and return to the Extension Templates page.

An Extension Template has all of the same details as Phone and Virtual Extensions.

Extension Settings

The Extension settings let you control some basic extension functionality.

When the settings are correct, click Save Extension Settings.
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Extensions PB X Features Systern Setup

Extension Length digits
] Beep after an assisted transfer

Fequire strong extension passwords
] Feqguire all extension-owners to change their password if it is not already strong

Fequire strong phone-registration passwords

£, Mote: Phone Feature Packs autormatically create very strong phone-registration passwords

Save Extension Settings

Extension Length
Select 3, 4, 5, or 6 digits. This is the length of the extensions in Switchvox. Changing this number does not change

existing extensions.

Keep in mind that if you go to a higher number, and you still have lower extension numbers, there might be a slight delay in
internal dialing. For example, if you call a 3-digit extension, Switchvox waits a moment before connecting the call, to see
if you are going to dial a fourth digit (or fifth or sixth).

Beep after an assisted transfer

Check this box if you want to play a beep sound when an assisted transfer is done. For example: Jill puts Jack on hold
then calls Jane, and asks her if she can speak with Jack. Jane agrees, and Jill transfers Jack to Jane. When the transfer
is complete the beep is played, Jill is off the call, and Jack and Jane are on the call and can begin talking.

Require Strong Extension Passwords
Check this box to require that extension-owners use strong extension passwords. If this box is checked, the extension-
owner cannot change his or her password unless it is evaluated as strong.

A strong password has at least 6 numbers, no more than 2 of the same number in a row (e.g., 111), and no sequences
(e.g., 123). Also, it does not contain the extension.

For details about the extension setting that this affects, see Numeric Password

Require all extension owners to change their password if it is not already strong
If strong passwords are required (the box above is checked), then you can check this box to require that all extension-

owners change their password if it is not already strong. This means that the extension-owners cannot use the Web Suite
until they have created a strong password.

This is similar to Force user to update password on next login, but this setting applies to all extension-owners who do not
have a strong, or very strong password.

Require Strong Phone Passwords
Check this box to require that phones register with Switchvox using a strong password.

A strong password has at least six characters, one of each character type (uppercase letter, lowercase letter, number,
and symbol), no sequences (abc, 123), no more than 2 of the same character type in a row, and includes 2 symbols. If you
do not want to use symbols, you can just make the password longer.

For example: m!12T*M
For details about the extension setting that this affects, see Phone Password.

Note: If you used Phone Setup to configure a phone, then the phone is already configured with a very strong password.
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s Extension Groups

Extension Groups let you group extensions together so that you can apply changes and features to many extensions at a
time.

The Default Group includes all of the phone-type extensions that you put in Switchvox. If you add extensions using the
extension form, ora CSV file, those extensions are included as Group Members. Although you can change the Default
Group, you may not want to. If you change the Default Group, then from that point on, new extensions go into the All
Available Accounts List not the Group Members list. That means that you won’t have an extension group that auto-
matically includes everyone.

Creating a New Extension Group

Click Create a New Extension Group to add a new extension group.

Group Name
Enter a unique name for this group.

Manage Group Members

These boxes let you select the accounts (extensions) that belong in this Extension Group. Any extensions in the Group
Members list is part of this Extension Group.

Click on the column headings to sort by that column.

To select multiple extensions, hold down the CTRL key and then select. To select multiple extensions that are all next to
each other in a block, hold down the Shift key and select the first and last extensions.

Use the green right and left arrows to move extensions from one list to another.

The Default Group includes all of the phone-type extensions that you put in Switchvox. If you add extensions using the
extension form, ora CSV file, those extensions are included as Group Members. Although you can change the Default
Group, you may not want to. If you change the Default Group, then from that point on, new extensions go into the All
Available Accounts List not the Group Members list. That means that you won’t have an extension group that
automatically includes everyone.

Voicemail/Fax Mailbox Quota (MB)
Enter a number of megabytes here to set a disk-space quota. This is the maximum number of megabytes that can be
used for voicemail messages and faxes. This value can be set for extensions and extension groups.
* If you leave this blank, it indicates unlimited space.
* If you enter a 0 (zero), it indicates that no voicemail or faxes can be stored.
* If aquotaiis set for a group or groups, and for an extension in the group, the extension's mailbox quota is used.
« If an extension is a member of multiple groups, the lowest mailbox quota is used.
« If an extension is not allowed to have voicemail, this setting is not relevant.

Modifying an Extension Group

Click the Modify button for the group you wish to modify from the Extension Groups page. This displays the Modify Group
page.
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Deleting an Extension Group

Click the Delete button for the group you wish to delete from the Extension Groups page. This displays the Delete Group

page.
Click Yes, Delete Extension Group to remove the group.

s.s EXtension Permissions

Extension Permissions let you set permissions for the Extended Entry features in the Switchboard Phonebooks.

After these permissions are set up, the managing extension owners need to add the managed extensions to the
Extended Entries section of their Phonebooks.

Switchvox Administrator Manual



Extensions PB= Features

System Setup Diagnostics

Extension Permissions

Manage various permissions for each extension in your system, These permissions allow the adm
which features can be utilized by which extensions.

IEI Tell me more about Extension Permissions

with extended permissions Which they have permissions on

Ext T I Full M arne | Group MName T I Mermbers
1001 Justine Kilean Default Group 21
1020 Jane Doeson TermmpotraryEmployees
1030 John =Emith
1040 Shipping
1050 Accounting I
1080 Spencer Flermming
1081 Mewton Degenhardt
10a&z2 Webster Savage
1083 Posey Podolsky
10a4 Ortiz Schuster hat
Extensions Groups

Extended Permissions l

1001 - Justine Kilean ¥ can view Calls

TermporaryEmployees
M can Record Calls
Can Monitor Calls
¥ can Pickup Ringing Calls
Can Intercom

Extensions Extensions

Extended Permissions l

1030 - Jahn Smith

1092 - Marlow Shurnard
1093 - windharm Stephens
1094 - Yance Davenport
1095 - Jeff Marx

1096 - Drew Poll

M can view calls

W can record Calls

Can Monitor Calls

[l can Fickup Ringing Calls
W can Intercom

Extensions or groups with extended permissions
In the left-hand box, select one or more extensions, or an extension group. The extension(s) here are granted permissions
to manage the extensions on the right.

Which extensions or groups they have permissions on
In the right-hand box, select one or more extensions, or an extension group. The extension(s) here are the ones that can
be managed by the extensions on the left.

Can View Calls

Let the managing extension view the caller ID of the managed extension’s current calls.
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Can Record Calls
Let the managing extension record the managed extension’s current calls.

Can Monitor Calls
Let the managing extension silently listen in on the managed extension’s current call.

Can Pickup Ringing Calls
Let the managing extension answer a call that is ringing the managed extension.

Can Intercom
Let the managing extension initiate an intercom connection with the managed extension.

Extended Permissions
Once you have created a permission-set, check the boxes for each permission that should be granted. If you make

changes to the permissions, click Save.

To change the permission-set, click Edit. The extension boxes are reset with this permission-set, and you save your
changes or cancel the editing.
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PBX Features

The PBX Features let you set up and manage the features of Switchvox, such as Music on Hold, Time Frames, and IVR
menus.

Music On Hold

Music On Hold (MOH) lets you set up audio program(s) for callers to hear when they are not actively on a call (i.e., on
hold, waiting in a queue, parked, or being transferred). Although the audio in MOH is referred to as ‘songs’, you can also
include custom announcements, and update them as often as you like. It’s a great tool for communicating with your
customers.

MOH is organized in groups of songs. Most MOH situations use the default group, which you can customize by adding
and deleting songs. MOH in a call queue can use any group. For example, you can create a MOH group with
announcements about special offers, and assign that group to your sales call queue.

The default MOH group is a selection of classical songs. You can add songs to this group, and delete any songs that you
don’t want.

Switchvox supports MP3 and Ogg Vorbis codecs for MOH files. This means that any file you want to use for MOH needs
toend in.mp3 or.ogg, orit won't play properly.

Extensions PEX Features Systemn Setup Diagnostics

Music On Hold

The rusic on hold manager lets you create groups of music, upload new songs, manage the ¢
EIMDI'E about Music On Hold

Wiew: i ol Songs eV m add Nl
[ velcivimiad ATl | copy To:
Group Lisfimgs

) Fawvarites Group
Music,  defaul Group lto4)af 4

IE File HName Group Mame =¥ Play Order Date Created Play

] mozart - Einekleinenachtrnusik.ogg default 1 12,1108, 3:29 PM
[0 sarasate - Mawarra.ogg default z 12711708, 3:29 PM
F Tchaikowsky - Mocturn.ogg default 3 12,1108, 3:29 PM
[] Mozart - Rondo.oga default 4 12/11/08, 3:29 FM
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Managing Music On Hold

The MOH Main page lists All Songs in MOH. For each song, it lists its group, play order, and date added. To sort by
column data, click that column name, and click it again to toggle ascending/descending order. You can also play the files.

To list all of the groups, select All Groups and click Go.

To list the songs in a group, select the group name and click Go.

Adding a Group

To add a new group, select Group from the Add New dropdown, then click Go. This displays the Music On Hold Group
page.

Click Create Group to save your new group and go back to the Music on Hold page. A success message indicates the
group was created, and the group list displays with the new group highlighted in blue.

Group Name
Enter a unique name for this group.

Description
Enter a brief description of the group.

Play Volume
Select Soft, Normal, Loud or somewhere in between on the adjustable slide bar.

Play Order
Select Chosen Order, which plays in the order displayed in the list, or Random, which randomly plays all the songs in the
list.

Modifying a Group

To modify a group, select All Groups from the View dropdown, then click Go. This displays the list of groups. Click
Modify for the group you want to make changes to. This displays the Music On Hold Group page.

Make your changes, then click Modify Group to save your changes and go back to the the Music on Hold page. A
success message indicates that the group has been modified.

Deleting a Group

To delete a group, select All Groups from the View dropdown, and click Go. This displays the list of groups. Click Delete
for the group you want to delete. Be sure that you do indeed want to delete the group, then click Yes, Delete Group. This
redisplays the Music On Hold main page, and a message indicates that your group has been deleted.

Uploading a Song

To upload a song, select Upload Song from the Add New dropdown, then click Go. This displays the MOH Upload page.
Click Browse to find the file on your computer. The file must be .mp3 or.ogg.

Select a group this song should belong to.

Click Upload Song to upload the new file. The MOH Main page is displayed again, with a success (or failure) message,
and the new song is available in the song list.
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Music On Hold

Song to Upload | " Browse..
Must be a ogg file

Part of Group
Upload Song

Song to Upload
Click Browse, then use the dialog box to locate the file on your machine. Select the file that you want to upload, then click

OK. This closes the dialog box and puts the name of the file in the Song to Upload box.

Be sure that you are uploading an .mp3 or an .ogg file.

Part of Group
Select a group from the dropdown. (You can always move or copy the song to a different group.)

Moving or Copying Songs

To move song files to a different group, check the box for each song that you want to move, select the new group from the
Move To dropdown, then click Move To. The song list is refreshed and reflects this change.

To copy song files to a different group, check the box for each song that you want to copy, select the new group from the
Copy To dropdown, then click Copy To. The song list is refreshed and reflects this change.

Deleting Songs

To delete song files, check the box for each song that you want to delete, then click Delete. Review the list of songs that
will be deleted, be sure that you do indeed want to delete them, then click Yes, Delete Files. The files are permanently
deleted, the MOH Main page is displayed, and a success message indicates that the files were deleted.

IVR Editor

Interactive Voice Response, or IVR, is an automated menu system (also known as an auto-attendant) that you can
program to greet and interact with your callers. An IVR can provide information to the caller, collect information from the
caller, and send the caller to the right extension.

Select Starting IVR Menu
Select an existing IVR menu, or Create New IVR Menu.

IVR Tree
This displays an overview of the selected menu, in tree form. The Actions for the IVR are listed at the top, with various

icons to indicate what sort of action is taking place. The last action in the list is always Listen for options, which cannot be
modified or deleted. That is the action that handles the IVR’s Options.

The Options that a caller can choose are listed at the bottom, with the folder icon. Options are really just an entry point into
another IVR, so if you click the plus next to an Option folder it expands and displays the actions in that IVR menu.
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Click on any action to see the details of that action in the IVR Menu Details section. Click on any folder or option-name to
see the menu details in the IVR Menu Details section.

IVR Menu Details
This normally displays the name and description of the menu, followed by a list of the actions and a list of the options. Or,
if you clicked on an action from the IVR Tree, this displays the details for that action.

Extensions PBX Features System Setup Diagnostics

I¥R Editor

Select Starting IVR Menu | Main VR [ 800 ) v|m

IWR. Menu Marme [Extension)

I¥R Tree I¥R Menu Details
[ Main 1vR _

IVYRE Menu Mame: Main VR
""" D Play Sound
""" @ Time Based Clause DESEI‘il]til]l'l:

""" (] Play Sound Edit IVR Menu Delete IVR Menu

""" D Play Sound
""" D Play Sound
""" D Play Sound

""" D Play Sound

Actions:

D Play Sound (Greeting)

""" @ Listen for options '@ Time Based Clause (During Business Hours)
[ * 71 Start at Mai
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Modify Actions

Creating a New IVR Menu

Select Create New IVR Menu from the dropdown and click Go. This displays the Create A New IVR Menu page.

Enter a unique name and a description, then click Create IVR Menu. This redisplays the IVR Editor main page with a
message indicating the new IVR Menu was created, and the new menu is displayed in the IVR Tree and IVR Menu
Details.
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To create your main IVR, it’s best to plan the entire IVR experience that you want to offer to your callers, then start from
the end and work towards the beginning:

» Determine all of the recorded sounds you want to play for the caller (instructions, information, etc.), and create
those sounds in the Sound Manager.

» Determine which extensions the caller might end up being transferred to, and create an IVR menu for each one.
(Those menus would have a ‘Dial Extension’ action.)

» Determine what factors might change your IVR, and build an IVR menu to handle each situation. For example, if
your IVR behaves differently during regular business hours than after hours, or if it behaves differently based on a zip
code the caller provides, you would create an IVR menu for each situation.

» Once you have your sounds and a set of ‘component’ [VRs built, then you can build the main IVR menu that
answers your calls.

When you are done building your main IVR, you need to create an extension that reaches it. For details, see IVR
(Interactive Voice Response) Extensions in “Extensions.” Also, if you want all calls from your phone service provider to
go to your main IVR, you can set that provider's Callback Extension to the extension of your main IVR.

Adding & Modifying IVR Actions

To add an action to an IVR, click Modify Actions in IVR Menu Details. This displays the Current Actions page. Click
Add New Action. Select an action from the dropdown. When you make a selection, the Action Description section
shows a short description of the selected action. When you have selected an action, then click Next.

There are many actions that can be added to an IVR Menu. Most actions have a configuration page where you can
specify the details of the action, then save your changes.

Interruptible Actions

As you build your IVRs, you'll notice that some IVR actions can be interrupted if the caller presses a key on his or her
keypad. This can offer a better caller experience, but you must plan for it carefully because it has repercussions
throughout your IVRs. If you want to allow interruptions, be careful with how the actions are ordered in your IVR, and
where the interruptions are allowed.

Here are the rules that Switchvox follows for interruptions in IVRs:

1. If an action is not interruptible, all keys pressed before or during that action are dropped. If the caller pressed keys dur-
ing previous interruptible actions, those keys are lost.

2. If an action is interruptible, the caller can press any key to interrupt, and the IVR remembers that one key.

3. If multiple subsequent actions are interruptible, the IVR remembers each key that was pressed to interrupt each
action.

4. When an IVR has collected one or more keys through a series of interruptible actions, it uses those keys (in the order
they were pressed), in the following manner:

1. If there is an upcoming Record Digits action, with no un-interruptible action in the way, the keys are reserved for
the Record Digits action. They will not be used to dial an extension or to select an option.

2. If Enable Extension Dialing is on, and the first key pressed matches an extension number, Switchvox pauses for 3
seconds to see if the caller will press a second key. If a second key is pressed and a valid extension is dialed, the
call is transferred. However, if two or more keys are pressed that do not match a valid extension, then the key
press is considered an Invalid Option (see Adding & Modifying IVR Options).

3. If Enable Extension Dialing is not on, or the caller presses a key that does not match an extension, or the caller
does not press a second key within 3 seconds, the option that matches that key is selected and the caller is sent to
that option’s IVR menu.
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Play Sound

This action plays a sound from the Sound Manager to the caller. If you want to play sounds recorded by the caller, use the
action ‘Play Recorded Sound.’

Folder
Select the Sound Manager folder where this sound is located.

Language
Select the language for this sound. Current Language is the default and is the language that was previously set in the IVR.
The default is English.

Sound to Play
Select the sound to play.

This sound is interruptible
Check this box if this is interruptible. For details, see Interruptible Actions.
Play Sound: Advanced Options

If you want to decide which sound to play based on a sound ID stored in a variable, click on the Show Advanced
Options link. This lets you select variables that have been previously created using the ‘Set Variable’ action. Make sure
that the value in the variable is a sound ID from the Sound Manager, or this action will not be able to play the sound.

Record Sound

This action records a sound from the caller, and saves it in a variable. The sound variable can be used later on in the IVR
menu for actions such as playing or uploading.

When a caller reaches a Record Sound action, Switchvox plays a beep and then begins recording. Recording stops when
the caller presses the "#" key, hangs up, has recorded too much silence, or has reached the total minutes of recording
time.

Stop Recording after sections of silence
Enter the number of seconds of silence allowed before recording stops.

Stop Recording after total minutes
Enter the maximum number of minutes to record.

Recorded Sound Variable Name
Select a previously defined sound variable, or enter the name of the new variable.

Play Recorded Sound

This action plays a previously recorded sound to the caller.

Recorded Sound to Playback
Select a sound from the dropdown. The dropdown includes all sound variables that have been previously set in this IVR.

sme| Send an Email

This action sends an email message. You can include IVR and System Variables in the message, and you can attach a
sound file.

Email Address to Send To
Select a variable that contains the email address, or enter an address in the text box.

From Email Address
Select a variable that contains the email address, or enter an address in the text box.
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Email Subject
Enter a subject in the text box. You can use IVR and System Variables to include text that is specific to this call.

Email Body
Enter the text for the body of the email message. You can use IVR and System Variables to include text that is specific to

this call.

Sound Attachments
Select a sound from the dropdown, then click Attach Sound to Email. The sound name is displayed, with a remove

button.

smB Send Recorded Sound to Voicemail

This action sends a sound to a folder in an extension owner’s voicemail Mailbox.

Extension To Send Sound To
Select a previously defined variable, or enter an extension in the text field.

Variable of Sound to Send
Select a previously set sound variable.

Voicemail Folder to Place Sound In
Select the voicemail Mailbox folder that you want to send the sound to.

smB' Store Recorded Sound in Sound Manager

This action stores a sound in the Sound Manager. This overwrites an existing user sound file in the Sound Manager (it
cannot overwrite a system sound). This action can be used to re-record stored sounds, such as information updates.

CAUTION: When the IVR reaches this action, it immediately stores the chosen sound in the Sound Manager, overwriting
the existing sound. You probably want to do something to limit the access to this action (i.e., require a pass code first).

Folder
Select the Sound Manager folder that the sound should be stored in.

Language
Select the Sound Manager language that the sound should be stored in.

Sound to Store as
Select the Sound Manager sound file that should be over-written. This dropdown only includes the sounds available in the

folder and language that you select. You cannot select system sounds.

Recorded Sound to Store
Select a previously defined sound variable that should be stored in the Sound Manager as specified above.

sme| Upload Recorded Sound

This action uploads a sound to a remote Web server. Two things are required: the URL of the remote upload processing
script, and an existing IVR sound variable.

You can enter a ‘static’ URL that is always the same, or you can create a ‘dynamic’ URL by entering variables so that the
system builds the appropriate URL.

A dynamic URL caninclude IVR Action variables or system variables. When using a variable, make sure that a previous
action has assigned a value to that variable, otherwise nothing will be inserted into the URL. To add a variable to the URL,
select it from the appropriate Possible Variables dropdown, then click Append. The variable will appear in the URL field.
When the URL is requested, each % VARIABLE _NAME% is replaced with the value of that variable.
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URL
Enter the URL to the remote processing script. Use the Possible Variables options to append variables to the URL.

Sound to Send
Select a previously defined sound variable from the dropdown.

Timeout in Seconds
Select the number of seconds to try connecting to the URL. If Switchvox cannot connect with the remote script within

that time, Switchvox will quit trying and go on to the next action in this IVR.

sme' Merge Sounds

This action merges multiple sounds together into one sound variable.

Sounds To Merge
Use the Existing Sounds and Sound Variables options to put sounds into the boxes numbered 1 through 10. The

sounds are merged in this order.

Variable Name for Merged Sound
Enter a unique name for this sound variable (one sound that includes all of the above sounds merged).

sme Play Sound From URL

This action downloads a WAV sound file from a URL, then plays the sound.

You can enter a “static” URL that is always the same, or you can create a “dynamic” URL by entering variables so that the
system builds the appropriate URL.

A dynamic URL can include IVR Action variables or system variables. When using a variable, make sure that a previous
action has assigned a value to that variable, otherwise nothing will be inserted into the URL. To add a variable to the URL,
select it from the appropriate Possible Variables dropdown, then click Append. The variable will appear in the URL field.
When the URL is requested, each %VARIABLE NAME% is replaced with the value of that variable.

URL
Enter the URL to the remote processing script. Use the Possible Variables options to append variables to the URL.

Timeout in Seconds
Select the number of seconds to try connecting to the URL. If Switchvox cannot connect with the remote script within

that time, Switchvox will quit trying and go on to the next action in this IVR.

This sound is interruptible
Check this box if this is interruptible. For details, see Interruptible Actions.

sme| Gate Keeper

This action places a ‘gatekeeper’ in the IVR that counts how many times a caller has traveled through the gate. This is
useful to keep callers from getting stuck in infinite loops, or to trap callers that are trying to abuse the system. Use a
Conditional Clause action to check the count, and send the caller to another IVR when they exceed the limit.

Gate Variable Name
Enter a unique name for this gatekeeper.

smB| Conditional Clause

This action is a conditional statement used to send callers to another IVR menu if the statement is true. A Conditional
Clause action has three parts: the variable to evaluate, the criteria to use, and a value to compare against.
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If your variable contains text, you can only use the criteria Equals or Does Not Equal. The other criteria are only for use
with a variable that contains numbers. Also, the text you enter is case sensitive, so ‘RINGING’ does not equal ‘ringing.’

If your variable contains nhumbers, you can use any of the criteria.

If
Select the variable to evaluate, the criteria to use, and a value to compare against.

Then Go To IVR Menu
Select the IVR menu the caller should be sent to if the above statement is true.

At Entry Point
Select an action that is in the above IVR menu. You do not have to start at the beginning of the IVR.

Time Based Clause

This action checks the current date, day, and time and matches it against the Time Frame. If the current time is within the
Time Frame, then the caller is sent to another IVR. (See Time Frames for instructions on creating and modifying Time
Frames.)

For example, if the current time is within your Time Frame Outside Business Hours, you can send callers to the IVR that
plays a sound asking the caller to leave a message or call back during business hours.

If the current time is within the time range
Select the Time Frame to compare against.

Then Go To IVR Menu
Select the IVR menu the caller should be sent to if the above statement is true.

At Entry Point
Select an action that is in the above IVR menu. You do not have to start at the beginning of the IVR.

Change Language

This action changes the ‘Call Language’ of this call, and any sounds played after this action are played in this language (or
the default language if there is no sound available for the call language).

Language to Change To
Select a language from the dropdown. The dropdown includes the languages that are available in the Sound Manager.

Alter Caller ID

This action alters the caller’s callerlD name or number. You can Prepend, Append, or Replace the name or number with
your information. This is useful to include information that a caller has entered, or to show which IVR options the caller
had selected.

How do you want to modify the Caller ID?
Select Prepend, Append, or Replace the callerlD with your information.

Which part of the Caller ID do you want to modify?
Select Number or Name, depending on which part you want to modify.

Use this text to modify the Caller ID
Enter the text that you want, or use the text from a previously set variable.

Wait

This action adds a delay before the next action.
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Wait time in seconds
Enter the number of seconds to wait before continuing to the next action.

This wait is interruptible
Check this box if this is interruptible. For details, see Interruptible Actions.

Give Busy Signal

This action gives the caller a busy signal for the number of seconds specified. The busy signal is not interruptible, but it
does not hang up the call. After it plays, the IVR continues as normal.

Signal Timeout in Seconds
Select the number of seconds that the busy signal plays.

Hang Up

This action hangs up the call. There are no settings for this action, just click Save Settings to save this action and go
back to the Current Actions page.

Dial Extension

This action dials an extension. The caller leaves the VR and rings that extension. At that point, the extension’s Call
Rules apply.

Extension to Dial
Select a previously set variable, or enter an extension.

Send to Voicemail

This action sends the caller to the voicemail box of an extension.

Extension to Dial
Select a previously set variable, or enter an extension.

Send to External Number

This action sends a caller to an external number.

Number To Dial
Select a previously set variable, or enter an external phone number.

Outgoing call rules for this number
Check the boxes to allow or deny use of each outgoing call rule (just as you would for Switchvox extensions). See

Outgoing Call Rules for details.

WARNING: Use this action with extreme caution because it can be abused by callers.

Go To IVR Menu / Action

This action sends a caller to another IVR menu. This can also be used to jump or return to an action in the current IVR
menu.

Go To IVR Menu
Select the IVR menu to send the caller to.

IVR Menu Entry Point
Select an Action that is in the IVR menu. (You don’t have to start at the beginning of the menu.)
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Record Digits
This action records digits (the DTMF tones) pressed by the caller. The digits are saved in a variable.

Beep before recording
Select Yes if you want a ‘beep’ sound to play before recording begins. This lets the caller know they should start pressing
buttons.

Stop recording after this many digits
Enter a number from 0to 255. Recording stops when the caller has pressed the maximum number of digits, or the pound (

#) key.
If this is 0, the recording continues until the caller presses #, or presses 255 digits.

Recorded Digits Variable Name
Select a previously set variable, or enter a unique name for this variable.

Say Digits/Letters
This action plays digits and/or letters to the caller.

Each digit or letter is read individually. For example, “one four four five,” or “L | K E.” If you want to say “one thousand four
hundred and forty five” instead, use the Say A Number action. (If you want to say words, use a sound variable.)

Digits to Say
Select a variable that contains the digits and/or letters to say, or enter the digits and/or letters in the text field.

Say A Number
This action plays a number to the caller.

The number 1445 is read as “one thousand four hundred and forty five.” If you want it to say “one four four five,” use the
Say Digits/Letters action.

Number to Say
Select a variable that contains the number to say, or enter the number in the field.

Say Date/Time

This action plays a date and time to the caller. This can be the current date and time, a specific date and time, or the date
and time contained in a variable.

Say the current date and time when the call enters this action
Check the box Yes if you want this to be true.

Say a predefined date
Enter the date to be played. Enter a time also, or leave it blank.

Say date from a variable
Select a variable from the dropdown. This variable must be in epoch time.

Format to Say the Date in
Select a format for the date to be played.

sus| Play DTMF Tones

This action plays DTMF tones.

Switchvox Administrator Manual



DTMF Digits to Play
Select a variable that contains each of the DTMF digits to play, or enter the digits in the field.

Play each digit for this many milliseconds
Select the number of milliseconds that you want each DTMF tone to play.

Wait this many milliseconds between digits
Select the number of milliseconds that you want to wait before the next tone is played.

suB| Perform Math

This action performs a mathematical operation on two IVR variables, and stores the result in a new variable.

Choose the variables for your operands and the desired operation
Select the first variable, the operation, and the second variable.

Variable Name for Result
Enter a unique name for this variable.

suB| Set Variable

This action sets a variable.

IVR Variables are temporary variables that are set during a call, and are only available to that call. During the call, the
variable and its value can be accessed from all IVR menus.

Note: If you want to set an IVR Variable where the value can be accessed across calls, see Set Global Variable.

Variable to set
Select a previously existing variable from the dropdown, or enter a unique name in the text field.

Set to value of
Select a System Variable, or enter a value in the field. If you select a System Variable, the value of that variable is now

contained in this variable.

smB| Set Global Variable

This action sets a Global Variable.

Global Variables are variables that can be accessed from all IVR Menus and whose values persist between calls. If a
Global Variable’s value is changed by an IVR Menu, all IVR Menus and all calls will have access to that value.

Global Variable to Set
Select a Global Variable from the dropdown, or enter a unique name for this Global Variable.

Set to value of Variable
Select a variable from the dropdown. The value contained in the variable is now also contained in this Global Variable.

smB| Get Global Variable

This action stores the value of a Global Variable into a normal variable. If you change the value of this normal variable, it
does not affect the original Global Variable.

Global Variables are variables that can be accessed from all IVR Menus and whose values persist between calls. If a
Global Variable’s value is changed by an IVR Menu, all IVR Menus and all calls will have access to that value.

Variable to set
Select a previously existing variable from the dropdown, or enter a unique name in the text field.
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Set to value of Global Variable
Select the Global Variable that contains the value that you want.

sme| Concatenate Variables

This action concatenates multiple variables together, then saves the result in a new variable.

Variable Concatenation
Enter a representation of the variable you want to create. Add variables to this field using the Possible Variables

options, or enter text. Variables must be enclosed with %.

Variable Name for Concatenation
Enter a unique name for this variable.

smB| Send Call Values to URL

This action passes call values to the URL of a processing script. That script can return XML containing a set of values,
which Switchvox can save in variables.

URL

The URL caninclude IVR variables or System variables. When using an IVR variable, make sure that a previous action
has assigned a value to that variable, otherwise nothing will be inserted into the URL.

To add a variable to the URL, select it from the appropriate Possible Variables dropdown, then click Append. The
variable will appear in the URL field. When the URL is requested, each % VARIABLE _NAME% is replaced with the value
of that variable. For example:

http://www.mybiz.com/cgi-bin/app.cgi?act=%ACCOUNTS&pin=%PIN%

This script might verify the account number and pin, then return a set of XML that includes the account information.

XML and Returned Values

If your script returns a set of XML with values that you want to save and use, you must enter the variable names in the
boxes labeled 1 through 8. After Switchvox sends the call values to your script, and collects the return set of variables,
those variables and their values are available for use on this call, in this IVR menu.

The following is a sample DTD for the XML response from your script:

<!-- Switchvox PBX IVR xml DTD -->

<?xml version="1.0"7?>

<!ELEMENT ivr info (variable+)>
<!ELEMENT variable (#PCDATA)

<!ATTLIST variable name CDATA #REQUIRED>

The following is a sample XML response from your script:

<?xml version="1.0" encoding="IS0-8859-1"?2>
<!DOCTYPE ivr info SYSTEM "http://www.mybz.com/xml/ivr.dtd">
<response>

<result>

<ivr info>

<variables>

<variable>

<name>balance</name>

<value>12323</value>

</variable>

<variable>

<name>first name</name>
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<value>John</value>
</variable>
</variables>

</ivr info>
</result>
</response>

smB| Get Extension Status

This action gets the status of the extension, and saves the result in a new variable. This is useful if you want to keep
control of the call. For example, if you use ‘Get Extension Status’ and the extension is busy, you could try someone else.
If you used ‘Dial Extension’ and the extension is busy, Call Rules might send the caller to voicemail instead.

Get Extension Status returns one of the following results:

+ IDLE

+ INUSE

+ BUSY

* INVALID

+  UNAVAILABLE
+ RINGING

These are case sensitive, so IDLE does not equal idle.

Extension To Check Status On
Select a variable that contains an extension, or enter an extension number in the field. Click on the people icon to look up
the extension that you want.

Variable Name for Status Result
Enter a unique name for this variable.

sme| Get Extension Type

This action gets the type of the extension, and saves the result in a new variable.

Get Extension Type returns one of the following results:

e zap
e virtual
o ivr
* sip

» conference
* group_pickup

* intercom
e voicemail
» callpark

» agentcallbacklogoff
» call_queue

» agentcallbacklogin
» autodial

» directory

» simple_conference
» feature_code
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These are case sensitive, so ZAP does not equal zap.

Extension To Get Type Of
Select a variable that contains an extension, or enter an extension number in the field. Click the people icon to look up the
extension that you want.

Variable Name for Result
Enter a unique name for this variable.

smBl Check User Password

This action evaluates the extension’s password with the password contained in a variable, and saves the result in a new
variable. This action returns a 0 (zero), which indicates failure, or 1 (one), which indicates success.

Choose variable where the extension is stored
Select the variable that contains the extension.

Choose variable where the password is stored
Select the variable that contains the password.

Variable Name for Result
Enter a unique name for this variable.

Set Distinctive Ring Hint

A Distinctive Ring Hint is used by an extension's Distinctive Ring Rules. These let an extension-owner set up different
'Ring Actions' depending on the call.

To set a distinctive ring hint:

* Use the value of an existing variable
The hint is the value of the variable, and this value must be previously set in the IVR actions. Otherwise, the hint is
not available to the recipient of the call.

» Enteravaluein the text field
The hint is exactly what you enter in this field.

Note: Distinctive Ring Rules are only available on Polycom phones.

Remove Distinctive Ring Hint

A Distinctive Ring Hint is used by an extension's Distinctive Ring Rules. These let an extension-owner set up different
'Ring Actions' depending on the call.

To remove a distinctive ring hint:

* Use the value of an existing variable
Select a variable from the dropdown. The hint that is removed is the value of this variable.
» Select an existing Ring Hint from the dropdown
Select a Hint from the dropdown. If you do not have any IVR actions of Set Distinctive Ringtone Hint, this
dropdown is not available.
* Clear all Distinctive Ring Hints
Check this box if you want to remove all distinctive ring hints that were previously set in this IVR.

Note: Distinctive Ring Rules are only available on Polycom phones.
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Adding & Modifying IVR Options

To add an option, click Modify Options in the IVR Menu Details. This displays the Current Options page.

To add a new option, click Add A New Option. Make your selections, then click Create New Option to save your
changes and go back to the Current Options page.

Option Number
Select a number, or the * key. This what the caller presses to select this option.

New IVR Menu
Select the IVR menu the caller is sent to when the Option Number is pressed.

IVR Menu Entry Point
Select an Action that is in the IVR menu. (You don’t have to start at the beginning of the menu.)

Enable Extension Dialing
Let the caller dial an extension number, then ring that number. Use this feature for an IVR that says, “if you know your
party’s extension, please dial it now.”

Normally IVR Menus only allow single digit options. However, if this setting is checked, then IVR callers (in this IVR
Menu only) can dial extensions. If the IVR caller enters a valid extension, Switchvox rings the extension. If the caller
enters an invalid extension, then it is considered an “invalid option,” and is handled according to that setting.

Only Call Queues, Phone Extensions, Directory Extensions, Voicemail Access extensions, Virtual Extensions, and other
IVR extensions can be dialed. Callers will not be able to dial any other types of extensions.

Extensions must have This extension can be dialed from the IVR checked. Even though it may be a valid extension,
if this is not checked then it is considered an ‘Invalid Option’ for a caller. (See Advanced Options.)

Options and extension dialing can coexist in the same IVR Menu. However, if you have an option in the menu (i.e.; 1) that
starts with the same number as an extension (i.e.; 105) then the caller experiences a delay. When he presses ‘1’,
Switchvox waits a moment to see whether he might also press ‘05'. If he doesn’t, Switchvox proceeds to option 1.

Invalid Option Settings
Specify what should happen when a caller presses a key for an option that doesn't exist. Select a sound to play, then an
IVR menu and entry point (you don’t have to start from the beginning of the menu).

Option Timeout Settings

Specify what should happen if a caller fails to select any options within a certain amount of time. Set the number of
seconds to give the caller, a sound to play, and an IVR menu and entry point (you don’t have to start from the beginning of
the menu).

Retry Settings
Specify what should happen if a caller chooses an invalid option or times out several times. Select the number of times to
allow, and an IVR menu and entry point (you don’t have to start from the beginning of the menu).

Sound Manager

The Sound Manager lets you create, upload, modify, and delete all of the sounds in Switchvox other than Music On Hold.
It also lets you organize your sounds in folders, and manage the same sounds that are in different languages.

Sounds can be uploaded from your computer, or recorded over any phone that’s connected to Switchvox.
Use the main page of the Sound Manager to see and manage your sounds:

e View all sounds
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* View all of the sound packs, folders, or languages
* View all sounds within a folder
* Add a new sound, sound pack, folder, or language

Note: You are not allowed to delete, move, or modify system sound information or system sound files in the English
language.

Extensions PBX Features System Setup Diagnostics

Sound Manager

Create and manage the recordings for your IWREs and call queles,

IEI Tell me more about the Sound Manager
View: | Main VA Sounds Folder (3 files)  + | Add Me

Crove o [T

Active Sounds ([ 1to9)1of 9

+  Sound Mame 7 Folder MName Languages Sound Pack Sound Type Modify ;
[] Business Hours Main IWR Sounds English*  Default Sounds User m
[] Dial Extension Main I¥R Sounds English*  Default Sounds User m
[] For Custormer Service Main IWR Sounds English*  Default Sounds User m
ol Greeting Main I¥R Sounds English*  Default Sounds User m
[] Main Menu Main IVR Sounds English*  Default Sounds User m
[] =ervice Announcement Main IVWR Sounds English*  Default Sounds User m
(] To hear Main Menu Main IVR Sounds English*  Default Sounds User m
[] Tohear Service Announcement Main IVR Sounds English*  Default Sounds User m
[] uUse the Directory Sound Description SEN m

* default language To hear our current service announcement press 2.

Adding a Sound

To add new language sound-file to a sound that already exists, follow the instructions in Modifying/Playing a Sound. For
example, if you already have a sound for ‘hi’ in English, and you want to create the Spanish sound ‘hola,’ then you would
modify the English ‘hi’ by adding the Spanish sound. That lets you keep the same sounds in different languages grouped
together.

To add a completely new sound, select Sound from the Add New dropdown and click Go.

When the settings are correct, click Save Sound. (If you are uploading a file, the transfer begins). The system redisplays
the Sound Manager main page with a message that a new sound has been added, and the new sound is included in the
list of sounds.
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Extensions PBX Features Systemn Setup Diagnostics

Sound Manager

Sound Mame

Sound Description / Script
Wwhat are the exact words

of thiz recording?

Faolder: | VR v
Sound Language:
Sound Source: | Record Over Phone + |

Extension to Ring 2

for Recarding:

Sound Name
Enter a unique name for this sound.

Sound Description/Script
Enter the words of this recording. This is displayed when you mouse over the sound name in the list of sounds.

Folder
Select a folder for this sound.

Sound Language
Select the language that is used in this sound.

Sound Source
Select Record Over Phone or Upload File.

If you chose Record Over Phone, enter the extension to ring, then click Record. Make your recording, then hang up the
phone or press #.

If you chose Upload File, browse your computer to identify the sound file.

Modifying/Playing a Sound

To play or modify a sound, click its Modify/Play button. This displays the Update a Sound page. This page shows the
sound, the available languages, and the sound’s status, name, sound pack, description, and actions allowed.

When the settings are correct, click Save Sound. (If you are uploading a file, the transfer begins). The system redisplays
the Sound Manager main page with a message that a new sound has been added, and the new sound is included in the
list of sounds.
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Play
Plays the sound on your computer. You must have a sound player application installed to hear the sound. For sounds in

the gsm format, Quicktime by Apple is a good player.

Play To Phone
Displays the Play To Phone dialog box. Enter the extension to ring, then click Go. This rings the extension, then plays

the message when you pick up the phone.

Modify
Displays the Sound Details page. Make your changes, then click Update Sound File. The Sound Manager main page is
displayed with a message indicating that the sound was modified.

WARNING: If you are uploading or re-recording the sound file, the existing file is replaced. You will not be able to retrieve
the old version of the file.

Record Over Phone
Displays the Sound Details page. Enter the sound name and description, and an extension to ring. Click Record. Make

your recording, then hang up the phone or press #.

Upload File
Displays the Sound Details page. Enter the sound name and description, and browse your computer to identify the sound

file to upload.
Extensions PBX Features System Setup Diagnostics

Sound Manager

Sound Marme Hear Announcement

Sound Description f Script [Te hear our current service announcement press 2.
What are the exact words

of thiz recording?

Faolder: Main IVR Sounds
Sound Language: English
Sound Source: | Record Over Phone |

Extension to Ring 2

for Recording:

Update Sound File

Deleting a Sound

In the sounds list on the main page, check the boxes for the sounds that you want to delete, then click Delete (at the top
of the song list). Be sure that you do indeed want to delete these sounds, then click Yes, Delete Sounds. The main page
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is displayed again, with a message that the sound has been deleted.

Note: If a sound box cannot be checked, it is because it cannot be deleted. The basic set of system sounds cannot be
deleted.

Moving a Sound into a Folder

In the sounds list, check the boxes that you want to move, select the folder the sound belongs in (the dropdown at the top
of the song list), then click Move To. The Sound Manager main page is displayed with a message that the sound has
been moved. If you have used the sound in IVRs or call queues, Switchvox now accesses the sound from its new folder.

Note: If a sound box cannot be checked, it is because it cannot be moved. The basic set of system sounds cannot be
moved.

About Sound Packs

Sound packs are pre-configured packages that you can add to Switchvox and use in place of the pre-installed default
English sound pack. Only officially certified sound packs can be installed on Switchvox.

To obtain sound packs for different languages, go to Machine Admin > Digium Addon Products and click Switchvox
Product Addons.

To add a sound pack:
1. Download the sound pack to your desktop computer.
2. Goto PBX Features > Sound Manager.
3. Select Sound Pack from the Add New: dropdown.
4. Click Go.
5. Click Browse and locate the file on your computer.
6. Click Add Sound Pack.

The sound pack is added to the Sound Manager, and the language of the sound pack is available for use.

Managing Folders

Sounds are organized in folders. Switchvox comes preconfigured with several folders, which cannot be deleted.
Typically, the folder name indicates the type of sounds it contains. Any new folders should be named accordingly.

Adding a New Folder

To create a new folder, select Folder from the Add New dropdown, then click Go. Enter a unique name and a description
for this folder, then click Create Sound Folder. This displays the Sound Manager main page with a message that a new
folder has been created, and the new folder is included in the folders list.

Modifying a Folder

To modify a folder, click its Modify button. Make your changes, then click Modify Sound Folder. The Sound Manager
main page is displayed with a message that the folder has been modified.
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Deleting a Folder

To delete a folder, select its Delete button. Be sure that you do indeed want to delete this folder and all of the sounds in it,
then click Yes, Delete Folder. The folder and all sounds in it are permanently removed, and the Sound Manager page is
displayed with a message that the folder has been deleted.

Managing Languages

Switchvox supports multiple languages. Each sound in the Sound Manager can be uploaded or recorded in all the
available languages. Your sounds ‘hi,” ‘hola,’ and ‘ciao’ sounds are grouped together, because they say the same thing to
the caller.

The pre-configured default language is English, and there is a set of system files tagged English.

Adding a New Language

To add a new language, select Language from the Add New dropdown. Enter the language name, then click Create
Language. The Sound Manager main page is displayed, with a message that a new language has been added.

Modifying a Language

To modify a language, click its Modify button. Make your changes, then click Modify Language. The Sound Manager
main page is displayed, with a message that the language was modified.

Deleting a Language

To delete a language, click its Delete button. Be sure that you do indeed want to delete this language and all of the sounds
associated with it, then click Yes, Delete Language. The Sound Manager main page is displayed with a message that
the language was deleted.

Setting a Default Language

To set alanguage as the default language, click Set as Default for that language. The page is refreshed with a message
that the sound pack was successfully activated. Now the sounds labeled with that language are played. If there is no
sound available in that language, Switchvox uses the English system sound-file.

WARNING: Changing the Default Language automatically causes the Switchvox software to restart. All current phone
connections will be dropped, and members will be logged out of all call queues.

Time Frames

Switchvox can operate differently based on the date, day, and time. You can set up IVR Menus and Call Rules to check
the Time Frames, and then act accordingly.

There are several predefined time frames that you can use: Business Hours, Outside Business Hours, and Weekends
Only. You can edit or delete these time frames, or create new ones.

A time frame is considered valid when the current date and time match any one of a time frame’s rules. Not all of the rules
have to match.
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Extensions PBX Features Systemn Setup Diagnostics

Time Frames

Create, modify and delete time frames to facilitate the administration of call rules on your PEX
llwhat are Time Frames for?

Create & New Time Frame

Tirme Frame Mame

| Create Hew

Modify Existing Time Frames

During Business Hours m
Dutside Business Hu:uursm
o [ voere |

weekends Only

Creating a New Time Frame

To create a new time frame, enter a unique name and click Create New. Enter any appropriate Start and End Dates, Start

and End Days, and Start and End times, then click Add.

Continue adding rules until you have completed the Time Frame definition.

The following are sample time frame definitions:

Start Date End Date Start Day End Day Start Time End Time
- - Monday Monday - -

- - Wednesday Wednesday - -
Mondays 12:00AM to 11:59PM, and Wednesdays 12:00AM to 11:59Pm

Start Date End Date Start Day End Day Start Time End Time

- - - - 3:00 AM 6:00 AM
Early Morning

Start Date End Date Start Day End Day Start Time End Time
07/01/2009 07/07/2009 - - - -
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The First Week in July 2009

Start Date End Date Start Day End Day Start Time End Time

01/21/2009 - - - - -

After January 21, 2009

Start Date End Date Start Day End Day Start Time End Time

02/01/2009 02/28/2009 Monday Friday 6:00 AM 7:00 AM

Weekdays in February, 2009 between 6:00 and 7:00 in the morning

Editing a Time Frame

To change a time frame, click its Edit button. This displays the Manage This Time Frame page. Create a new rule, or
multiple rules, and delete any rules that you do not want to include in this time frame. (You cannot edit a rule.)

Manage this Time Frame

ﬂ How does this work?

Start Date End Date Start Day End Day Start Time
Monday Friday 2:00 am

S - ) BN - S Em| Iy

Midnight = 12:00 AM
Moon = 12:00 PM

Deleting a Time Frame

To delete a time frame, click its Delete button. Be sure that you do indeed want to delete this time frame, then click Yes,
Delete Time Frame. The Time Frames main page is deleted with a message that the time frame was deleted.

Before you delete a Time Frame, be sure you do not have any IVR Menus or Call Rules that depend on it.

= Call Recording

This lets you set up rules for recording calls. Any calls that match these rules are recorded and listed on this page. You

can view, listen to, and download recorded calls.
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There is one default call recording rule that Switchvox automatically follows, called user-initiated recordings. When a user
records a call (his own call or another person’s), those recordings are included here. These are the same recordings that
the user has in his Mailbox, so if you or the user deletes one of these recordings, it is no longer available in either area.
However, if the user forwarded the recording to another Switchvox user, that version is unchanged. Users can record
calls using the Switchboard, if he or she has permission.

Viewing & Playing Recorded Calls

The Recorded Calls list shows the information for each call, and lets you play the call. When you click Play, you can
choose to play the call with your audio player, or download the file (these options may depend on your Web browser's
settings).

Extensions PBX Features System Setup Diagnostics

Call Recording

Setup and manage which extension's calls you want recorded in your system.
IEI Tell me more about using the Call Recording feature

$chedule a Hew Call Recording Enter Call Recording Settings

Scheduled Call Recordings (1to2 ) of 2

Recording Tag <& Extension Type Record For Keep For Date Created
user-initiated recordings  All Extensions Initiated Calls 100 calls then delete 0173006, 7:10
1 Kilean Phone Extension 9 calls Forever 0371709, 3:01

Recorded Calls vour disk is 75% full (6.2 gb /5.4 gb)

Delete Checked 0 S0%

M Recorded calls disk usage B other ¢
D’ Click to show filter options
Recorded Calls (1to2)of 2
IE Recording Tag Recorded Account From Caller ID To Caller ID Duration D
user-initiated lane Doeson Justine Kilean Jane Doeson . 0
. s
recordings <1020= <1001 = <1020=
i Justine Kilean Jane Doeson Justine Kilean
(] 1kilean 1Zs n
<1001= <1020 <1001=
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Filter Options

To view and listen to a specific set of calls, click on the Click to show filter options link. The Apply Filter dropdown lets
you filter the recordings list.

Click Run Filter to limit the Recorded Calls to the calls that match your filter.

Date
Enter the surrounding dates of the time period that you would like to hear the recorded calls from.

Recording Tag
Simply choose the recording tag of the recorded calls that you would like to hear from the dropdown.

Duration
Simply choose the time limit of the recorded calls you would like to hear from the dropdown.

From Caller ID
Enter the phone number, extension, or caller ID of the person who called you that you would like to hear the recorded calls

from.

To Caller ID
Enter the phone number, extension, or caller ID of the person who you called, that you would like to hear the recorded

calls from.

Recorded Account
In this filter option, you must choose either Phone Extensions, Call Queues or Extension Groups from the dropdown, and

then choose which account from the lists that are displayed below the menu.

About Call Recording Settings

You can back up your recorded calls to an external FTP server before the calls are deleted. This is highly recommended if
you rely on call recordings.

On the main page, click Enter Call Recording Settings. Enter your FTP server settings.

When recorded calls are backed up to this FTP server, Switchvox automatically creates a separate folder on the FTP
server for each recording rule. Each call recording is automatically stored in its respective folder. Each recorded call has
two files, a WAV file and a XML file. The WAV file is the sound, and the XML is the data about the call.

The file names are based on the following structure: [Date]-[Time Stamp]-[From Caller ID]-[To Caller ID].

2007-04-06-15-00-41 7771021212 102.wav
2007-04-06-15-00-41 7771021212 102.xml

This sample call was made on April 6, 2007 at 3:00:41PM. A call from 7771021212 was received by extension 102.
The XML file includes the following data:

<recording info>

<recording tag>Steve Smith</recording tag>

<recorded call id>1200</recorded call id>

<recorder cid></recorder cid>

<recorded cid>Steve Smith &1t;102&gt;</recorded cid>
<recorder account id></recorder account id>
<recorded account id>1101</recorded account id>
<from account id>0</from account id>

<from caller id>BuyIt &1t;7771021212&gt;</from caller id>
<to account 1d>1101</to_account id>

<to caller id>Steve Smithé&lt;102&gt;</to _caller id>
<duration>316</duration>
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<date created ts>2007-04-06 15:00:41.611474</date created ts>
<date created secs>1175896842</date created secs>
</recording info>

Scheduling a New Call Recording

To schedule a new call recording, click Schedule a New Call Recording.

Whose calls would you like to record?
Select one or more extensions, extension groups, or call queues. You cannot combine these types, but you may select

many of each type.

What type of calls would you like to record?
Check All Outgoing Calls, Incoming Direct Calls, and/or Incoming Queue Calls.

How many calls would you like to record?
Set a specific number of calls, or the date and time you want the recordings to end.

How long do you want to keep the recordings?
Set the storage instructions for the recordings. If you want to back up older recordings before you delete them, click the

link to Call Recording Settings Section (see About Call Recording Settings). IMPORTANT: If you enter a number into
the Delete calls after setting, Switchvox immediately deletes any older recordings to ensure that there are no more than
that number of files on disk.

What do you want to label these call recordings?
Enter a unique name for this scheduled call recording rule.
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Extensions PBX Features System Setup Diagnostics

Call Recording

Schiedule a Recording Job

Whose calls would you like to record?

| Phone Estenzsions + |

Phone Accounts Current Members

1020 “Jane Doeson™ s 10071 “Juzting Kilean"
1030 "John Smith" E
1040 "Shipping "'

1050 “Accounting

1080 "Spencer Flemming'' —
1081 "Mewton Degenhardt

1082 "webster Savage"

1083 "Pogey Podalzky"

1024 "Ortiz Schuster”

1085 "Harvey Cubver hd

&

What type of calls would yvou like to recard?

(] 2l Cutgoing Calls
¥l Ihcoming Direct Calls
Incuming Queue Calls

How many calls would you like to record?

® The next calls
- OF -
O unitil the date,u‘tirne|

How long do wou want to keep the recardings?
I Warning: Changing this may result in the deletion of previously recorded calls - [2] vell e

@Keep Farawver
- OR -

O Delete calls aﬂ:erl_|
- OF -
]

Y you must enter your ftp server information in the Call Recording Settings Section to en.

What is the minimum recording length?

[ Delete recordings sharter than |:| seconds,
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Deleting Recorded Calls

To delete call recordings, check the box for each one that you want to delete, then click Delete Checked (at the top of the
list). Be sure that you do indeed want to delete the recordings, then click Yes, Delete. If you are deleting ‘user-initiated
recordings,’ the recordings are deleted from the user’'s Mailbox.

s SWitchboard Plugins

Switchboard Plugins let you add powerful panels to the Switchboard. These panels let you exchange data with external
Web applications, then display the results. The panels refresh each time a call comes in, showing caller-specific
information.

For each panel, you can specify which phone-type extensions are allowed to use it. If an extension isn’t allowed to use a
panel, that panel isn’t included in the Switchboard’s Panel menu.

Extensions PBX Features Systermn Setup Diagnostics

Switchboard Plugins

Create a custom panel that references third-party web services,

IEI Tell me all about custom panels

[l Panel Settings

Farel Mare Googlelookup

Panel Description |[Look up 'Caller ID Nawe' on Google

Panel LIRL IJr'nJ'pdafsearn:h?r‘nrestriu:t=xhtmI&q=%C.-'—‘-.LLEH_ID_N.i'-.ME%

El Extensions allowed to use this panel

all Available Accounts Extensions with this Panel
1091 "Fruge Lesher 1007 “Justine Kilean" A
1092 "Marlowe Shurmard' 1020 "Jane Doeson' ]
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Standard Panels

Standard panels provide integration with SugarCRM®, Salesforce.com, and Google® Maps.

SugarCRM®

This panel provides integration with your SugarCRM® application.

SugarCRM® Web URL

This is the URL to your SugarCRM® application’s Web interface (e.g., http://crm.example.com/sugarcrm/). If
you want external users to have access to this panel, then this URL must be accessible from the outside Internet. If your
SugarCRM® application is running behind NAT, you may need to make it accessible by forwarding ports. HTTPS URLs
and alternate ports are supported (e.g., https://public.example.com:8080/sugarcrm/).

SugarCRM® SOAP URL

This is the URL to your SugarCRM® application’s SOAP API (e.g.,
http://crm.example.com/sugarcrm/soap.php). This URL must be accessible from the outside Intemnet, so if
your CRM application is running behind NAT, you may need to make it accessible by forwarding ports. HTTPS URLs and
alternate ports are supported (e.g., https://public.example.com:8080/sugarcrm/soap.php).

Extensions allowed to use this panel
Select one or many extensions on the left, and click the right-facing green icon to put those extensions into the box on the
right. All of the extensions in the box on the right are allowed to use this panel.

Test your connection
Enter your CRM system username and password, and the phone number for a contact in your application. Click Test
Settings to see the results of your test.

This section is purely for testing your Switchvox's access to the CRM service, this Username and Password are not
used outside of this test. In the Switchboard panel,each user must enter their own login information.

Salesforce.com

This panel provides integration with your Salesforce.com account.

Extensions allowed to use this panel
Select one or many extensions on the left, and click the right-facing green icon to put those extensions into the box on the
right. All of the extensions in the box on the right are allowed to use this panel.

Test your connection
Enter your CRM system username and password, and the phone number for a contact in your application. Click Test
Settings to see the results of your test.

This section is purely for testing your Switchvox's access to the CRM service, this Username and Password are not
used outside of this test. In the Switchboard panel,each user must enter their own login information.

GoogleTM Maps

This panel provides integration with Google Maps.

Default Zoom Level
Select the level of zoom to use. The Switchboard user can always zoom in or out.

Extensions allowed to use this panel
Select one or many extensions on the left, and click the right-facing green icon to put those extensions into the box on the
right. All of the extensions in the box on the right are allowed to use this panel.
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Test your settings
Enter a phone number to look up. Click Test Settings to see the results of your test.

Custom Panels

Custom panels let you build your own panel that integrates with any Web application you choose. You can build the URL
with Switchvox variables, which pass caller data to the application.

Panel Name
Enter a unique name for this panel. The panel name appears as the title of the panel window.

Panel Description
Enter a description of this panel. This is only displayed in the Admin Suite, it is not shown in the panel.

Panel URL
This is the URL to be loaded in the panel, for example:

http://news.google.com/news?gq=%CALLER ID NAME$%

The URL can contain variables (between percent signs) that are substituted with real values during each request. (See
URL Variables.)
Extensions allowed to use this panel

Select one or many extensions on the left, and click the right-facing green icon to put those extensions into the box on the
right. All of the extensions in the box on the right are allowed to use this panel.

URL Variables

You can include one or more variables in a Custom Panel URL.

CALLER_ID_NUMBER
The phone number of the current caller. Example: 8585551212

CALLER_ID_NAME
The text component of Caller-ID for the current caller. Example: BOB JONES

EXTENSION
The extension of the current Switchboard user. This does not apply to who is calling, but is instead the extension who has

launched this Switchboard panel.

SESSION_ID
A string of numbers and underscores representing the current switchboard session. (There is no guarantee that this

session_id is unique across logins or machines.)

FIRST_LOAD
A boolean integer value indicating if this is the first time the panel is requesting the page. On startup, the panel will request
the URL without any associated call information with FIRST_LOAD set to 1. After subsequent calls, FIRST_LOAD will

be set to 0.

PARTIAL_REG_CODE
The last four digits of your Switchvox’s registration code.

FULL_REG_CODE_DIGEST
A hexadecimal MD$ hash of your Switchvox’s registration code.
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Distinctive Ringtones

Switchvox can store and play distinctive ringtones that can be used on Polycom phones (each phone needs a Phone Fea-
ture Packs). For details about using these ringtones on a SIP phone with a Phone Feature Pack, see the User Suite's
Phone Features

You can add as many ringtones to Switchvox as you want. However, each phone has two important limitations for
supporting ringtones that do not come standard on the phone:

» Maximum disk-use of 300 kilobytes for all ringtones
*  Maximum of 8 ringtones

Add a Ringtone

Add a Ringtone
Ringtone File (owasy filed: | |[ Browse...

Marme: | |

Add Ringtone

To add a ringtone:
1. Click Browse, and find the file on your computer.
2. In the Name field, enter a name for this ringtone.
3. Click Add Ringtone.

The Distinctive Ringtones list is refreshed, with your new ringtone listed.

Distinctive Ringtones List

This list shows the ringtones that you have uploaded to Switchvox, and the ringtones that come with a Polycom phone.

"/ Play the ringtone.
The audio file is downloaded to your computer, then played using your default audio player for WAV files.

' Edit the ringtone.
You can upload a new file, or change the Name.

X Delete the ringtone.
You must verify that you want the ringtone deleted. If you delete a ringtone, every Ring-Rule that uses that ringtone is
also deleted.
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System Setup

The System Setup tools let you configure hardware, channels, network, and other settings that form the foundation of
Switchvox.

Hardware Setup

The Hardware Setup tools let you scan for and configure new telephony hardware in the Switchvox server. You can also
manage and delete hardware devices.

If hardware has not been detected, please be sure that all cards are installed properly, and that the device you are using is
supported.

Hardware Devices

Each device connected to the Switchvox server is listed under Hardware Devices.

Hardware Setup

Manage any hardware devices associated with this PEX (T1, E1, Fs O, FXS cards)
@Tmuhleshuuting Hardware Setup

Hardware Devices [(1to 21 of 2

Card Type Device Type Dewvice Hame Spans Total Chnls Modify Device =
TOME0OP wetdmzdxxp Wildcard TOMBOOF Board 1 0 5 Configure
TEZHMP  t2xxp T2®®P (PCI) Card 0 Spanl 2 48 Configure

To configure a device, click Configure for that device. To delete a device, click Delete for that device, then verify that
you do indeed want to delete it. Devices are listed with Card Type, Device Type, Device Name, Spans (the logical
groupings of channels), and Total Channels.

If you have added new hardware, Switchvox detects it when you start the server. If you have deleted a device and want
Switchvox to detect it again, click Scan for New Devices. Switchvox detects the telephony hardware and includes it in
the Hardware Devices list.

Hardware Country Settings

If you need to change the country that your Switchvox server is located in, select it from the dropdown, then click Set
Country. This setting also sets the call-progress tone scheme, which determines the tones that are sent to your callers.
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Hardware Echo Cancellation

You can disable the hardware's echo cancellation so that all echo cancellation is handled by Switchvox. For details about
those settings, see Advanced Options under Channel Admin.

Echo Reduction

To reduce the echo on your analog lines, click Run Echo Reduction Tool. Switchvox runs a series of tests, then the
analog lines are automatically calibrated to the results. Click Remove Echo Reduction Settings to revert the settings
back to their default values.

We recommend running the Echo Reduction Tool if you move lines to other ports, or add new lines.

Running this tool causes your system to go offline for approximately two minutes per analog line. Any current phone calls
are dropped, and any agents logged in to call queues are logged out.

Channel Admin

The Channel Admin tools let you manage hardware device channels to enable multiple signaling methods and configure
callback extensions.

Channel Admin displays all the channels available in your system, and lets you group channels together by signaling
type. You can also modify or delete existing groups.

Extensions PB¥ Features System Setup Diagnostics

Channel Admin

Create Hew Channel Group

Wiew | Channel Groups |
Channel Groups (1tol1)ofl

# Group Mame < # Channels Signaling Method Callback Extension Modify / Delete

1 PRI Lines 0 PRI T1/EL B (Bearer) Channel 800 Modify

To create a channel group, click Create New Channel Group. This displays the Channel Group Configuration page.

Enter a name for the channel group, specify the device type, and select the channels to add to the group. Also enter the
Callback Extension and the Default Fax Extension for the channel. (Voice calls that do not match any Incoming Call rules
or routes are sent to the Callback Extension. If you have fax installed, Fax calls that do not match any Incoming Call
Routes are sent to the Default Fax Extension.) Unless you are an advanced user, do not change any of the other settings.

When you are done, click Create Channel Group to create the group.
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Extensions PBx Features System Setup Diagnostics
Channel Admin

Channel Group Configuration

Y MOTE: Unless vou are an advanced user, vou should only set the following Channel Gro
Group Mame, Device Type, and Callback Extension (if applicable).

Group Mame : | |

v

Device Type 2] . | Pleaze Choose “four Device Ty
i Pleaze Choose 'our Device Tupe
Advanced Option Fe20 [Foreign Exchange Office] with Eewlstart signaling
F0 [Foreign Exchange Office] with Loopstart zsignaling
Fe0 [Foreign Exchange Office] with Groundstart zignaling
F5 [Foreign Exchange Station] with Eewlstart signaling
Add Channels to £ Fx5 [Foreign Exchange Station] with Loopstart zsignaling
Fe25 [Foreign Exchange Station) with Groundstart zsignaling
There aren't any ch PRI T1/E1 D [Data] Channel
FRI T1/E1 B [Bearer] Channel

¢ . BRI D [0 ata) Channel
L WA.RNIN(-;. I BRI B (Bearer] Channel o your phone system. &y
connections will be E&M Signaling Bd out,

Create Channel Group

WARNING: Switchvox restarts after you create a new channel. Any current calls are dropped, and any agents logged
into queues are logged out.

Device Types

Device Type describes the type of line that is connected to the PBX through this device.

FXO and FXS

Foreign Exchange Office (FXO) and Foreign Exchange Service (FXS) device types refer to the type of interface on the
telephone equipment: an FXO interface receives power (battery) and receives ring signals; and an FXS interface provides
power (battery) and generates ring signals. FXO devices can only communicate with FXS devices and vice versa. Each
FXO and FXS type listed in the dropdown has an associated signaling type: kewlstart, loopstart, or groundstart. The
signaling type is the “language” the interface uses to communicate to the devices connected to it. Some devices have
their signaling type preset and cannot be changed (for example, analog cards). Some devices can have their signaling
type changed to match the devices they are connected to.

You cannot have both FXS and FXO channels in the same group. However, you can create more than one group per
signaling type.

FXO (Foreign Exchange Office) with Kewlstart signaling
Select this option if you are connecting normal analog phone lines from the phone company into your PBX. This option
can also be used with certain T1 lines or T1 channel banks in rare instances.
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FXO (Foreign Exchange Office) with Loopstart signaling
Do not use this option. Use FXO with Kewlstart instead. Kewlstart is fully compatible with Loopstart, and will detect
hangups on most lines which the Loopstart option does not do.

FXO (Foreign Exchange Office) with Groundstart signaling
Groundstart is an alternate type of signalling used with analog phone lines from the phone company. Groundstart phone
lines are slightly unusual, so double-check with your provider before selecting this option.

FXS (Foreign Exchange Station) with Kewlstart signaling
Select this option if you are connecting a normal analog handset to an FXS port of an analog card.

FXS (Foreign Exchange Station) with Loopstart signaling
It is recommended to use the Kewlstart option instead of Loopstart.

FXS (Foreign Exchange Station) with Groundstart signaling
Select this option if you are connecting a groundstart FXS device, such as another analog PBX, to the FXS port of an
analog card.

PRI

The Data channel is a single channel used for call control on T1/E1 PRI connections. It is usually on channel 24 for T1,
and 16 for E1 connections. The Bearer channels carry the audio for T1/E1 PRI calls. Full PRIs use all channels except for
the D channel. Partial PRIs use a subset for the Bearer channels.

PRI T1/E1 D (Data) Channel
The Data channel is a single channel used for call control on T1/E1 PRI connections. It is usually on channel 24 for T1,
and 16 for E1 connections.

PRI T1/E1 B (Bearer) Channel
The Bearer channels carry the audio for T1/E1 PRI calls. Full PRIs use all channels except for the D channel. Partial
PRIs use a subset for the Bearer channels.

BRI

The Data channel is the third channel on every BRI that controls signaling. The Bearer channels are the first two channels
on a BRI that actually pass calls.

BRI D (Data) Channel
The Data channel is the third channel on every BRI that controls signaling.

BRI B (Bearer) Channel
B channels are the first two channels on a BRI that actually pass calls.

E&M Signaling

The E&M (Ear & Mouth) Signaling device type is a different type of T1 signaling used by some telephone companies.

E&M Signalling
E&M signalling describes certain older T1 lines. Select this option if you have an E&M or E&M-wink circuit, sometimes
referred to as a Supertrunk.

Callback Extension
The extension to ring when a voice call comes in over this provider or channel. Callback extensions can be any extension

type (your receptionist’s phone, an IVR, etc.).
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SMB| pefault Fax Extension

SMB| The extension to ring when a call comes in over this provider or channel, and is identified as a fax. (Switchvox only
identifies T.38 faxes over SIP providers. A fax coming in over an IAX provider or a channel, or a fax using a different stand-
ard may not be identified as a fax.)

Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an Advanced
Option, click Show Advanced Options.

Aggressive Echo Cancellation
This option enables aggressive echo suppression in the Analog echo canceller. This is done by making the line half-

duplex, or by muting the party that is not actively speaking. While this does eliminate echo, it might cause other problems
such as not being able to interrupt a speaking party, or clipping on the leading and trailing edge of speech. Setting this
option to run for the first 5 seconds of a call is an effective way to eliminate echo that eventually trains out. Otherwise, it's
best to keep this option disabled.

Apply Noise Reduction Filter

This option applies a filter on calls to reduce analog line noise. This can improve quality on very old analog lines in rural
areas. Before enabling this option, it's best to call your provider to see if they can improve the signal quality or strength
from their end, as this option only masks over the noise.

Automatic Gain Correction
Enabling this will automatically adjust the received volume of calls to a standard volume level. This should be the first

thing to try if inbound calls are too quiet, specifically on analog lines.

Automatically determine call progress
Do not enable this option unless explicitly instructed to. Enabling this option in the wrong environment will result in

dropped calls.

Battery Debounce
This option is extremely advanced and only used in very rare circumstances in certain countries.

This option controls how Switchvox looks for a hangup signal on Kewlstart lines. In Kewlstart signalling, hangup is sent
by a voltage drop in the analog lines for a certain period of time.

The Battery Debounce controls how longSwitchvox waits until concluding that it has received a hangup signal. If set too
low, line noise or lightning or regular speech can be interpreted as a hangup. If set too high, correct hangup signals will not
be received. The default value for this setting is chosen to be the perfect balance. Do not change it unless you've phys-
ically measured the duration of a battery drop for your country's telephone lines.

Battery Threshold
This option is extremely advanced and only used in very rare circumstances in certain countries.

This option controls how Switchvox looks for a hangup signal on Kewlstart lines. In Kewlstart signalling, hangup is sent
by a voltage drop in the analog lines for a certain period of time.

The Battery Threshold controls how low the voltage must go before being considered dropped. The default setting for this
option will work in most countries. Do not change it unless you've physically measured the duration of a battery drop for
your country's telephone lines.

Caller ID Signaling
Caller-ID is sent over analog lines differently in different countries. This option controls which method to read the caller-

ID. The options are Bell (for countries like the USA), v23 (United Kingdom), and DTMF (Sweden). When changing this
value, also make sure to adjust the Caller ID Start value to correspond to your country.
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Caller ID Start
Different countries send caller-ID at different times. This option instructs Switchvox when to look for the caller-ID signal.

The choices are ring (for countries like the USA), or polarity (for countries like the United Kingdom).

Detect busy signal

This option will listen for the busy signal to trigger a hangup. It is strongly recommended to leave this option disabled
and have your telco send a true disconnect signal. This option may be enabled in countries that do not have disconnect
supervision. If you are in the USA, UK, Australia, or Canada, you should not need to enable this option. If this option is
enabled, it is advised to increase the Busy Count setting to as many tones as possible to avoid false-positives that may
result in dropped calls.

Echo Cancel

This option enables or disables echo cancellation on the system. We strongly recommend setting this option to Yes.
Setting this option to No will disable both software echo cancellation, and any onboard hardware echo canceller on the
given card.

Echo Cancel when bridging TDM channels
This option controls echo cancellation for calls that enter Switchvox on one hardware channel, and exits Switchvox on

another hardware channel. |E: this affects calls that do not touch any VolP Providers or SIP handsets.

Calls of this nature do not normally need echo cancellation, so it is safe to leave this option to the default of No. Note that
this setting does not apply to calls to normal SIP handsets.

Echo Canceller Tail Length
This controls how long the canceller should listen for echo to return. It is best to use the smallest value possible. For
analog lines, echo is usually in the 64 or 128 range. For T1 lines, 128 or greater.

Echo Canceller Type
Different echo canceller types may perform better in certain situations.

Analog
A good general-purpose echo canceller that works best on analog lines, or on T1 lines with shorter echo tails. This is the
default echo canceller, and is a good place to start.

T1
This echo canceller works best on T1 lines with long echo tails, but may also outperform other types in certain analog
environments.

HPEC
Digium, Inc.'s High Performance Echo Cancellation software. To use this option, you must have an HPEC license
installed.

Acoustic
This experimental echo canceller is tuned for acoustic echo. While good on paper, this method of cancellation hasn't
worked very well in practice.

SMB| Fax Buffer Policy
Set the Fax Buffer Policy for this Channel Group. To turn this option off, select Disabled. The default is Half.

This option lets you set a buffer policy to prevent fax failures on high latency systems. Please see the related option
Number of Fax Buffers.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.
SMB' Fax Detection
Set the Fax Detection for this Channel Group. For more information, see About Faxing.

Both
Detect incoming and outgoing faxes, and behave appropriately.
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No
Do not detect incoming or outgoing faxes.

Incoming
Detect incoming faxes and behave appropriately. Do not detect outgoing faxes.

Outgoing
Detect outgoing faxes and behave appropriately. Do not detect incoming faxes.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

SMB| Fax Error Correction Mode
Error Correction Mode (ECM). The default is to leave this feature enabled.

Hang up on Polarity Switch

Some countries, most notably Australia, signal remote hangup by switching the polarity of the lines. This is sometimes
called ROIC (Reverse On Idle Condition). Only enable this option if you have confirmed with your telco that hangups are
signalled with polarity reversal.

Hardware Echo Cancellation
This option enables the hardware echo cancellation module on BRI cards.

Hide caller id
Enabling this option will disable sending caller-id for this channel group.

SMB| Maximum transfer rate for fax transmissions
Maximum transfer rate used during fax rate negotiation. The default maximum transfer rate is 14400.

SMB| Minimum transfer rate for fax transmissions
Minimum transfer rate used during fax rate negotiation. The default minimum transfer rate is 2400.

Network Specific Facility Code
This option is rarely used. If you are unsure of what to do, leave it set to None.

NSF, or Network Specific Facility codes are special codes that are sent in PRI facility messages and are used to signal
additional data to your telephone company. Do not change this setting unless your telephone company explicitly stated
that they require a specific NSF value.

SMB| Number of Fax Buffers

Set the number of fax buffers. The default is 12.

This option lets you set a buffer policy to prevent fax failures on high latency systems. Please see the related option Fax
Buffer Policy.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

Overlap dial
Overlap dialing sends each digit pressed as it's entered, instead of sending the entire number all at once. It is safe to
leave this option disabled.

Pause Before Dialing
This option adds a slight delay to allow the off-hook signal to propagate to the telephone company before sending down
DTMF digits. This should not need to be changed.

PRI Dialplan
This controls how outbound calls are sent over the PRI. Check with your PRI provider to confirm which method they
prefer.

PRI Reset Interval
The default value for this option, 3600, is usually correct.
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This controls how often the PRI B channels are reset when they are unused. For the vast majority of PRI lines, this has
no effect on the PRI and is purely done just to be safe. However, some PRIs in countries such as India may have
problems with being reset. In that case, you may want to enter a value of never.

PRI Switch Type
Your PRI provider should be able to provide you with the preferred PRI Switchtype. The most common option is National
ISDN 2, sometimes referred to as NI/2.

Relax DTMF recognition

Enabling this option will make the DTMF interpreter much more permissive. If you are having trouble receiving DTMF key
presses in [VRs with calls over a channel group, enabling this option may help. Unfortunately, it also may result in many
more false positives, or double keypresses. In cases where poor line quality is hampering DTMF detection, it is highly
recommended to improve the line quality first before enabling this option.

Ring Debounce
This option is only used in very rare circumstances in certain countries.

This option controls how long Switchvox waits before confirming a ring on analog lines. The value is in 1/8000ths of a
second, and the default is 1024. Larger numbers cause Switchvox to wait longer, potentially making it harder to receive
false-positives or ghost calls. Smaller numbers cause Switchvox to be more sensitive to rings.

RX Gain
We recommend enabling Automatic Gain Correction before altering this option.

This controls the volume of audio received from this channel group. For example, if incoming callers are too quiet or too
loud, this option can change the volume. Values are in decibels, and can be positive or negative to make calls louder or
quieter respectively. This is usually only needed on analog lines (not T1 lines) to compensate for signal loss in the wires.
Normal values range in the -15 to 15, and it's recommended to start low, and increment the gains by a factor of 2 until they
reach the correct volume (e.g., 2, 4, 6, 8...).

Secondary Device Type
This option should almost always be set to PRI (Primary Rate ISDN) CPE Side. Consult your T1 provider before

selecting an alternate option.

Train echo canceller at beginning of calls
This option sends a pulse at the beginning of a call in the attempt to pre-train the echo canceller. This can improve

situations with echo at the beginning of a call.

TX Gain
This controls the volume of audio sent from this channel group. It is recommended to not increase this value, although

lowering it to -3 may improve call quality and/or echo. If in doubt, leaving this setting at the default of 0.0 is recommended.

Use Caller ID
Enabling this option will enable receiving (and sending) caller-id.

It's almost always recommended to leave this set to Yes. The one situation where it may be prefereable to disable caller-
id is when using analog lines in a country (such as the USA) that sends the caller-id between the first and second ring. In
order to receive caller-id on analog lines, Switchvox has to wait until the second ring before answering. If caller-id is
disabled, Switchvox will answer inbound calls immediately, without waiting for the caller-id.

Wait Duration
This forces the system to wait the specified number of seconds before answering the call, allowing time to receive all of
the call data before answering the call. The default is 1. Most likely you do not need to change the default.

Phone Setup

If you purchased your phones with Switchvox, then your phones are already configured. It's going to be very easy to get
your phones up and running!Plug the phones into your network and wait for them to start up. Once you see the date and
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time on the phone’s display, pick up the handset and dial 800. This extension rings a sample Interactive Voice Response
(IVR) menu. The call should connect and you should hear a recorded voice say “congratulations, Switchvox has been
configured properly.”

If you did not purchase your phones with Switchvox, we offer the Phone Setup tool that lets you easily set up phones
from Polycom® and snom technology Inc.

Note: If you do not have these types of phones, you need to refer to your phone’s documentation for information on how to
set it up for use with Switchvox.

Select System Setup > Phone Setup to display the Phone Setup page.
The following must be in place before you set up your phones. Make sure that

» Switchvox is up and running.

* Your phones are on the same network as Switchvox.

* You have a Phone Feature Packs available for each phone.

* Any Polycom phones you are setting up are running SIP firmware 1.6.7 or higher.

* Any snom phones you are setting up are running snom firmware version 6.5.18 or higher.

* You are comfortable with Switchvox updating each phone’s firmware as necessary. If you do not want a phone’s
firmware updated, you need to set up that phone manually (not as part of this Phone Setup process).

* You are comfortable with Switchvox setting each phone’s config authentication login and password, and its
handset password. The config authentication login and password are randomly generated and can be found in the
Configured Phones list. The handset password is always 456. If you do not want this information changed for a
phone, you need to set up that phone manually (not as part of this Phone Setup process).

IMPORTANT: If your phone is not on the same network as Switchvox, or it does not have the required firmware, it cannot
be discovered by Switchvox. If this is the case, see Making Phones Visible to Switchvox. If you have a Polycom 300 or
500 phone, you must set up your phone manually (you cannot use the Phone Setup tool). For help, see the
documentation for your phone.

The Phone Setup tool has three main categories: Unknown Phones, Unconfigured Phones, and Configured Phones.
You must confirm each phone for configuration, and then configure each phone with extension details.

To begin setting up phones on Switchvox:

1. Place each phone where it should be located, plug it into your network, and turn it on. At this point, it is helpful to note
the MAC address of each phone, but it is not necessary.

When each phone boots up (after you turn it on), Switchvox detects it and adds it to the Unknown Phones list.
These are phones that Switchvox has seen on the network, but does not have control over.

2. Inthe Admin Suite, select System Setup > Phone Setup.

The Phone Setup page opens to Unknown Phones. If a phone does not appear here, try rebooting the phone.

Unknown Phones

Unknown phones are the phones that Switchvox has found on your network, but they are not yet configured for use with
Switchvox. (These phones do not receive any configuration files from Switchvox.)

Phones that have not been detected on the network in over 14 days will stop showing up in the Unknown Phones list.
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Unknown Phones P Unconfigured Phones b Configured Phones

Fernaining phone configuration tokens: 150

[* Show Advanced Options

Confirm Checked Phones

Unknown Phones { 1to 3 ) of 3

IE MALC Address = Last Seen IP Address Phone Brand Ph
[] o00:04:13:29:30:67 03/18/09, 2:27 PM 10.10.3.145 Snom Me
[] 00:04:13:40:07:28 03/16/09, 2:24 PM 10.10.3.195 Snom Mo
Wl 00:04:f2:02:1a:5e 03/18/09, 3:09 PM 10.10.3.221 Palvcamn M

1. Check the box next to each phone you want to configure, and then click Confirm Checked Phones. Switchvox sends
firmware and configuration files to the phone, then a command to reboot.

IMPORTANT: If you do not want to configure a phone, do not check its box. That ensures that the phone does not
receive Switchvox configuration files. In particular, if you have more than one PBX on your local network, make sure
that you do not confirm phones that are set up on another PBX. This overwrites the configuration of these phones and
they will no longer connect properly to the other PBX Phones.

2. Be sure that each phone has finished rebooting. This can take as much as 10 minutes, and it is important that it is fin-
ished before you move on to the next step. If the date and time are shown on the phone’s display, that indicates that it
has finished rebooting.

Once your phone has finished rebooting and is back online, it is in the Unconfigured Phones list. Now it needs to be
assigned an extension.

Phone Model Not Reported

Switchvox is not able to determine the phone model for some phones. Despite that, these phones can still be configured.
During the configuration process, Switchvox updates the firmware on the phone (if necessary), and that helps to
determine the model.

Unconfigured Phones

Unconfigured phones are the phones that are registered with Switchvox and can receive configuration files, but these
phones do not yet have an assigned extension.

Note: The ‘Config Authentication’ Login and Password shown on this page are used when the phone requests a current
configuration file from Switchvox. This is different from the phone’s registration login, and the extension’s login, and you
can safely ignore this information.

To remove a phone from this list and put it back on the Unknown Phones list, check the box for that phone and click
Reject Checked Phones.

Accept Checked Phones Reject Checked Phones

nconfigured Phones (1to131ofl
Switchvox Administrator Manual
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To assign an extension to a phone:
1. Enter the extension in that phone’s row. You can use an existing extension as long as it is a SIP extension, and has
not already been configured for use by a phone.

If you know the phone’s MAC address and the extension that belongs with it, you can enter the extension on this
page. Do this for each phone that you know the extension for.

If you do not know the phone’s MAC address, pick up each phone’s handset and follow the prompts to enter the cor-
rect extension for that phone. When you are done, go back to the Phone Setup page. The Unconfigured Phones list
now has an extension listed for each phone.

If an extension already existed, the owner’s name and other information is displayed.

2. If the extension does not already exist, enter the extension owner’s first and last name, and email address. You can
also select the Extension Template you want to use to create this extension (or just leave it set to Default).

3. If you have a secondary Switchvox for the phone, enter that IP address in the Alternate Host field.

If a phone is unable to reach the primary Switchvox (this one that you are using to setup this phone), the phone will try
to connect with a SIP server at this IP address. This should be a secondary Switchvox with the same configuration
as your primary Switchvox. You can set up a secondary Switchvox using Backups from this primary Switchvox.

4. Once each phone has the correct extension, check its box and click Accept Checked Phones.

Switchvox creates any extensions that do not already exist, pushes out the final configuration to each phone, and sends a
command to each phone to reboot again.

If an extension already exists, this process does not change the phone’s registration login, or the extension’s password. If
the extension is created in this process, then the phone registration login is randomly generated, and the extension
password is the same as the extension number.

Once your phone has finished rebooting and is back online, it is in the Configured Phones list. If you want to assign
additional lines to this phone, you can do that on the Configured Phones page.

Configured Phones

The phones are now on the Configured Phones list on the Phone Setup page. Each time a configured phone reboots, it
receives configuration updates and its user’s specified Phonebook (see the User Suite's Phone Features Options).
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Unknown Phones P Unconfigured Phones I Configured Phones
Phone Feature Packs Available: 9999 fourrently using 2)

Femaining Phone Feature Packs: 2997

[* Show Advanced Options

Unconfigure Checked Phones Reboot Checked Phones

Configured Phones ( 1to 2 ) of 2

IE MAC Address = Phone Infa Ext. Infao Z
[] oo:0d:f2:05:b1:ad IP Address: 10.10.3.120 Extension: 101
Phone Brand: Palyvcom First Mame: lustine P
Phone Model: IPS01 Last Mame: Kilzan
Email:

Alternate Host:

"FHide Additional Lines.

System Ext Extension Host Alternate Host Fart Uzer ID Fassw
Line 2: [ves ] ft02 |2 | | | | | | | | |
Line 3: Mo v | | |E~. ||:n|:n>-<.r'n_‘,f|:ni2.n::n:nr‘n | |phxhackup.r‘ny|:niz.c:n:nr| |5EIEiEI | |'IEIE | |33|:|CE

Save Line Settings

Additional Lines

Click Show Additional Lines to add or remove 2 additional lines on this phone.
To add a line, specify whether this is a Switchvox Extension or not, and then enter the extension information.

« Ifitis a Switchvox extension, you just need to enter that extension number.

+ Ifitis not a Switchvox extension, you can enter host name, alternate host name (if available), Port, User ID, and
Password.

*“Hide Additional Lines

Systermn Ext Extension Host Alternate Host Port User 1D Password
Line 2 [Yes v | |1':|2 |E~. | | | | | | | | | |
Line 3: No v | |E~. ||:|I:ux.myl:|iz.|:|:|m | |hxbackup.mybiz.n:u:um| |5EIEEI | |1EI2 | |E3|:|CBS|| |

Save Line Settings
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Making Phones Visible to Switchvox

If Switchvox cannot discover your phone (you cannot see your phone in the Unknown Phones list), you need to
manually point the phone to the Switchvox server.

For Polycom phones: Reset the phone back to its factory defaults, then set the network configuration Server type to
HTTP and the Server Address to ‘SWITCHVOX_IP_ADDRESS/pc.’ For example, if Switchvox has an IP address of
192.100.0.71’ then set the server address to ‘192.100.0.1/pc’. To do this for Polycom models 320, 330, and 430, hold down
the 1, 3, 5, and 7 keys simultaneously. For other models, hold down the 4, 6, 8, and * keys until the phone prompts you for
a password. Then press 4, 5, 6 on the keypad, then select Exit.

For snom phones: Reset the phone back to its factory defaults, then set the Setting URL to ‘SWITCHVOX_IP_
ADDRESS/pc/PHONE_MAC_ADDRESS.xml. For example, if Switchvox has an IP address of ‘192.100.0.1’and the
phone has a MAC address of ‘00:11:11:AF:2A:EA’, then set the Setting URL to *192.100.0.1/pc/00:11:11:AF:2A:EA.xml’.
(See your phone’s user manual for instructions on how to accomplish this.)

After those changes, make sure that the phone is rebooted. Rebooting can take as much as 10 minutes, and it is
important that you let it finish completely. If the date and time are shown on your phone’s display, that indicates that your
phone has finished rebooting.

When your phone reboots and comes back online, it appears in the Unconfigured Phones list in Phone Setup.

IMPORTANT: To configure phones that are external to your network, Switchvox must be accessible outside of your
network over port 80. Please contact your network administrator for information about how to do this.

Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an Advanced
Option, click Show Advanced Options.

Alternate Host Default Option

Check this box if you want to use the default for the Alternate Host option. The default is the PBX's external
IP/hostname. The default is only applied if a phone does not have a setting in the Alternate Host option.

Only Accept Calls from the PBX

Check this box if your Switchvox-configured phones should only accept calls from this Switchvox.

Digit Map Options

When your phone gets configuration files from Switchvox, then Switchvox provides digit map settings for your phone
based on the extension lengths your system uses and typical dialing requirements.

Extension length
This is the setting your digit map uses for dialing extensions on Switchvox. By default this is the length of the longest

extension. You might change this if you have two Switchvoxes that are peered together and they use different extension
lengths.

Use 10 digit local dialing
Some providers require 10 digits to be entered, even for local dialing. If this is the case for your provider, you should check

this box.
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Custom Digit Map
You can specify a custom digit map for Switchvox-configured phones. If you do this, Switchvox ignores all the other rules

for creating a digit map, and pushes the custom digit map to your configured phones.

Custom Digit Map Timeout

You can specify a Timeout (in seconds) for each segment of your custom digit map. If there are more digit maps than
timeout values, the default value of 3 is used. If there are more timeout values than digit maps, the extra timeout values
are ignored.

Phone Discovery Options: DHCP Sniping

Polycom phones with SIP Applications prior to 2.2.2 do not support DHCP INFORM. To configure these older phones,
Switchvox must be more aggressive, usurping your network’s DHCP server. Once the phone is upgraded, Switchvox
returns to normal behavior. It’s probably safe to leave this option enabled, but if your DHCP server reacts poorly when
older phones are configured, disabling this option might help.

Custom NTP Server

You can specify an Network Time Protocol Server to set the time on your Switchvox-configured phones.

Phone Feature Packs

Phone Feature Packs let you easily configure your phones for use with Switchvox, and offer great tools for customizing
your phones.

You need one Phone Feature Pack per SIP phone. Please see your reseller for instructions on purchasing and activating
more Phone Feature Packs. If you purchased your phones with Switchvox, then each phone already has its own Phone
Feature Pack, and is already configured for use with Switchvox. Phone Feature Packs are not necessary for any other
type of extension.

A Switchvox Phone Feature Pack offers the following features:

» Customized phone displays
Customize some of the information displayed on your phone. See Phone Options.

5,

o

» Status Indicators
Set a line status indicator light on your phone. This can show whether a call is waiting in a parking
lot, or whether you are logged into a queue. See Status Indicator Entries.

» Distinctive Ringtones
Set the audio file of your choice to ring on incoming calls, depending on the caller. See Distinctive Ring Rules.

* Auto-answer
Set an automatic answer in Intercom mode, depending on your caller. See Distinctive Ring Rules.

» Combine Ringtones and Auto-answer
Combine a ringtone and auto-answer, depending on the caller. See Distinctive Ring Rules.

* Phone Applications
Access many of the Switchvox features right from your phone.

The Phone Features available on your phone will vary, depending on the type of phone you have.

* The General Options are available on snom and Polycom phones.

» The other features are only available on Polycom phones. If you have a newer Polycom phone with three or
more lines (e.g., the VVX 1500 or SoundPoint 450, 550, 560,650, or 670) you should be able to take full advantage of
your Phone Feature Pack. Other Polycom phones may not offer all of the features.
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» If you use Switchvox remotely (your phone is not on the same network as Switchvox), you will not see
Switchvox Caller Profiles.

VOIP Providers

This lets you manage your Voice Over Internet Protocol (VOIP) Providers. VOIP providers can be either commercial
VOIP phone services, or other VOIP hardware such as a peered Switchvox.

There are two types of VOIP providers: SIP or IAX. (These are two common protocols used for placing phone calls over
the internet.) If you are unsure which protocol to use, ask your service provider.

Extensions PBE Features System Setup Diagnostics

VOIP Providers

_n_Manage YOIP Providers |2/

Add New: [ SIP Provider m

WOIP Providers ([ 1to 2 ) of 2

# Provider Type Provider Name & Account ID Hostmame Callback Extensior
1 IAx Junction Metworks svtesting jax.jnctn.net a0
2 Iax Feer with Partner devs di.switchyox . com 800

Pl rsa key 2

Download Current ESA key (pbx9183)

—OR-

Rename RSA key: | |

:E:RTP Port Rangel?)

From [10000 | to [20000 | [EE0N

Adding a SIP Provider

Select SIP Provider from the Add New dropdown, then click Go. The Add a New SIP Provider page is displayed.
Enter the information about the new provider, then click Add SIP Provider to create the new SIP provider.

After you have created a provider, you are prompted to go to the System Status page. This page displays your VOIP
providers and their status. If Switchvox successfully contacts your provider, it is displayed as Registered. Now if you
call the number your provider gave you, your call should ring the Callback Extension.
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Extensions PB¥ Features System Setup Diagnostics

VYOIP Providers

Add a Mew SIP Provider

SIP Provider Mame | |
@What i this used for?

four Account I0 | |
Elwhat's an Account ID?

Your Password | |

Hostname/IP Address | |
Elwhat does this mean?

ke

iCallback Extension
Elwhat's the Callback Extension?

Default Fax Extension I

@What is this used for?

DTMF Mode

Elwhat i DTMF Mode?

P click to Show Advanced Options

Add SIP Provider

SIP Provider Name
Create a name to refer to this provider. This is only used for referring to this Provider in other areas of the Admin Suite.

Your Account ID
The account ID provided to you by your SIP provider. This may also be called Login, or Authentication ID.

Your Password
Your password for the account.

Hostname/IP Address
The hostname or IP address for the SIP server, provided to you by your SIP provider. This may also be called Registrar

Server.

Callback Extension
The extension to ring when a voice call comes in over this provider or channel. Callback extensions can be any extension

type (your receptionist’s phone, an IVR, etc.).

Default Fax Extension

SMB| The extension to ring when a call comes in over this provider or channel, and is identified as a fax. (Switchvox only
identifies T.38 faxes over SIP providers. A fax coming in over an IAX provider or a channel, or a fax using a different
standard may not be identified as a fax.)

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.
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DTMF Mode
DTMF tones are the sounds emitted when you press buttons on your phone.

» SIP extensions: Refer to your phone's user manual for the DTMF mode that your phone uses.
» SIP providers: Ask your provider which DTMF mode it supports.

If you are unsure of which DTMF mode to select, use RFC2833 (the most common method).
Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an Advanced
Option, click Show Advanced Options.

Peer Settings

The Peer Settings determine the relationship with this provider.

Host Type
Provideris a host you must actively register to inform it of your location and settings. Peeris another SIP PBX, including
another Switchvox.

Host is the Same PBX
If this VOIP Provider is a peered Switchvox, set this to Yes. This lets you use advanced functionality with the peered
Switchvox.

Treat system’s users like local users
If you want Switchvox to exchange presence and line-use information with this peered Switchvox, set this option to Yes.

SMB| Jabber Hostname
You can specify a hostname for the peered Switchvox’s Jabber server. To find this hostname, look in the peered server's
Network Settings page.

This is important if you are peering Switchvoxes and want to use functions such asPresence or the Chat Panel.

Apply Incoming Call Rules to Provider
This option lets you alter the routing of incoming calls.

Yes is the default setting. It uses the rules on the Incoming Calls section as well as the Callback Extension to decide
which extension to ring when you receive a call over this provider.

Select Noif this provider is a peer. This allows callers from this peer to directly dial any extension in Switchvox. Incoming
calls will not follow the rules in the Incoming Calls section and they will not ring the Callback Extension.

Outgoing Call Rules

If you have selected No for the Apply Incoming Call Rules to Provider option, you can use this option to define how the
remote peer can place outbound calls through this Switchvox. Use the check boxes to assign which outgoing rules apply
to this peer. Check an Allow box to apply the rule to this peer’s inbound calls. Check a Deny box to block all calls that
match that rule, such as blocking all long-distance numbers. To bypass a rule, leave both options unchecked. See
Outgoing Calls for more information about each outgoing rule.

Caller ID Settings

The Caller ID settings determine how your Caller ID is set on outgoing calls.

Supports Changing Caller ID

Changing your caller ID information may cause all outbound calls to fail, so be careful when using this setting. Be sure
that your provider accepts a modified Caller ID, then enable this option and customize the Caller ID displayed on
outbound calls.

Caller-ID method
Leave this set to From Header unless your provider explicitly tells you to use a different setting. The vast majority of
providers require caller ID to be supplied in the From header.

Caller ID Name / Caller ID Number
Enter a name and phone number to display as your Caller ID when making outbound calls with this provider.
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WARNING: Setting this field may cause all outbound calls to fail; be sure that your provider supports this feature. If your
provider does not support this feature, clear the Caller ID Name and Caller ID Number fields.

Connection Settings
The Connection settings determine how the connection is established with this provider.

SIP Port
This is the UDP port used to communicate with this SIP Provider. By default this is set to 5060, the standard port for SIP
communication. This port can be changed if your provider or peer requires it.

SIP Expiry
This controls the duration (in seconds) between SIP registration requests sent to your provider. Selecting a value other
than 120 may cause problems with NAT routers. Do not change this unless explicitly instructed by your provider.

Proxy Host
If your SIP provider says you need to use a SIP proxy, enter the proxy host IP here.

Authentication User
If your SIP provider says you need a different authentication name than your account name, enter that authentication
name here.

Always Trust this Provider
Most providers require this option be set to Yes. It is alittle less secure because it does not require authentication on
incoming calls from this provider. If you set this to No and it does not work properly, set it back to Yes.

Note: This option lets the provider send you calls without authenticating. Most SIP providers do not authenticate,
therefore setting this to No will likely cause problems. Leave this option set to Yes unless instructed otherwise.

Qualify Hosts

Enabling this option sends a SIP Options packet to this SIP provider every 60 seconds. This keeps NAT tunnels open.
Response latency for these requests are shown in the System Status page. Note: Do not enable this option if your
provider does not respond to SIP Options packets.

Include user=phone in SIP
This option has no effect on the vast majority of SIP providers. Enable it if your provider explicitly requests it. This adds
the string “user=phone” on the end of the SIP URI used in various messages.

Use Local Address in From Header

Leave this set to No. Changing it to Yes will violate section 8.1.1.3 of the SIP standard, RFC 3261. Only set this to Yes if
your provider explicitly requests that you violate the SIP standard in this manner. If this is Yes, Switchvox uses its own
local IP address in the From header of requests.

SIP Provider Host List

Some SIP providers have multiple servers on the internet that communicate with Switchvox. For example, you may
register sip.example.com but receive calls from ny.example.com, la.example.com, and mia.example.com. Use this
option to list multiple hosts (or IP addresses) so that Switchvox can route calls from them. If you do not know if there are
multiple hosts, ask your provider. If there are multiple hosts, ask your provider to supply you with a list of their IP
addresses.

Call Settings

The Call settings determine how to manage calls with this provider.

Provider Codecs

Some providers support more than the normal codecs. These additional codecs may provide compression or other
features that save bandwidth or lead to better call quality. However, you should check with your provider before selecting
another codec, to be sure it is supported. If your Switchvox is a peer with another Switchvox, you can choose any audio
codec.

For SIP providers, the video codecs H.263, H.263+, and H.264 are available. Video calling is not available over IAX. The
following table describes the audio codecs. If you entered a license key for the G729 Codec in Machine Admin >
Digium Addon Products, you will also see G729 in the list of codecs.
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Table 1: Audio Codecs

Bandwidth
Codec Usage Sound Quality |CPU Usage
(kbits/s)
ULAW 85 Great None
ALAW 85 Great None
G722 85 Excellent Low
G726 54 Good Low
SPEEX 33 Great High
GSM 35 Good Low
ADPCM 54 Good Low
LPC10 22 Poor Medium

Map Distinctive Rings

Some providers let users set different ring tones based on the dialed number, but do not pass the dialed number
information directly. You may have to experiment with this setting and the settings of your SIP provider to get the right
phone number associated with the right ring type.

Enable Jitterbuffer
Enable this option to combat network problems. A jitterbuffer induces a small delay in call latency to make up for lost or

delayed voice packets. You may want to enable the jitterbuffer if you have bad network connectivity between Switchvox
and the Provider.

The options are as follows:
Never: It’s best to leave the jitterbuffer disabled if you are not having any audio quality problems.

When Needed: Intelligently enable the jitterbuffer with a dynamic window size when the call is terminated on Switchvox.
Try this option first if you have audio quality issues.

Always: Always enable the jitterbuffer with a dynamic window size. This may be useful if you are using phones or other
SIP devices that do not have their own jitterbuffer.

When Needed with Fixed Window: Intelligently enable the jitterbuffer with a fixed window size. This may be useful if
jitter is sporadic, yet sudden. Or, if you need to mask problems with poorly configured routers that cannot implement QoS.

Always with Fixed Window: Always enable the jitterbuffer with a fixed window size. Select this if all else fails. Note
that this just masks over the underlying issue. It’s best to fix the jitter problem itself, instead of using this option.

Allow Reunite
We strongly recommend leaving this set to Never.

Enabling this option is incredibly risky, and will likely result in sporadic one-way audio, dropped calls, or not being able to
place calls.

This lets Switchvox redirect the media stream of some calls, bypassing the PBX and passing directly between both
participants. This may offer bandwidth and quality improvements in certain scenarios, but it's extremely risky.

Never: This is the safest setting that presents the least likelihood of trouble.
Always: The PBX directs media streams between participants when it is able to. Set this at your own risk.

Non-NAT Connections Only: The PBX redirects media streams only between participants who are not behind NAT.
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Always, Using the UPDATE method: This is the same as the Always setting, but uses a different mechanism within
the SIP protocol. Only set this if you have been explicitly instructed to do so.

Non-NAT Connections Only, Using the UPDATE method: The PBX redirects media streams only between
participants who are not behind NAT, using a different mechanism within the SIP protocol.

IMPORTANT: This setting is just a recommendation to Switchvox that reinvite is possible. There are many scenarios,
such as when a call is being monitored or recorded, where Switchvox will not be able to reinvite the call away.

Always Send Early Media

Setting this option to Yes causes Switchvox to send RTP audio before a call is answered. Enabling this option may
resolve an issue where audio is not sent by certain SIP providers when an inbound call is cascaded out of the same
provider.

Voicepulse Connect DID Workaround

This option is a workaround for SIP providers that send two INVITE messages for every phone call to handle SIP devices
that handle DIDs and ones that do not. Only enable this option if you are sure your provider is sending two INVITEs for
every call: one with the DID in the From header, and one with your account ID in the From header.

SMB| Fax Settings
The Fax settings determine how faxes are handled with this provider.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

IMPORTANT: We recommend that you only send T.38 faxes over SIP. We do not recommend sending faxes over IAX
connections. Switchvox cannot necessarily recognize a fax over an IAX connection.

Error Correction Mode for G711 Faxes
The default is to leave this feature enabled.

SMB| Minimum transfer rate for fax transmissions
Minimum transfer rate used during fax rate negotiation. The default minimum transfer rate is 2400.

SMB| Maximum transfer rate for fax transmissions
Maximum transfer rate used during fax rate negotiation. The default maximum transfer rate is 14400.

Maximum expected T38 packet delay

The result of this specification is that all T38 packets are padded to prepare the fax stack for the specified delay. As long
as the packet delay is less than or equal to the specified value, the fax stack will not realize that there is an actual packet
delay because of the packet padding. The default value of 800 milliseconds should cover most use cases.

Fax Detection
This option describes the method of fax detection. The default is Yes.

Yes
Detect incoming faxes based on the receipt of a CNG tone or a T.38 invite.

CNG
Detect incoming faxes based on the receipt of a CNG tone.

T.38
Detect incoming faxes based on the receipt of a T.38 invite, without CNG tone.

No
Do not detect incoming faxes.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

Error Correction Mode for T.38 Faxes
Error Correction Mode (ECM). The default is FEC.
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Initiate T38 reinvite after timeout
This option initiates a T.38 re-invite if it is not received within 10 seconds. The default is Yes.

Enable Audio Failover
This option causes Switchvox to revert to audio fax mode in the event that T.38 negotiation fails. The default is Yes.

Adding an IAX Provider

Select IAX Provider from the Add New dropdown, then click Go. The Add a New IAX Provider page is displayed.
Enter the information about the new provider, then click Add IAX Provider to create the new IAX provider.

After you have created a provider, you are prompted to go to the System Status page. This page displays your VOIP
providers and their status. If Switchvox successfully contacts your provider, it is displayed as Registered. Now if you
call the number your provider gave you, your call should ring the Callback Extension.
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Extensions PB» Features System Setup Diagnostics

YOIP Providers

Add a MNew IAX Provider
EIHDW do I setup IAX

Ia% Pravider Mame | |
IEI Whatis this used for?

[a% Pravider Label | |
El How do I find out my Provider

Labal?

Your Account 1D | |
EI What's an Account ID?

Your Password | |

Hostname/IP Address | |
E What does this mean?

Callback Extension | | &
EI What's the Callback Extension?

Incorming Authentication Type MD5 w
EI Tell me about authentication

RSA Authentication Key Use Existing Key: [ freeworlddislup |

or Upload Mew Key:| | Browse..

Caller ID Mame | |
EI Whatis Caller ID Hame?

Zaller ID Mumber | |
EI Whatis Caller ID Number?

[ Click to Show Advanced Options

Add IAX Provider

IAX Provider Name
Any string to identify this VOIP provider. This is only used for referring to this VOIP Provider in other areas of the Admin

Suite.
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IAX Provider Label

Label this provider gives itself when placing calls to your system. This is usually the name inside of [ ] brackets in

Asterisk configuration examples.

Your Account ID

Username provided by IAX Provider to authenticate your Switchvox PBX to the provider during IAX registration and

outbound calls.

Your Password
Your password for the account.

Hostname/IP Address

Primary hostname or IP address of your provider's IAX server. This hostname will be used to send registration requests.
It will also be the host that will send any inbound calls to your PBX.

If your provider has multiple servers for their IAX service, you can use the Primary, Secondary, and Tertiary Outbound
Host settings to list them. Otherwise, the Hostname/IP Address field will be used for placing outbound calls as well as

inbound calls and registration requests.

Callback Extension

The extension to ring when a voice call comes in over this provider or channel. Callback extensions can be any extension

type (your receptionist’s phone, an IVR, etc.).

IAX Configuration Files

Many IAX providers distribute their configuration instructions in the form of configuration files for the Asterisk PBX. The
following information will enable you to translate between Asterisk configuration files and Switchvox's IAX Providers

information.

Note: This section is not necessary if you do not need to convert settings from Asterisk configuration files.

Here is an example register line in the iax.conf configuration file:

iax.conf register state-
ment:

IAX Provider fields

register =>

Here is a section in the iax.conf configuration file:

iax.conf parameter
[label]

username=myuser

secret=mypassword

host=iax.provider.com
type=peer

context=notused

auth=rsa

inkeys=keyname
callerid="John Doe <5551212>"
disallow=all

allow=ulaw

allow=alaw

Your Account ID Your Password

:password @iax.provider.com

Hostname/IP Address

IAX Provider fields
IAX Provider Label
Your Account ID
Your Password or

Incoming Password

Hostname/IP Address

not used

replaced by Callback Extension
Incoming Authentication Type

RSA Authentication Key

Caller ID Name and Caller ID Number

Provider Codecs
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In the extensions.conf file, here is how to extract the settings from a Dial command:

extensions.conf exten=> _ ) . .
Dial string: X_.1, Dial(IAX2/ username :password @iax.provider.com /${EXTEN})
Hostname/IP

Address or

Primary Outbound

Host or
IAX Provider fields Your Account ID Your Password

Secondary
Outbound Host or

Tertiary Outbound
Host

Incoming Authentication Type

Select one of these choices from the dropdown: MD5, plaintext, and RSA. MD5 and plain text use your password for
authentication. It is preferable to use the MD5 method over the plain text method. RSA uses public and private encryption
keys to authenticate the provider. If you select this option, enter the public RSA key in the RSA Authentication Key field.

RSA Authentication Key
Select from the dropdown of available keys, or from your computer hard drive.

Caller ID Name / Caller ID Number
Enter a name and phone number to display as your Caller ID when making outbound calls with this provider.

WARNING: Setting this field may cause all outbound calls to fail; be sure that your provider supports this feature. If your
provider does not support this feature, clear the Caller ID Name and Caller ID Number fields.

Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an Advanced
Option, click Show Advanced Options.

Peer Settings

The Peer Settings determine the relationship with this provider.

Registration Type
This setting controls registration between this Switchvox and the remote host.

Provider is the default setting where this Switchvox sends registration to the remote host.
Client is the setting where the remote host is the client and it sends registration requests to this Switchvox.

Peeris the setting for peered hosts that do not need to register. If you choose Peer, make sure that both hosts have static
IP addresses.

Host is the Same PBX
If this VOIP Provider is a peered Switchvox, set this to Yes. This lets you use advanced functionality with the peered
Switchvox.

Treat system’s users like local users
If you want Switchvox to exchange presence and line-use information with this peered Switchvox, set this option to Yes.
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SMB| Jabber Hostname
You can specify a hostname for the peered Switchvox’s Jabber server. To find this hostname, look in the peered server's
Network Settings page.

This is important if you are peering Switchvoxes and want to use functions such asPresence or the Chat Panel.

Apply Incoming Call Rules to Provider
This option lets you alter the routing of incoming calls.

Yes is the default setting. It uses the rules on the Incoming Calls section as well as the Callback Extension to decide
which extension to ring when you receive a call over this provider.

Select Noif this provider is a peer. This allows callers from this peer to directly dial any extension in Switchvox. Incoming
calls will not follow the rules in the Incoming Calls section and they will not ring the Callback Extension.

Outgoing Call Rules

If the Apply Incoming Call Rules to Provider option is No, use this section to define how the remote peer can place
outbound calls through this PBX. Use the check boxes to assign which outgoing rules apply to this peer. Check the Allow
box to apply the rule to this peer's inbound calls. Check Deny to block all calls that match that rule, such as blocking all
long-distance numbers. To bypass a rule, leave both options unchecked. See Outgoing Calls for more information about
each outgoing rule.

Connection Settings
The Connection settings determine how the connection is established with this provider.

Primary, Secondary, Tertiary Outbound Hosts

Some IAX providers use different hosts for registration, incoming, and outgoing calls. If your provider has multiple hosts
for placing outbound calls, you can use the Primary, Secondary, and Tertiary Outbound Host fields to specify them. If
these are left blank, the PBX will use the host specified in the Hostname/IP Address field for outgoing calls.

Incoming Password

If this provider uses passwords forincoming call authentication and the password is different from your account
password, specify it here. This condition is rare unless you are peering with a remote host and have explicitly configured
the inbound and outbound passwords to be different.

Qualify Hosts
Enabling this option will periodically send IAX POKE packets to the remote host and time their response. This latency
measurement can then be seen in the System Status page.

Enable Jitterbuffer

Enable this option to combat network problems. A jitterbuffer induces a small delay in call latency to make up for lost or
delayed voice packets. You may want to enable the jitterbuffer if you have bad network connectivity between Switchvox
and the Provider.

Enable Trunking

Trunking can be used to reduce the bandwidth used across multiple simultaneous calls; however, it must be enabled on
both sides of the link. This is useful when you have two systems peered together over IAX with heavy voice traffic. If
using commercial IAX services, check with the provider to see if it supports trunking. Enabling trunking on only one host
will result in one-way audio on phone calls.

Use RSA Authentication for Outgoing
Before setting this option, place your public RSA key on the remote host. You can retrieve this system's public RSA key
in System Setup> VOIP Providers.

Call Settings
The Call settings determine how to manage calls with this provider.

Provider Codecs
Some providers support more than the normal codecs. These additional codecs may provide compression or other
features that save bandwidth or lead to better call quality. However, you should check with your provider before selecting
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another codec, to be sure it is supported. If your Switchvox is a peer with another Switchvox, you can choose any audio
codec.

For SIP providers, the video codecs H.263, H.263+, and H.264 are available. Video calling is not available over IAX. The
following table describes the audio codecs. If you entered a license key for the G729 Codec in Machine Admin >
Digium Addon Products, you will also see G729 in the list of codecs.

Table 1: Audio Codecs

Bandwidth
Codec Usage Sound Quality |CPU Usage
(kbits/s)
ULAW 85 Great None
ALAW 85 Great None
G722 85 Excellent Low
G726 54 Good Low
SPEEX 33 Great High
GSM 35 Good Low
ADPCM 54 Good Low
LPC10 22 Poor Medium

SMB| Fax Settings
The Fax settings determine how faxes are handled with this provider.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

IMPORTANT: We recommend that you only send T.38 faxes over SIP. We do not recommend sending faxes over IAX
connections. Switchvox cannot necessarily recognize a fax over an IAX connection.

Error Correction Mode for G711 Faxes
The default is to leave this feature enabled.

SMB| Minimum transfer rate for fax transmissions
Minimum transfer rate used during fax rate negotiation. The default minimum transfer rate is 2400.

SMB| Maximum transfer rate for fax transmissions
Maximum transfer rate used during fax rate negotiation. The default maximum transfer rate is 14400.

Adding a Peered PBX

You can set up two or more Switchvoxes so that you can make inter-Switchvox calls without employing a phone service
provider. This is referred to as ‘peering.” To peer with another Switchvox, you set up a new VOIP provider that is really the
other Switchvox. The preferred protocol for peering is IAX, because there are fewer port-forwarding requirements than
SIP.

IMPORTANT: If you are doing any video calling with Switchvox peers, you must use SIP. Video calling is not available
over IAX.
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The following instructions describe how to set up two offices, one in London and one in Boston. Both have their own
Switchvox installation and broadband connection.

1. Assign extensions.

To make call routing easier, it's a good idea to make all London extensions start with one number, and Boston exten-
sions start with a different number. In this example, we will make all London extensions 200-299, and all Boston
extensions 400-499.

2. On each Switchvox, set up a VOIP provider that is the other Switchvox. Select System Setup > VOIP Providers,
then add a new IAX or SIP provider. The settings are as follows. You need to click Show Advanced Options to
access some of these settings.

In the new provider on the London Switchvox:

* For SIP:
Provider Name: Boston PBX
Your Account ID: pbx

* For |AX:
Provider Name: Boston PBX
Provider Label: boston_pbx
Your Account ID: london_pbx

* Your Password: pbxL
* Hostname/IP Address: boston.com (or an IP address)
» Jabber Hostname: jabber.boston.com

In the new provider on the Boston Switchvox:

e For SIP:
Provider Name: London PBX
Your Account ID: pbx

* ForlAX:
Provider Name: London PBX
Provider Label: london_pbx
Your Account ID: boston_pbx

* Your Password: pbxB
* Hostname/IP Address: london.com (or an IP address)
» Jabber Hostname: jabber.london.com

In the new provider for both Switchvoxes, set the following options the same way:

» Callback Extension: Leave this blank.

+ Default Fax Extension (SIP only): Leave this blank.

* DTMF Mode (SIP only): RFC2833

* Incoming Authentication Type (IAX only): MD5
 Caller ID Name and Number (IAX only): Leave these blank.
» Host Type: Peer

* Host is a Switchvox PBX: Yes

* Treat system’s users like local users: Yes

» Apply Incoming Call Rules to Provider: No

* Outgoing Call Rules: check the box for Allow Internal
* Qualify Hosts: Yes

Scroll down and click the Add Provider button to save your changes and add the new provider.
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3. On each Switchvox, set up an Outgoing Call Rule to the other Switchvox. Select System Setup > Outgoing Calls,
and click Add New Outgoing Rule.

In the new outgoing rule on the London Switchvox:

* Rule Name: Boston Switchvox
* |s this rule final? Yes

* Pattern to match:
Number begins with the digits 4
The rest of the number must be between 2 and 2 digits in length.
(Leave the remaining two fields blank.)

* Call through: Select the new VOIP Provider Boston Switchvox.
* Allow all existing extensions to use this rule? Yes

In the new outgoing rule on the Boston Switchvox:

* Rule Name: London Switchvox
* Is this rule final? Yes
* Pattern to match:
Number begins with the digits 2
The rest of the number must be between 2 and 2 digits in length.
(Leave the remaining two fields blank.)
« Call through: Select the new VOIP Provider London Switchvox.
+ Allow all existing extensions to use this rule? Yes

Click Add Outgoing Rule. A message is displayed that indicates the new outgoing rule was successfully created,
and the new rule is included in the list of rules. Highlight the new rule and click the Up arrow until the new rule is a
higher priority than the Internal rule.

4. If either Switchvox is behind a NAT router, you need to enable port forwarding on that router, and configure that
Switchvox’s Network Settings.

If the IP address of either Switchvox is in the following ranges, it is behind a NAT router:

192.168.0.0 - 192.168.255.255
10.0.0.0 - 10.255.255.255
172.16.0.0 - 172.32.255.255

The following ports need to be forwarded from your router to Switchvox:

For IAX traffic: UDP port 4569
For SIP traffic: UDP Ports 5060, and 10000-20000

To enable port forwarding, check with the documentation for your router. Documentation on port forwarding for many
common routers can be found at:
http://www.portforward.com.

To configure the Switchvox Network Settings, select Machine Admin > Network Settings, then click Show
Advanced Options. Select Yes for Allow Nat Port Forwarding, and enter the external IP address of your router
(click Look Up External IP if you do not know it). Click Update Network Settings to save your changes.

Downloading and Renaming your RSA Key

RSA keys can be used for authenticating peers using IAX. This is not usually necessary when using commercial IAX
providers, but it can be handy when peering multiple IAX-compatible PBXs together. Click Download to save the current
RSA key. Then you can upload it to other phone systems when you create or modify an IAX Provider on that system.

Switchvox Administrator Manual



You can rename this RSA key to something unique to this Switchvox PBX: Enter a new name in the Rename RSA key
field, then click Rename. This can help you identify keys as you set up peered PBX systems. For example, you may
name this key bostonoffice and another system’s key londonoffice.

Setting an RTP Port Range

These are the source ports used for establishing the RTP media pathway for SIP calls.

Itis unlikely that you will need to change this setting. Only change it at your provider’s request.

Outgoing Calls

The Outgoing Calls tools let you handle all aspects of outgoing calls.

Outgoing Call Rules

An outgoing call rule is a dialing pattern and associated routing information. For example, the International outgoing call
rule is triggered when a user dials “9011” followed by 7 to 13 digits. Such calls are sent to the selected device (such as a
provider or a Channel Group).

You can create multiple call rules that match the same pattern. In this case, if there is a pattern match, the rule that is
highest in the priority list gets called first. If that rule fails, and it is not marked as a final rule, the next rule is called, and so
on.

Switchvox is preconfigured with a set of outgoing call rules that serve most situations.
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f} Outgoing Call Rules

Create, modify and delete outgoing call rules to apply to the extensions on your phone syste
ﬂ What are outgoing call rules?

Add Hew Outgoing Rule

Cutgoing Rules

(1to 7iof¥

Priority &= Move HMame

' ¢

PR PR @

International

1-900 Murmbers

Tall Free

Long Distance

Local

911

Internal

FPattern to Match
Begins with 9011 and the rermainder
i5 7 ..

Begins with 91(900|976) and the
remainde. ..

Begins with 91(800|8588|877|866)
and the ...

Begins with 91 and the rermainder is
1i04d...

Begins with 9 and the remainder is
7 dig...

mMurnber exactly matches 911,

any number 3 digits in length.

Creating a New Outgoing Rule

To create a new call rule, click Add New Outgoing Rule.

DOutgoing Type

Channel Group

Channel Group

Channel Group

Channel Group

Channel Group

Channel Group

internal

Call Using

FRI Line

PRI Line

PRI Line

PRI Line

PRI Line

PRI Line
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Modify Outgoing Call Rule

Fule Mame: |L|:u:al |

I this rule final?: ®ves OmNo
IEI Whatis a final rule?

Pattern to match: Number begins with the digits [91(760)518/85% |,

(7] What do these fields mean?  The rest of the number must be between |.'f‘ | and |?‘ | r
Before connecting the call, trim |1 digits from the front,
and then prepend the digits | |t|:| the number.

Call Through: SIP Provider |+

SIP Provider:

Save Changes

Rule Name
Enter a unique name for this rule.

Is this rule final?
If Yes (the default), when a call matches this rule but the route fails, then Switchvox does not look for additional matching

rules and the call is not completed.
If No, when a call matches this rule but fails, Switchvox looks for another matching rule, and the call might be completed.
One reason that the routing might fail is if the extension is denied permission to use the outgoing rule.

Pattern to match
Enter the call rule information in the boxes as follows:

Number begins with the digits [].
Enter any required precall numbers; for example, Switchvox normally requires dialing a 9 for an outside call. In this case,

enter 9 in this box.

After the precall digit, enter the pattern you want to match. You can use any digit 0 through 9, pound (#), asterisk (*), and
the plus sign (+) to describe a pattern. If a call uses the pattern exactly as described, then the rule is applied.

You can also match multiple patterns in the same rule by using parenthesis and the pipe (|). To do this, put all of the
possible patterns between parentheses and separate them with a pipe. The default rule Toll Free is a good example:
91(800|888|877|866). If a call begins with 91800, 91888, 91877, or 91866, then the rule is applied.

The rest of the number must be between [] and [] digits in length.
Enter the length of a telephone number; for example, a local number must be exactly 7 digits. In this case, enter 7 in both

boxes.

Before connecting the call, trim [] digits from the front,
Enter the number of digits to trim when dialing; for example, enter 1 to remove the prepended 9 from the number sent to

the provider.

and then prepend the digits [] to the number.
Enter the digits to prepend to the telephone number; for example, enter 1 and the area code for the number.
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Call through
Where to route the call. The following options are available in the dropdown: SIP Provider, IAX Provider, Channel Group,

Internal. If you select a Provider or a Channel Group, a dropdown is displayed that lets you select which provider or
channel group to use.

Allow all existing extensions to use this rule?

If Yes (the default), all existing extensions are set to Allow this rule, and the Default Extension Template is set to Allow
this rule. If No, extensions and extension templates are neither Allowed or Denied this rule (the rule is blank). Note: If you
have custom extension templates, you may want to set this rule to Allow or Deny.

Click Add Outgoing Rule to create the new rule. The Outgoing Calls page is redisplayed with a message indicating that
the new rule was created.

Modifying an Outgoing Rule

To modify an outgoing rule, click its Modify button. This displays the Outgoing Call Rule page showing the current
definition for this rule. Make any changes that you want, then click Save Changes. Your changes are saved and the
Outgoing Calls page is redisplayed with a message indicating that the rule was modified.

Deleting an Outgoing Rule

To delete an outgoing rule, click its Delete button. Be sure that you do indeed want to delete the outgoing rule, then click
Yes, Delete Rule. The outgoing rule is permanently deleted and the Outgoing Calls page is redisplayed with a message
indicating that the rule was deleted.

Outgoing Caller ID Rules

Outgoing Caller ID rules let you modify the outgoing caller ID name and number. Caller-ID rules can apply to a single
extension, to any extension, or to a range of extensions.

If you want a rule to apply to any extension, enter any in the extension field.

EI Outgoing Caller ID Rules

Change the caller ID for extensions making outgoing calls on your phone system.
El Tell me more about how this works

Add Hew Caller Il Rule Add Hew Ranged Caller ID Rule

# ©utgoing Caller I Rules

When extension 2 is making an outgoing call through rule | Any Dutgoing Rule |+ |
change their caller id name to |._|ustine Kilean | and their caller id number to |455?891 101 |

SMB/ |f you have a ranged Caller-ID rule, you can derive that extension’s correct caller ID by adding and prepending
numbers to their extension. For example, if you have an extension block from 100 to 200, and a DID block of 800-555-
1200 - 800-555-1300, you would use the following ranged rule:
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When an extension is in the range from 7100 to 200 and is making an outgoing call
through rule Any Outgoing Rule, change their caller id to a number derived by adding 700
to their extension and prepending 8005557.

Note: Not all VOIP providers support this feature and some VOIP providers do not work properly with altered Caller IDs.
Also, it is not possible to set Caller ID on regular analog phone lines.

Outgoing Call Diagnostics

Outgoing Call Diagnostics can be used to determine which Outgoing Call Rule is being used and why.

If you click Enable Outgoing Call Diagnostics Mode, diagnostic information is read over the phone to all callers from
all extensions. For example, If you were to Enable Outgoing Call Diagnostics Mode and then dial an internal extension
(800), instead of connecting the call, the system would read back, “You have dialed, eight zero zero. This call will be sent
to outgoing rule number seven. This rule will send the call to extension eight zero zero. Press one to attempt this call
through rule number seven.” As outgoing calls become more complex by trimming or appending digits, altering Caller ID,
or matching multiple outgoing call rules, the diagnostic information provided will become more complex.

Listening to the diagnostic information and following the voice prompts provides insight into the path that calls are taking
in the system to solve calling problems or unexpected call behavior taking place in the system. For example, the
diagnostic may reveal that a call is using the wrong rule.

When using the Diagnostic mode, make sure the number you are dialing matches the pattern for the rule. If the pattern
does not match, your outgoing call will not be connected using that rule. If the number you have dialed does match the
pattern for the rule, make sure the extension you are placing the call from has permission to call through that rule (see

Outgoing Call Rules).

Incoming Calls

The Incoming Calls tools let you manage incoming call rules and routes.

Incoming Call Rules

This section lets you create, modify, prioritize, and delete incoming call rules that apply to the extensions on Switchvox.
Incoming call rules let you perform actions on calls based on who is calling you. These rules are system wide and happen
before any of the extension call rules are triggered.
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[l Incoming Call Rules

Create, modify, prioritize and delete incoming call rules to apply to the extensions on your PR

El Tell me more about Incoming Call Rules

Create & New Incoming Call Rule: | Block Number &

# Move Incarming Call Rules

g Transfer | Prefix w714 to extension 2 if time is

| During Buziness Hours % |

Block Number

Lets you block callers from certain phone numbers or prefixes. For example, a rogue fax machine keeps calling your office
with a caller ID number of 8005551234. You could add a Block Number incoming call rule that hangs up anytime this
number calls you. You can block whole prefixes of numbers by choosing to block Prefix rather than Phone Number.

Transfer Call
Lets you transfer certain callers to a specific extension. For example, you could route all calls from a vendor whose phone
number is 8005554321 to the extension for your purchasing department.

Note: All phone numbers used in an incoming call rule must be exactly as they appear in your caller ID. This number is
usually the full 10-digit number, which includes the area code.

To create a new incoming call rule, select a type of rule from the Create A New Incoming Call Rule dropdown, then
click Add Rule. This displays a new entry in the list (the new entry is highlighted).

Type of number
Select Phone Number or Prefix from the dropdown.

Number
Enter the numbers of the phone number or prefix that you want to affect.

Transfer to extension
If you created a Transfer rule, enter the extension the call should be transferred to.

Action to perform
If you created a Block rule, select Play Busy Signal, Play Congestion, or Hangup from the dropdown.

Times to apply this rule
Select Any Time, During Business Hours, Outside Business Hours, or Weekends Only from the dropdown. (For more

information, see Time Frames.)

Click Save, and a message is displayed indicating that the new rule was successfully saved.

Modifying Incoming Call Rules

To change an incoming call rule, modify the settings for the rule and click its Save button. The rule is saved and a
message is displayed indicating the rule was successfully saved.

Deleting Incoming Call Rules

To delete an incoming call rule, click its Delete button. The rule is deleted permanently and a message is displayed
indicating the rule has been deleted.
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Incoming Call Routes

An Incoming Call Route maps numbers coming in on a particular Provider or Channel Group to a particular extension.

By default, Switchvox creates a default call route (the callback extension) for each interface as they are created (i.e.,
each provider has a rule). You can add new rules that allow for specialized call routing based on information sent by the
provider or deduced from the channel group.

ﬂ Incoming Call Routes

Foute incoming numbers to different internal extensions,

il Tell me more about Incoming Call Routing

Create & New Incoming Call Route: | Single DID %

# Incoming Call Routes

all | Yoice Calls | on numbers from | Channel Group + || PRI Lines + |

1 ranging from |555'| 235100 |t|:| |555'| 236189 | will route to an extension derived by

trimmming digits from the front and adding I:I to the result,

Route all calls on unmatched numbers from I&X Provider "Peer with Partner” to extension 103

Click here to change this IAxX Provider's default extension.

Route all calls on unmatched numbers from Channel Group "PRI Lines" to extension S00
3 Route all faxes on unmatched numbers from Channel Group "PRI Lines" to extension 300

Click here to change this Channel Group's default extensions.

4 Route all YOIP calls from any unknown host to| Busy Signal »

Single DID
Lets you send a single phone number to a specific extension. For example:

Route number 8005557212 on numbers from Channel Group T1to extension 802

SMB| Multiple DID
Lets you send a range of phone numbers to an extension that is derived from the phone number itself. This is useful if

each person has an outside number for directly dialing their extension. For example:

All Voice Calls on numbers from Channel Group T1 ranging from 8005551200 through 8005551300 will route to an
extension derived by trimming 7 digits from the front and adding 0 to the result.

Note: Some SIP providers and most types of analog lines do not send the number dialed to the PBX. Ask your phone
service provider if they support multiple incoming numbers or DIDs.

To create a new incoming call route, select the type of route from the Create A New Incoming Call Route dropdown,
then click Add Route. This displays a new entry in the list (the new entry is highlighted).

SMB| Type of Call
Select the type of calls to affect: Voice Calls, Faxes, or Voice Calls and Faxes.
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You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

From
Enter the source of the call, either a Provider or a Channel Group.

Number
If you created a Single DID route, enter the phone number to be routed.

SMB| Range of Numbers
If you created a Multiple DID route, enter the first number in the range and the last number in the range.

SMB| Trimming
If you created a Multiple DID route, enter the number of digits to trim from the front of the phone number.

SMB| Adding
If you created a Multiple DID route, you can enter a value to add to the result or you can leave this blank.

Extension
Enter the extension number to receive the call.

Modifying Incoming Call Routes

To change an incoming call route, modify the settings for the route and click its Save button. The route is saved and a
message is displayed indicating the route was successfully saved.

Deleting Incoming Call Routes

To delete an incoming call route, click its Delete button. The route is permanently deleted and a message is displayed
indicating the route has been deleted.

Voicemail Settings

Select System Setup > Voicemail Settings to display the Voicemail Settings page. This lets you control any voicemail-
related options.

Voicemail Notification Settings

When voicemail is recorded for an extension, a notification email message is sent to the extension’s email address. You
can set a ‘From’ address for those email messages, and an SMTP server to use.

You may need to set this field to be a real email address before you are able to receive voicemail notification emails.
Some strict mail servers will bounce emails appearing from the localhost.localdomain domain.
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[I Customize the settings for voicemail notification emails

voicemail Motification Email "From” Address |F'ED<@I|:uc:alhnst.lncaldnmain
EI What is this used for?

Cuthound SMTP Server | |
El Tell me more about this

Cuthound SMTP Username | |
EI About SMTP Auth

Cuthound SMTP Password | |
EI About SMTP Auth

Save Email $ettings

Voicemail Notification Email “From” Address

Enter an email address. When you receive emails notifying you of new voicemail messages, they will come from this
email address. You may need to set this field to be a real email address before you are able to receive voicemail
notification emails. Some strict mail servers will bounce emails appearing from the domain localhost.localdomain.

Outbound SMTP Server

Enter the hostname of your SMTP server. Some ISPs or network admins require all outgoing email to pass through a
specific SMTP server. If you are having trouble receiving voicemail notification emails, you may want to specify the
hostname of your server here.

Outbound SMTP Username and Password
Enter a username and password if your SMTP server requires it. It’s probably safe to leave these blank, as many mail

servers do not require them.

Running Voicemail Notification Diagnostics

If you are having problems with voicemail notifications, enter an email address to send a test message, then click Run
Diagnostic Tool. A diagnostic page is displayed that describes each step that was taken, and the result (passed or
failed).

ﬂ Voicemail Motification Email Diagnostics

Are users not receiving voicermail notification emails?

Ernail Address to Send a Test Email To |

Run Diagnostic Tool
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sus Voicemail Routing

Voicemail Routing lets you handle several voicemail-related actions:

E Yoicermail Routing

U] puring a user's voicemail greeting, callers may push the "*" key to log into the current v
During a user's voicemail greeting, callers may push the "0" key to exit and be forwarded to

If a user's voicemail box is full, callers will be forwarded to extension :l 2
fave Settings

During a user’s voicemail greeting, callers may push the “*” key to log into the current voicemail
box.
Check the box if you want this to be true. When the caller presses “*,” he or she is prompted for their password.

During a user’s voicemail greeting, callers may push the “0” key to exit and be forwarded to exten-
sion [].

Enter an extension if you want this to be true. Click the people icon to select from a list of extensions. When the caller
pushes “0,” he or she has the option to accept and save their recording before being transferred to the extension.

If a user’s voicemail box is full, callers will be forwarded to extension [].
Enter an extension if you want this to be true. Click the people icon to select from a list of extensions.

sus Voicemail Email Templates

Voicemail Email Templates let you customize voicemail notification emails. You can create multiple templates and tailor
them to different types of email accounts. These templates are available to a user when he sets up his voicemail
notifications (along with any templates he creates for himself).

You can use variables in your template that are substituted with real values when the email gets sent. For example, %VM
_NAME% in a template sends as the extension owner’s first and last name. There is a full list of these variables on the
pages where you create or edit a template.
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ﬂ VYoicemail Email Template

IE' Tell me more about this

Create & New Yoicemail Email Template

Template Name: | | Create Hew

Modify Existing Templates

Choose Template: | Default (» m

Creating Voicemail Email Templates

The Modify Template page is displayed with a sample template already entered. You can modify the subject and body
(change it completely if you need to), using the list of possible variables at the bottom of the page. You can leave the
subject blank, but you must put something in the body of the message.

To create a new template, enter a name in the Template Name field, then click Create New.

Click Save Template to save your changes and go back to the Voicemail Settings page. Click Restore to Original
Template to restore this page to the original system default template.

Viewing & Modifying Voicemail Email Templates

To see a ‘preview’ of a template, choose that template from the Choose Template dropdown, then click View. The
template is displayed with sample values, in HTML and text-only.
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Extensions PB¥ Features System Setup Diagnostics

Modify Voicemail Email Template {"Default')

Below you can the customize the email template that gets sent to the user when they reciew

Subject: |

Format * | Fonk family = Font size -

‘LHTmL|&v—

-]
oy
=
w B
"
o
il
(]

S«

-
|
frre

¥

Crear #WM_MAMEL:
You just received a ®YM_DURY long message in mailbox $WVM_MAILEOKS from %WM_CALLERIDS, on ¢

Thank you!

Path:

ou can use variables in your termplate that will be substitued with the real values when the email gets -

wariables and a description of their substituted value,

Sa¥M_MAME®%0 - Recipient's firstname and lastname

%a¥M_DUR% - The duration of the vaicernail message

Sa¥M_MAILBOX® - The recipient's extension

%a¥M_CALLERID®% - The caller id of the person who left the message

Sa¥M_DATE® - The date and time the message was left

SeDOWNLOAD _LINK® - 4 URL to the web admin to download the message

SeDOWNLOAD _LINK_AMD_MARK_DELETED % - & URL to the web admin to download the message

recipient's railbaox,

Save Template Restore to Original Template

To modify a template, choose that template from the Choose Template dropdown, then click Edit. The Modify template
page is displayed. Click Save Template to save your changes and go back to the Voicemail Settings page. Click
Restore to Original Template to restore this page to the original system default template.

Deleting Voicemail Email Templates

You can edit each of the system default templates, but you cannot delete them.

To delete one of your own custom templates, choose that template from the Choose Template dropdown, then click
Delete. Be sure that you do indeed want to delete the template, then click Yes, Delete Voicemail Email Template. The
template is deleted, and the Voicemail Settings page is displayed again. If any extension owners were using this
template, those settings are changed to the ‘Default’ template.

Switchvox Administrator Manual



sws| External Voicemail

If you want to use the voicemail system of an external provider, rather than this Switchvox’s voicemail system, check
this box and choose the SIP Provider whose voicemail system you want to use.

E External Yoicemail

Use External Woicemail System OJ
IEI Whatis this used for?

SIP Provider [Best Network | +]

IEI What is this used for?

Save External Yoicemail 3ettings

In Switchvox SMB, the SIP Provider can be a peered Switchvox (for more information, see Adding a Peered PBX). To
use a peered Switchvox as the External Voicemail Provider:

» Be sure both Switchvoxes are running SMB version 4.0 or later.
* Onthe server Switchvox (the External Voicemail Provider):
* set up a new SIP provider that is the client Switchvox. On the new provider, show Advanced Options, select Yes
for Host is a Switchvox PBX, and enter the Jabber Hostname for the client Switchvox.
» Be sure that each extension that exists on the client Switchvox also exists on the server Switchvox as a Virtual
extension. For help managing this, see Creating & Updating Multiple Extensions.
*  Onthe client Switchvox:
» Set up a SIP provider that is the server Switchvox.
» Check the box to Use External Voicemail System, and select the server Switchvox as the SIP provider.
+ Set up an outgoing call rule so that calls to the voicemail-access extension (by default, this is 899) are sent to the
server Switchvox. (For details, see Outgoing Call Rules.)
* Remember, when checking their voicemail users should go to the Switchvox User Suite on the server
Switchvox.

Custom Voicemail Message Length

You can specify the number of seconds that it takes for Switchvox to ‘give up’ on a caller if they reach your voicemail but

don’t leave a message. For example: you specify 10 seconds, someone calls and reaches your voicemail, but they don’t

start talking, then Switchvox hangs up and does not save those 10 seconds of silence. Setting a number of seconds here
should help reduce clutter in Mailboxes and on disk.

You can also set a number of seconds to let the caller speak, and after that the call is disconnected. This is useful if you
are concerned about storage capacity.
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[ﬂ Custom Yoicemail Message Length

Do not store voicemail if message is just silence for seconds.
2] whatis this used for?

Do not let callers leave voicemail messages longer than seconds,
ll What is this used for?

Save Custom Voicemail Message Lengths

s« URL Manager

The URL Manager lets you set up Switchvox to interact with external Web applications. When certain events occur in
Switchvox, it can submit information about the event to a Web application, and respond to the XML that is returned.

Extensions FPB¥ Features System Setup Diagnostics
UREL Manager

Send call values from the PBX to other weh services,
il What can I do with the URL Manager?

Default URL
frcceptable wariables for this URL ECALLER 1D MAME =
CalLLER_ID HUMEER
EXTEMSION
. EXTEMSION_TYPE
On Incoming Call Event URL FEATURE DATA
| INCOMING._DID
Acceptable Yariables for this URL E’hquESEa
_OR - Wh_MEGNLIM
Whd_bAAILE O
[ use the Default URL i DATE
EVENT_TYFE
JOB D

On Route to Extension Event URL
[

Default URL

You can enter a Default URL so that you do not have to enter a full URL for each event. But, you can choose to use the
default URL or not, so you still have flexibility on each event.
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Events

There are some Switchvox events that triggeran HTTP POST.

On Incoming Call

Triggered at the beginning of an incoming call. This event applies to calls received from VOIP providers, any channel
groups, as well as calls between extensions. It is common for requests of this type to return XML for routing the call or
altering the Caller ID.

On Route to Extension
Triggered when a call hits an extension. This event can occur multiple times for each call. For example, a call may hit an
IVR, a queue, and then a phone extension. XML can be returned to route calls differently.

WARNING: Do not create routing loops. For example, if a call to extension 333 results in a request that sets transfer_
extension to 333, then Switchvox loops endlessly. Do not set transfer_extension in the response to this event unless it is
absolutely necessary.

On Call Answered
Triggered when a call is answered. This event applies to calls from external numbers, and from all Switchvox extensions.

On New Voicemail

Triggered when a voicemail message is left for an extension (including a message forwarded from another extension).
This event requests the voicemail URL. Note: Setting XML values in the response to this request results in undefined
behavior. Return empty XML for this request.

On Checked Voicemail

Triggered when an extension checks its voicemail. This event could be used in conjunction with the On New Voicemail
Event to track new voicemail messages and implement an escalation policy. Note: Setting XML values in the response to
this request results in undefined behavior. Return empty XML for this request.

On Agent Logged In
Triggered when a queue member logs into a queue.

On Agent Logged Out
Triggered when a queue member logs out of a queue.

On Call Hangup

Triggered when a call is hung up. This event can be used in conjunction with the JOB_ID variable to record the completion
of calls that invoked previous URL events. Note: Setting XML values in the response to this request results in undefined
behavior. Return empty XML for this request.

On Outgoing Call
Triggered when a call is created. This event applies to calls to external numbers and all Switchvox extensions.

Variables

Switchvox events can submit various information about calls. To do this, you use variables in the URL. Not every
variable is available in every event (check the Acceptable Variables dropdown on each event), so be prepared to handle
an empty variable. Here is the complete list of all of the variables for all event types:

CALLER_ID_NUMBER
Phone number from caller ID, including area code.

CALLER_ID_NAME
Name from caller ID.

EXTENSION
Internal extension associated with the event.
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EXTENSION_TYPE
The type of the extension associated with the event. For the list of extension types, see Extension Types.

FEATURE_DATA
The data entered after a feature code. For example, in *62204, you have an EXTENSION of 62, an EXTENSION_TYPE

of feature_monitor, and a FEATURE_DATA of 204.

INCOMING_DID
Phone number dialed by an external caller. May be empty for internal calls, or calls over certain analog lines that do not

provide the DID.

VM_DUR
The duration of the voicemail message, in seconds.

VM_MSGNUM
The unique message number for this voicemail message.

VM_MAILBOX
Extension associated with the event’s voicemail box.

VM_DATE
The date and time of the voicemail message.

QUEUES
A comma separated list of the queue account_ids being logged in to or logged out of. In the case where the user is being
logged out of all queues, the list will only contain the list of queues the user is a member of.

EVENT_TYPE
Event type that has been triggered. This is useful for the Default URL, which receives POSTs from any of the event

types.

JOB_ID
Unique ID of the call. Note: This string of digits is not a numerical value: 99.100 is not equal to 99.1. This variable is
useful for correlating multiple events (and also certain IVR requests).

XML Response

For some events, the remote web application can return XML that instructs Switchvox to perform operations on the call.
Here is a sample of an XML response:

<response>

<result>

<call info>

<caller id number>8585551212</caller id number>
<caller id name>John Doe</caller id name>

<transfer extension>850</transfer extension>

<display url>http://intranet.example.com/crm.cgi?custid=2</display url>
<continue outgoing reporting>1</continue outgoing reporting>
</call info>

</result>

</response>

All of the tags inside the call_info block are optional. The following XML tags can be used:

callerid_num
Set Caller ID Number to this value.

callerid_name
Set Caller ID Name to this value.

transfer_extension
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Transfer call to the extension of this value. If this XML is a response to the event On Outgoing Call, this can be an
external number. Make sure to enter this number as you would dial it from your phone. For example, if you must dial 9 for
an external number, an external number here must begin witha9. WARNING: It is possible to break Switchvox by
creating routing loops with transfer_extension.

display_url
Display this URL in the Switchboard as a clickable icon. For example: the remote web application might lookup the
caller's phone number in your company’s user database, then return the URL of the caller's user record.

continue_outgoing_reporting
Continue reporting any subsequent outgoing calls for this JOB_ID. For example, if a call is made to a queue, the event will
continue when a queue-member's extension is dialed. The value of this tag must be 1 or 0.
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Diagnostics

The Diagnostics tools give you different views of the call activity in Switchvox, and help you evaluate potential problems.

System Status

This page shows you the overall health of Switchvox’s connected devices including the VOIP Providers, SIP Phones,
Hardware Devices, and Mailbox Disk Usage.

VOIP Providers

This section lists the following information for each provider:

» Name of the provider as entered when the provider was created

» Host that Switchvox connects to when registering and sending calls
* Account ID

» Extension that incoming calls are sent to by default

» State of the connection

WOIP Providers ([ 1to1l)ofl

Type = Name Host Account ID Callback Ext. Latency (mis) State

TAx Junction Metwaorks iax.jnctn.net svtesting 800 n/a ﬁl‘»Unm

The state of the connection should be Registered when the system is operating properly. If it is not, outgoing calls will fail
and incoming calls cannot be received. Here are some of the most common reasons a VOIP provider is in a non-
registered state, and a resolution:

» VOIP provider has just been entered and the registration has not finished yet. Wait a few minutes and then
refresh the page.
» Username or password are incorrect. Check to make sure you have entered them correctly.

» Firewall is not allowing the communication between Switchvox and your provider to flow freely. When you use a
SlIP-aware firewall, keep in mind that it recognizes the data being sent back and forth. A normal router does not
require any special configuration, but a SIP-aware firewall does. Contact the manufacturer of the firewall for details on
setting up any necessary routing rules.

SIP Phones

This section lists all the phone-extensions and information about their phones.
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SIP Phones

Extension < Caller ID User Agent IP Address

101 Justine Kilean PolycomSoundPointIP-SPIP_430-UA4Z.1.0.2705 10.10.3.14-
Aastra 91330i/1.4.1.2000 Brem Calletrl/1.5.1.0

102 Jane Doeson 10.10.3.211
MxSFiv3. 2. 6,26

103 John Smith PolycornSoundPointIP-SPIP_300-UAS2,1.2.0078 10.10.3.22:

104 Gilbert Brown Grandstrearmn GXP1200 1.1.6.16 10.10.3.69

Phone State

The State column indicates the state of the extension's phone on Switchvox.

* Registered: this indicates that the phone is configured properly and is on the network.

+ Timeout: this indicates that the phone was registered at some point, but the server no longer recognizes it and
does not send calls to this phone anymore.

» Unreachable: this indicates that the phone has not yet registered with Switchvox.
If a phone is not Registered but it should be:
» Make sure that your phone is set to register every 120 seconds. (Some phones are by default set to only register

once.) See your phone’s user manual for more information about this setting.

» Make sure your phone is configured correctly. Your phone must know Switchvox's IP address, and it must have
the same password as the "Phone Password" for the extension. For more information on configuring your phone,
please see your phone's manual or call your phone's technical support.

» Make sure your phone is ON, the Ethermnet cord is plugged into the phone and the correct Etheret jack, and the
phone is on the same LAN as Switchvox (not on a separate partitioned LAN subnet).

» Make sure there isn't a firewall between your phone and Switchvox that could be blocking your phone from
accessing Switchvox.

Diagnose a Problem

If a SIP phone is not in a Registered state, click its Diagnose button to run a diagnostic tool for that phone.

External Phones

Phones are considered "External” if they are not on the same network as Switchvox. This generally means that they have
to connect to Switchvox over the Internet, or they are located on a separately partitioned network. External phones cannot
go through the full diagnostics because Switchvox does not have direct access to these phones.

Finding the IP Address of your SIP Phone

To run the diagnostic tool, you need to know the IP address for your phone.

Polycom Soundpoint IP 300/301/500/501/600/601

Each phone is set up to obtain its IP address via DHCP. You can find the IP address of a Polycom phone by pressing the
Menu button on your phone. Then, on the LCD screen of your phone highlight "Status..." and press select and then
highlight "Network..." and press select again, then highlight "TCP/IP Parameters..." and press select. Now find the line
that starts with "IP:" and write down the IP Address.
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Sipura ATA

Connect a phone to the jack labeled "Phone 1" on the front of your ATA. Then on the phone dial "****" you will then hear a
voice say "Configuration Menu". Then dial "110#" and it will read back the ip address of your ATA.

Hardware Devices

This section lists all the channels on the hardware devices installed for Switchvox, and an alarm state for each. The state
of these channels, if properly connected, should be No Alarm.

If any other alarm state is shown (a RED Alarm or a Loss of Signal), check to make sure that the device is plugged into
the correct line, and that you have the appropriate signaling type selected.

Hardware Devices

Device < Dewice Channel Member of Channel Group Signalling State

TP (PCI) Card 0 Span 1 1 ZOx PRI Lines ISDMN PRI Mo &larm
T2wwP (PCI) Card 0 Span 1 2 Cix PRI Lines I=DM PRI Mo Alarm
TZ¥wWP (PCI) Card 0 Span 1 3 Z0¥ PRI Lines I=DMN PRI Mo &larm

Voicemail/Fax Disk Usage

This section shows an overview of the disk usage, and lists each extension and its disk usage.

Total Yoicemail/Fax Disk Usage

vour disk is 75% full (6.2 gb / 8.4 gh)

0% S0 100%
M soicemail/Fax disk usage B other disk usage

YoicernailfFax Disk Usage By Extension ( 1to 20 ) of 20

Extension

= Type First Name Last Mame Quota Class % Quota Used # OF ¥M WM Usage (O
101 sip Justine Kilean 1] 0 1]

10z sip Jane Diogsan ] 0 ]

103 sip John Smith n 1] n

For information about disk-space quotas, see Voicemail/Fax Mailbox Quota (MB).

Current Calls

This is a list of all current calls. It shows the person who called, the person who took the call, the duration of the call (in
seconds), the current state of the call, and the provider.
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To hang up on a call, click Hangup. Be sure that you do indeed want to hangup the call, then click Yes, Hangup.

Extensions PB= Features =ystemn Setup Diagnostics

Current Calls

Current Calls (1to1)ofil

Call From call To Duration = Current State Format Provic

Justine Kilean <1001= Jane Doeson <1020 &s Talking ulawsulaw|hza3|hzed interr

Concurrent Calls for the past day

calls

-4.0

-G, 0+
Mon 20: 00 Tue Q@:00 Tue 04:00 Tue 0F:00 Tue 12:00

M Incoming Calls max 5 last O
B Outgoing Calls max 3 last O
H Internal Calls max 2 last O

B Phones inUse max 6 last O

sz Queue Status

The Queue Status tool provides information for each call queue in Switchvox: Overall statistics, member status and
statistics, and calls waiting in the queue.

Statistics

Queue Statistics show you how a queue has been functioning.

Current Calls Waiting
Calls waiting in the queue.

Completed Calls
Calls answered by a queue member.

Abandoned Calls
Calls in the queue, but hung up before being answered by a queue member.
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Redirected Calls
Call was redirected out of the call queue, or the caller pressed 0 key, or the call reached maximum timeout, or the call was

sent the maximum number of times, or the call queue was at its maximum length.

Longest Queue Length
Largest number of calls waiting in the queue at one time.

Average Entry Position
Average position when calls first enter the queue.

Longest Wait Time for Completed Calls
Longest time that a call was in the queue and was answered by a queue member.

Longest Wait Time for Abandoned Calls
Longest time that a call was in the queue but hung up before being answered by a queue member.

Average Wait Time for Completed Calls
Average time that a call was in the queue and was answered by a queue member.

Average Wait Time for Abandoned Calls
Average time that a call was in the queue and hung up before being answered by a queue member.

Average Talk Time
Average time that queue members spent talking with callers from the queue.

Member Status

This shows each member of the queue, their extension and queue-status (logged in, logged out, or logged in but paused),
who they are talking to, and the amount of time they spent on their last call. It also includes statistics: the number of calls
they have taken today, and the average time they spent talking on those calls.

Current Calls Waiting

This shows the calls that are currently waiting in the queue, including the current position, caller ID, how long they have
been waiting in the queue, and the position in which they entered the queue.

Past Statistics

Click to view past statistics for yesterday, the past 2, 7, 10, or 30 days, or the past year. Past statistics don’t include
member status, or calls waiting.

sz Queue Reports

This lets you generate a report about call activity for a queue (or a set of queues), or a queue member. Queue reports are
generated for the date-range and criteria that you specify.
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Extensions PBX Features Systern Setup Diagnostics

Queue Reports

Get detailed reports to help analyze your call queues and their members, Use the form below
information that you view in the reports in order to derive a more meaningful and specific gue

From Date: 03242008 | 7] To Date:|03/25/2008 | 7]

Crarny ddfyyyyd [rarnd ddfyyyyl

D Ignore Weekends

Call Queues Call Queaue Members

Report Breakdown |.-'-‘-.\.ferage Talk and ' ait Time Per Call By Qusue | Select Queue(s):

6171 "Custamer Service”
612 "'Technical Suppart'

Hold dawn CTRL to select m

Yiew Chart

Check the ‘Ignore Weekends’ box if your queue is not active on weekends and calls on those days can be ignored.

To view the report, set up your criteria then click View Chart.

Call Queue Reports

Queue reports can be broken down in different ways, based on talk and wait times, date, day of the week (e.g., Monday),
or hour of the day.

Select the report breakdown, then select at least one queue to report on. To select multiple queues, hold down the CTRL
key and click on the queues.

Call Queue Member Reports

Queue Member reports can be broken down in different ways, based on talk time, member, date, and duration.

Select the report breakdown, then select at least one member to report on. To select multiple members, hold down the
CTRL key and click on the members.
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Call Log

This lets you generate a log of call activity. Call logs are generated for the date-range and criteria that you specify. Criteria
include extensions, providers, caller ID, or Incoming DID.

Extensions PR Features Systern Setup Diagnostics

Call Log

See what calls have been made on the phone system. Use the form below to narrow down th
in the logs in order to derive a more meaningful and specific call report,

From Date:[03118/2008 | 7 To Date: (03182008 | 7]

Crarnd ddf yyyy) [rarn ddf wyyy)

all calls Phones Call Queues I¥Rs Agents Providers Caller Id Incoming DID

This will show yvou all calls in your system
between the dates selected above.,

view Report | outputto xisfite | outputtoxmt |

CallLog (1fto11)of 11

Call Date & Call Fram Call To Call Type  Call Time
031809 3:28:19 PM Justine Kilean =101 = Gilbert Brown <104 = outgoing  39s
03/18/09 3:22:30 PM John Smith =103 = Justine Kilean =101 = outgoing 4=
031809 2:09:05 PM Jobhn Smith =103 = Justine Kilean =101 = outgoing  1m, 0s
031809 2;08:00 PM John Smith <103 = Justine Kilean <101 = outgoing  14s
03/18/091:18:34 PM Jane Coeson =102 = Gilbert Brown =104 = outgoing  3s
03/18/09 1:18:25 PM Jane Doeson <102 = Justine Kilean <101 = outgoing  10s
03718509 1:13:04 PM John Smith =103 = Jane Doeson <102 > outgoing  3s

View Report
Open the report in the browser window.

Output to .xlIs file
Download a .xls file that you can open with an application such as Microsoft Excel.
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Call Reporting

This lets you generate a report about call activity. Call reports are generated for the date-range and criteria that you
specify, and include the information that you specify.

Extensions PB= Features Systern Setup Diagnostics

Call Reporting

See what calls have been made on the phone system, Use the form below to narrow down th
inthe logs in arder to derive a more meaningful and specific call report,

From Date: |03/24/2009 | 75 To Date: |[03/252008 | [+

Crornyd ddf vy Crmnd ddfyyyy)

F Igrnore Weekends

Report E-reaku:lu:uwn:| T otal Curnulative V|

Overview Phones Call Queues I¥Rs Agents Providers Incoming DID
This repart takes into account all calls Report Fields
in your system between the dates Total Mumber of Calls

Tatal Mumnber of Incarming Calls
Tatal Mumber of Outgaoing Calls
Tatal Talking Time

Total Call Duration

Average Talk Time per Call
Average Call Time per Call

selected above

Hold dawn CTRL to select multiple iterns

view Report | Ouputto xisfile | outputto xmt | chart Report

Check the ‘Ignore Weekends’ box if your organization is not active on weekends and calls on those days can be ignored.

Call reports can be broken down in different ways, based on cumulative numbers, date, account, hour of the day and day
of the week (e.g., Monday), extensions, providers, or the incoming DID.

You can select what fields of data you want to include in a report, depending on what calls you include in the report. The
fields include total calls incoming and/or outgoing, talking time and call duration, and average times. Call duration means
the entire call, including time spent in an IVR or waiting in a queue. Talk time means the time when the callers were
actually talking to each other.

To generate the report, you can choose one of several viewing options.

View Report
Open the report in the browser window.
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Output to .xls file
Download a .xIs file that you can open with an application such as Microsoft Excel.

Output to xml
Download an xml file.

Chart Report
Open the report as a graphical chart in the browser window.

s SCheduled Reports

Scheduled Reports is similar to Call Reporting, but here you can set up a report to run at a certain time with a particular
output, and the report is sent to you (via email) based on those criteria.

To create a new report, click Create a new Scheduled Report. Name the report, and then set up the schedule,
parameters, and delivery option.

To edit an existing scheduled report, click Modify on the same line as the report.

The Schedule Information indicates the dates during which this report is active. Enter the date that you want to activate
the report (the first date it should run), and the date that you want to deactivate it (the last date it should run). If you want
the report to keep running indefinitely, indicate No end date.

The Recurrence Pattern indicates how often the report should run during the time it is active. You can control how often
the report runs, from hourly to once a year. The start date of the report indicates the beginning day and time of the report,
based on the recurrence pattern.

The Report Parameters let you define what fields of data to include in the report.
The Delivery Options let you define how you want to receive the report:

Output Type
HTML, graphic chart, or XML.

Delivery Method
The delivery method available is Email. Enter your full email address.
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Extensions PB= Features Systemn Setup Diagnostics
Scheduled Reports

[I Report Information

Repart Mame: [Daily Queue Activity

__ Schedule Information

Start Date: 010152008 | 77 End Event: & Mo end date
(/3 LT —

Crarndddfvpyy]

Choose Your Recurrence Pattern:

OHuurhr
@ Run at[11:59pm & | every |1 dayls)
@ paily O Run at[12:00am +| only on:

C) weekly DSunday DMDnday DTuesday DWednesday
O Monthl DThursday DFriday DSaturday

onthly
O‘l"early

O each scheduled ocourence, the start date of the report should be:

® from the beginning of the
O dateftime minus hours) %
O from the date |:| B

Crornd ddfyyyy)

__ Report Parameters

D Ignore Weekends in my report

Report Breakdown: | Total Cumulative |

Overview Phones Call Queues IVRs Prowviders
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Hardware Monitor

This offers information about the health of the Switchvox server. As long as the Current Status for each item is Good, the
hardware is fine.

Extensions FB=> Features Systerm Setup Diagnostics

Hardware Monitor

memaory Current Status:

Current Status Value: mem used = %72, swap used="%29
Last Updated: 03/17,/2009 4:50:07 PM
Threshold: mazimum percentage of swap mermory used ( 200

disk Current Status:

Current Status Value: Disk Total: 8,45 Used:5.3G (79%) Available:(1.8G)
Last Updated: 03/17/2009 4:50:07 PM
Threshold: maxzimum percentage of disk used ( 80

load Current Status:

Current Status Value: Load Average is 0,36
Last Updated: 03/17,/2009 4:50:07 PM
Threshold: mazimum load average { 5 )

Show Advanced Hardware Information

If a field is over threshold, it needs immediate attention. The following are some suggestions for handling a problem:

memory
If memory is over threshold, one option is to turn the system off (wait a few moments), and then turn it back on. This

normally frees up the memory usage. Another option is to install more RAM. You can also attempt to identify the process
that is overloading the memory (call recording, concurrent calls, concurrent conference calls, etc.), and stop that process.
disk

If disk is over threshold, check voicemail, fax, call recordings, and backups to find out what is taking up the disk space.

load
If load is over threshold, check Diagnostics > Current Calls to see if the system is hitting a peak (spike) amount of

concurrent calls.
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Error Log

This section provides tools for our customer service representatives to help you with any problems that you might have
with Switchvox. You do not need to use these tools unless we ask you to.

The tools included here are simple error logs, advanced error logs, and advanced debugging sessions.
Extensions FPB* Features System Setup Diagnostics

Error Log

In the error logs, all server errars from the phone system are recorded and stored by date. Tk
columns to make finding the information you are looking for fast and easy. Please click here tc
Logs.

Yiew an Error Log: | 03A17/2009

Error Messages

There are no errar messages an this daw,

Advanced Debugging

&dvanced debugging sessions can be useful in identifying the source of a problem. However, 1
additional load on the Switchvox system resources, We recommend that you do not use this ©
directedy by a technical support representative,

Go To Advanced Debugging

Advanced Debugging

Advanced debugging sessions can be useful in identifying the source of a problem. However, these sessions place an
additional load on the Switchvox system resources. We recommend that you do not use this tool unless you are being
directed by a technical support representative.

These debugging sessions collect detailed PCAP, PRI, or ACLI information to help you see exactly what is happening in
Switchvox.

Tech Support

This section provides tools for Switchvox Tech Support representatives to help you with any problems that you might
have with Switchvox.

IMPORTANT: You do not need to, and should not use these tools unless it is at the request of a Switchvox Tech Support
representative.
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Tech Support Access lets us access your machine to help diagnose a problem. You must click Allow Tech Support
Access to use the VPN connection. If you click Disable Tech Support Access, then all access to your system will be
closed, including an open VPN connection.

A TSR an be downloaded and sent to Switchvox Tech Support.

Extensions PB* Features Systern Setup Diac

Tech Support

“ Enable Tech Support &ccess 2l

Flease do not enable tech support access unless requested by a tech support representative,

Allow Tech Support Access

[J Please call tech support to receive your YPN Connection Passward,
Tech support will never call you and ask yvou for your password.

UOYPM Mot Connected

WPMN Connection Password: |

| connect |

ﬂ Download a Technical Service Report |2/

To download a TSR ( Technical Service Feqguest ) Report please dick the "Download TSR Report” below, In
send a TSR Report to customer service so they can better diagnose any problems you might have,

Download TSR Report
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Machine Admin

The Machine Admin tools let you manage your server's network settings, make and restore backups, apply updates, set
the system clock, and more.

Network Settings

This lets you configure the networking information for Switchvox. These settings are similar to settings you would set on
any other computer on your network.

Enter the information, then click Update Network Settings.
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Extensions PBE Features System Setup Diagnostics

Metwork Settings

" Changing your network settings can cause all active calls to be dropped, We do not recor
your network settings during busingss hours,

Gateway Address |1EI.1III.IZI.1 |
IP address of vour router

110.10.0.1 |
DS Addresses | |
IP addrezzes of vyour name zervers | |
Allawy Hat ®ves OmNo

Port Forwarding
ﬂ What does this mean?

External IP Address / Hostname  [72.54.25242 | ook up Externatie |

il What is this for?

[ Click to Show Advanced Options

Interfaces
ethl Enabled  (Oves: @ po
Protocal  OpHop @ static
Ip .ﬁ.ddress| |
MNetrnask | |
etho Enabled @ ves Owo
Protocol O pHor  ® static
IF .ﬁ.ddress|1|]_1|]_1_11 |
Netmask [255.255.252.0 |
Gateway Address
This is the IP address of the machine to which Switchvox sends outbound traffic. It is typically the address of your router.
DNS Addresses

You can enter up to three DNS addresses. Switchvox uses these addresses to translate any host/domain names into IP
addresses.
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Allow NAT Port Forwarding
Select Yes to allow NAT Port Forwarding to Switchvox. This option is useful if you need to handle calls going to and

coming from an external network, and Switchvox is behind a router that performs NAT.

On your router, you must forward the following ports to your Switchvox server. Also, in Machine Admin > Access
Control, you must have a rule that allows the appropriate traffic for an external network. See Access Control for more
information.

Protocol TCP/UDP Port(s) Description
IAX UDP 4569 Signaling port needed for phones outside of your network.
SIP UDP 5060 Signaling port needed for phones outside of your network.
SIP UbDP 10000-10500 RTP audio ports needed for phones outside of your network.
TCP 80 HTTP port for remote web voicemail access
TCP 443 HTTPS port for remote web admin access
TCP 5222 & 843 Ports for using the Switchboard remotely
TCP 5269 Port for remote XMPP (Jabber/chat) access

External IP Address
Your external IP is the public IP Address of your router. If you are not sure what your public IP is, click Look Up External

IP to automatically find it.
Note: SIP phones that are outside of your network must use this external IP for registration.

You cannot use this feature if your ISP does not give you a static external IP address. Check with your ISP to make sure
that the public IP you enter here will not change. If you do not have a static public IP, you will only be able to use phones
from within your local network.

Interfaces
The IP and Netmask address. You set these addresses when you installed the Switchvox software, and you do not

normally need to change this information after installation.

Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an Advanced
Option, click Show Advanced Options.

Hostname
You can set a hostname for Switchvox (e.g., pbx.example.com) if you have a DNS setting. This may alleviate problems

with delivering emails through particularly strict SMTP servers.

IMPORTANT: This option also sets the web server's SSL key. This may help prevent warnings from your browser when
logging into Switchvox. In most cases it is best to leave this option unchanged.

SMB| Jabber Hostname
You can set a hostname for the Jabber server in Switchvox (e.g., jabber.example.com) if you have a DNS setting.

This is important if you are peering Switchvoxes and want to use functions such asPresence or the Chat Panel.

IP ToS
This lets you set the ToS or DSCP field in VolP packets sent by Switchvox. This field can be used by firewalls and

switches to distinguish specific types of traffic to apply QoS rules, such as favoring all voice traffic for better quality.
Setting the ToS field isn’'t a requirement for prioritizing VOIP traffic on your router, it’s just one way to identify VOIP traffic.
If you’re not explicitly prioritizing this field in your network equipment, changing this option will have no effect on your
VOIP quality.

For more information see the following resources:
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RFC 2474 - "Definition of the Differentiated Services Field (DS field) in the IPv4 and IPv6 Headers", Nichols, K., et al,
December 1998.

IANA Assignments, DSCP registry, Differentiated Services Field Codepoints: http://www.iana.org/assignments/dscp-
registry

SMB| Custom SSL Certificate
Use this field to add a Custom SSL Certificate. This option can be used to prevent your browser from popping up a

security warning when you access the Admin Suite. After you have purchased an HTTPS certificate from an online
certificate authority, it can be uploaded into these sections in order to allow Switchvox to use it for encrypting web traffic.

Another option for this section is if your organization creates its own web certificates for encrypting various intranet traffic.
If you are unsure about HTTPS certificates, it is safe to leave this section blank.

Additional Local Networks
Use this section to list any additional networks that are not separated from Switchvox by a NATing router.

This option is only needed if:

» Switchvox is behind a router that performs NAT.
* You wish to use soft phones from outside your network.
* There is more than one network (such as a remote office VPN) connected to the local net.
Networks can be listed in either CIDR (e.g., 192.168.0.0/24) or netmask (e.g., 192.168.0.0/255.255.255) notation.

SNMP Settings

SNMP (Simple Network Management Protocol) is used to monitor devices on an IP network. If you are not already using
SNMP, then you can safely ignore these settings.

If you are already using SNMP, you can monitor the OIDs that the Switchvox agent provides.
IMPORTANT: Be sure to allow SNMP traffic in Switchvox Access Control. (By default, SNMP traffic is not allowed).

SNMP v1/v2c Community Name
Enter the Community Name for the SNMP community to which Switchvox should belong.

SNMP v3 User Name
Enter the SNMP User Name, if you are using SNMP version 3.

SNMP v3 Password
Enter the SNMP Password, if you are using SNMP version 3.

Switchvox OIDs
The Switchvox prefix is .1.3.6.1.4.1.22736.10

.1 Switchvox Information

.1.3.6.1.4.1.22736.10.1.1
.1.3.6.1.4.1.22736.10.1.2
.1.3.6.1.4.1.22736.10.1.3
.1.3.6.1.4.1.22736.10.1.4
.1.3.6.1.4.1.22736.10.1.5
.1.3.6.1.4.1.22736.10.1.6

.2 VOIP Providers

software version
max concurrent calls
used feature packs
max feature packs
used extensions
max extensions
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1.3.6.1.4.1.22736.10.2.1

1.3.6.1.4.1.22736.10.2.2

1.3.6.1.4.1.22736.10.2.3.1.1
1.3.6.1.4.1.22736.10.2.3.1.2
1.3.6.1.4.1.22736.10.2.3.1.3
1.3.6.1.4.1.22736.10.2.3.1.4
1.3.6.1.4.1.22736.10.2.3.1.5
1.3.6.1.4.1.22736.10.2.3.1.6
1.3.6.1.4.1.22736.10.2.3.1.7
1.3.6.1.4.1.22736.10.2.3.1.8

1.3.6.1.4.1.22736.10.2.3.[2-xxx].[1-8]

.3 Hardware Status

1.3.6.1.4.1.22736.10.3.1.1
1.3.6.1.4.1.22736.10.3.1.2
1.3.6.1.4.1.22736.10.3.1.3
1.3.6.1.4.1.22736.10.3.1.4
1.3.6.1.4.1.22736.10.3.1.5
1.3.6.1.4.1.22736.10.3.2.1
1.3.6.1.4.1.22736.10.3.2.2
1.3.6.1.4.1.22736.10.3.2.3
1.3.6.1.4.1.22736.10.3.3.1

.4 Phone Status

1.3.6.1.4.1.22736.10.4.1

1.3.6.1.4.1.22736.10.4.2

1.3.6.1.4.1.22736.10.4.3.1.1
1.3.6.1.4.1.22736.10.4.3.1.2
1.3.6.1.4.1.22736.10.4.3.1.3
1.3.6.1.4.1.22736.10.4.3.1.4
1.3.6.1.4.1.22736.10.4.3.1.5
1.3.6.1.4.1.22736.10.4.3.1.6

1.3.6.1.4.1.22736.10.4.3.[2-xxx].[1-6]

.5 Current Calls

1.3.6.1.4.1.22736.10.5.1
1.3.6.1.4.1.22736.10.5.2
1.3.6.1.4.1.22736.10.5.3
1.3.6.1.4.1.22736.10.5.4
1.3.6.1.4.1.22736.10.5.5
1.3.6.1.4.1.22736.10.5.6
1.3.6.1.4.1.22736.10.5.7
1.3.6.1.4.1.22736.10.5.8
1.3.6.1.4.1.22736.10.5.9
1.3.6.1.4.1.22736.10.5.10
1.3.6.1.4.1.22736.10.5.11

number of VOIP providers

number of state 'Ok’ VOIP providers
first VOIP providerid

first VOIP provider type

first VOIP provider name

first VOIP provider host

first VOIP provider account id

first VOIP provider callback extension
first VOIP provider latency

first VOIP provider state

details for each additional VOIP provider

memory used

memory total

swap used

swap total

last update (memory/swap)
disk used

disk total

last update (disk)

load

number of SIP phones

number of reachable SIP phones
first phone id

first phone extension

first phone caller id

first phone user agent

first phone ip address

first phone state

details for each additional phone

total current calls

number of calls in state 'agent_login'
number of calls in state 'agent_logout'
number of calls in state 'checking_voicemail'
number of calls in state 'conference'
number of calls in state 'directory’

number of calls in state 'faxing'

number of calls in state 'intercom'’

number of calls in state "ivr'

number of calls in state 'leaving_voicemail'
number of calls in state 'monitoring'
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.1.3.6.1.4.1.22736.10.5.12 number of calls in state 'parked'

.1.3.6.1.4.1.22736.10.5.13 number of calls in state 'queued'
.1.3.6.1.4.1.22736.10.5.14 number of calls in state 'receiving_fax'
.1.3.6.1.4.1.22736.10.5.15 number of calls in state 'ringing'
.1.3.6.1.4.1.22736.10.5.16 number of calls in state 'talking'
.1.3.6.1.4.1.22736.10.5.17 number of calls in state 'unknown'
.6 Telephony Cards

.1.3.6.1.4.1.22736.10.6.1 number of devices
.1.3.6.1.4.1.22736.10.6.2 number of state 'Ok’ devices
.1.3.6.1.4.1.22736.10.6.3.1.1 first device id
.1.3.6.1.4.1.22736.10.6.3.1.2 first device name
.1.3.6.1.4.1.22736.10.6.3.1.3 first device channel
.1.3.6.1.4.1.22736.10.6.3.1.4 first device channel group
.1.3.6.1.4.1.22736.10.6.3.1.5 first device signalling
.1.3.6.1.4.1.22736.10.6.3.1.6 first device state
.1.3.6.1.4.1.22736.10.6.3.[2-xxx].[1-6] details for each additional device

.7 Switchvox Subscription

.1.3.6.1.4.1.22736.10.7.1 expire date
.1.3.6.1.4.1.22736.10.7.2 days left

.8 RAID Controller

1.3.6.1.4.1.22736.10.8.1 controller status
1.3.6.1.4.1.22736.10.8.2 logical device status
1.3.6.1.4.1.22736.10.8.3 device #0 status
1.3.6.1.4.1.22736.10.8.4 device #1 status

Other OIDs

The Switchvox agent provides some additional OIDs that are not specific to the Switchvox application.

.iso.org.dod.internet. mgmt.mib-2.system Linux system OIDs. You can use any OID under this.
.iso.org.dod.internet.private.enterprises.ucdavis Linux system OIDs. You can use any OID under this.

Access Control

The Access Control page lets you manage what networks have access to Switchvox.

Access Control Rules allow network access to Switchvox services based on IP address and Netmask. The default
action is to deny access, so if you don’t allow a service for a network, then the network is denied access to that service.

Blocked IPs have been automatically blocked by Switchvox. This section lets you see what has been blocked, and
Unblock it. It also lets you change the blocking options, and search for blocked IPs.
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Access Control Rules

The Local Network rule by default allows all traffic for all services. The All Networks rule allows traffic for various services
depending on your Switchvox configuration. You can modify the services allowed for the Local Network and All Networks
rules, but you cannot change the name or the network.

Creating an Access Control Rule

To create a new rule, click Add an Access Control Rule.
Enter the basic information for the rule:

* Aunique Rule Name
» The Network that the rule applies to (the IP address and Netmask)
» Check Never Block IPs to turn off automatic Blocking for this network

Then, for each service that you want to allow this Network to access, check that service’s box.

Never Block IPs

This indicates that Switchvox should never automatically block this network. For example, Local Network is set to
Never block IPs. For details about how Switchvox automatically blocks IP addresses, and how to change it, see
Blocked IPs.

Web Admin Portal
The Switchvox Admin Tool Suite.

Web User Portal
The Switchvox User Tool Suite (for extension owners).

Admin API
AP calls to Admin tools.

User API

API calls to User tools.

Printing

Printing to Switchvox, including printing files to be faxed.

IMAP
The Switchvox IMAP server for voicemail and faxes.

SMB| XMPP Server (Jabber)
XMPP chat server traffic.

SMB| XMPP Client (Jabber)
XMPP chat client traffic.

SIP
SIP traffic.

IAX
|AX traffic.

NTP
NTP traffic (Network Time Protocol).

SNMP
SNMP traffic. If you want to monitor Switchvox using SNMP, make sure this service is checked. For information about

the OIDs that Switchvox publishes, see SNMP Settings.

Switchvox Administrator Manual



Modifying an Access Control Rule

To modify a rule, click the Pencil icon next to the rule. The rule becomes active, and you can change the name, network,
and services. Click the Checkmark icon to save your changes.

Deleting an Access Control Rule

To delete a rule, click the X icon next to the rule. Be sure that you do indeed want to delete this rule, then click Yes,
Delete Rule. The rule is permanently deleted.

Blocked IPs

Switchvox automatically blocks an IP if it is attempting to log in or register a phone with a bad username and password.
This is based on the assumption that if someone is trying to reach Switchvox without valid login information, that person
probably does not have a legitimate reason to reach Switchvox.

To change the options for automatic blocking, click Edit Blocking Options.

ﬂ Blocked IPs

& Edit IP Blocking Options

To unblock an IP address or netmask, click Unblock on that item.

Credentals Service Blocked Reason Date Blocked = Actions

101 https (80,443) Failed web user login 5 times 06/04/2010 01:37 PM view Detaits | unblock

To find an IP address that has been blocked, use the Search field. You can enter an IP address, an extension number, or
an administrator's login.

Note: If you have physical access to the Switchvox server, you can use the Basic Server Function Unblock Local IPs
to remove the blocks for local IP addresses. (See also: Basic Server Functions.)

Edit Blocking Options

The IP Blocking Options determine when Switchvox blocks an IP address from logging into, or connecting to Switchvox.

Web Suite and API Logins
Login attempts before lock out

If an IP address attempts to log in as a Switchvox extension or administrator, but fails this number of times, then the IP
address is 'locked out' of Switchvox. That means that the IP can reach the Switchvox Web Suite and API, but no login
information can be entered.

Login attempts before IP block

If an IP address attempts to log in as a Switchvox extension or administrator, but fails this number of times, then the IP
address is blocked from connecting to Switchvox. That means that Switchvox does not let that IP display any part of the
Web Suite, oraccess the API.

Number of blocked IPs from the same network to trigger a netmask block
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If this number of blocked IPs are from the same network, then the /24 network is blocked. In other words, if the first 3 sets
of digits match on more than 25 blocked IPs, then the netmask block (e.g., 216.239.51.0/24) replaces all of the original IP
blocks. That means that all of the 256 possible IP addresses in that netmask are denied access to Switchvox.

SIP Registration

Registration attempts before IP block

If a phone attempts to register, but fails this number of times, then its IP address is blocked from connecting to
Switchvox.

Number of blocked IPs from the same network to trigger a netmask block

If this number of blocked IPs are from the same network, then the /24 network is blocked. In other words, if the first 3 sets
of digits match on more than 25 blocked IPs, then the netmask block (e.g., 216.239.51.0/24) replaces all of the original IP
blocks. That means that all of the 256 possible IP addresses in that netmask are denied access to Switchvox.

General
Share blocked IPs with Digium

If this is checked, it allows Switchvox to send the blocked IP addresses to Digium. This may help us identify common IP
addresses that are being blocked.

sms, Managing Physical Access to the Server

If you have an appliance with an LCD Panel, you can disable other access to the appliance. You can also clear the pass-
word on the LCD Panel, in case you have forgotten it.

Disable server configuration from a local keyboard

Check this box if you do not want anyone to be able to connect a keyboard and monitor to the Switchvox server and make
changes to the server configuration.

This means that the LCD Panel is the only way to access Switchvox's Basic Server Functions. You can set a password
to protect the use of the LCD Panel.

Clear LCD Password

Click this button to clear the password for the LCD Panel. This means that anyone with access to the Switchvox server
can use the LCD Panel to configure Switchvox’s Basic Server Functions, without entering a password.

Set System Clock

This shows you the current time zone and time setting. By default, Switchvox uses NTP to retrieve its time settings.
Unless you have a particular reason to change this, leave your clock set to the default NTP settings. The time zone can
be changed if the machine is moved from one location to another.
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Set System Clock

Extensions PBEx Features System Setup Diagnostics

Your Current System Time: 03/18/2009 1:24 PM
Your Current Timezone: Americaflos Angeles

Set your Timezone:

Timezone: | America/los Angeles

Set your System Date and Time:

Manually Set Your DatefTime: |

- OF -

Dizable NTP time fetching below to enable thiz aption.

Llze an MTP Server: ||:u:u:||.nt|:|.|:|rg|

| [] Disable NTP time fetching

Exarmple: us.pool.ntp.org

Save Time Settings

A WARNING: Changing the system time requires a software restart, &l current calls in the

Backups

Switchvox lets you create and download a backup that can contain much of the data and audio files for Switchvox. This

file may be restored back into Switchvox at any time to return Switchvox to the same state it was in when the backup was

created.

Always make a backup before making changes to Switchvox, and before restoring from backup.

IMPORTANT: The ‘best practice’ for backups is to schedule a daily automatic backup that stores the backup file on an

FTP server. For details, see Creating Automatic Backups.

Creating a Backup

To create a backup, click Create A Backup. This displays the Create Backups page.
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On the Create Backups page, click the check boxes next to any of the optional components that you want to include.
The only thing that you cannot include in a backup is Call Recordings; those are backed up separately. For details, see
About Call Recording Settings.

Distinctive Ringtones 2.6mhb Required

Woicernail and Fax Files 156.5kb Optional
Yoicemail Greetings 4.0kb Cptional
Music ©n Hold Files 21.1mb Optional
PEX Error Logs 317 4khb ! optional

Total Size of Backup™: 24 32mb

*approximate size before cornpression

Click Create Backup to create the backup and return to the main page.

WARNING: The backup process may take several minutes depending on the amount of content. Do not click any links or
buttons during the backup processing.

After the backup is created, the Backups page is displayed with the new backup in the Backups table. Click on
Download to save the backup (which may include multiple files). Be sure to put it in a location from which it can be easily
accessed to restore your system.

Backups (1to2)of2

Optional Contents Size Date Created & Delate Restare Dawnload
WM, VMG, MGH, EL 30,71 mb 08/04/2010 02:53 FM
UM, MG, MOH,EL 30,71 mb 08/04/2010 02135 PM

Creating Automatic Backups

It is good practice to schedule daily automatic backups. To do this, click Setup Automatic Backups to display the
Automatic Backups page.
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Automatic backups will ocour every | Frday v| at|1:00 AM W

Murnber of backup copies to keep around
When the above threshald iz reached the aldest backup will be deleted fram the ftp haost

Backups should be automatically transfered to:

FTP Hl:ustname|ft|:n.myl:ui2.|:|:nm

FTP Username |switchvux_|:|ac:ku pg

|
|
FTP Fassword ||l-|lnlnlulll-||-l-'l |
|

FTP Path lipbx01

Path of ' denaotes root lagin directory,

Test FTP Settings

Be sure to test your FTP settings, and to check the boxes for any optional components that you want to include.

Distinctive Ringtones Z.6mhb Required

Yoicemail and Fax Files 156.5khb optional
Yoicemail Greetings 4,0kb Cptional
Music On Hold Files 21.1mb Optional
PBE¥ Error Logs 317 4kb ¥l optional

Total Size of Backup®: 24.32mb

*anproximate zize before cormpression

When you have entered the settings that you want, click Save Settings to save this automatic backup and go back to the
main Backups page.

To disable automatic backups, clear all of the FTP information, then click Save Settings. Those changes are saved, and
the main Backups page is displayed.

Day and Time
Set the day of the week and time to run the backup process.

Number of Copies
When this number is exceeded, the oldest backup is deleted from the FTP host.

FTP Information

Set the hostname of your FTP server, the username and password that you use to access the server, and the path to the
directory where you want to store the backup files. Click Test FTP Settings to test this information and be sure that your
backup files can be properly transferred.

Optional Components
Click each ‘Optional’ box for the files and logs that you want to include in the backup.

Restoring a Backup

If the backup file you want to restore is listed in the table of Backups, you can restore from the list.
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If the backup file you want to restore is not listed, then you need to upload the backup file and then restore.

Restoring From the List

In the list of backups, find the backup file that you want to restore and click its Restore button.

Be sure that you do indeed want to restore this backup, then click Yes, Restore Backup.

Restoring From a Backup on Your Computer

To upload backup file(s):
1. Click Upload a Backup File.

Backups

DOWARMING Your current PBx configuration will be overwritten with the contents of the backup file you upload.
offline for a couple of minutes while the backup is loaded and processing. This will drop all calls in your syster anc

If your backup is contained on rultiple files, please upload the meta file below, otherwise upload a single backup

Backup File: |—3ED—business.svb.meta”[ Erowse..

Upload and Restore Backup

2. Click Browse to find the file on your computer. If the backup is contained on multiple files, select the .meta file.
If you select a meta file, you are prompted to Browse for all of the files on your computer:

Your backup consists of multiple files, Please upload the requested files below,

SYBACKUP__ 2010-8-4-14-35-23_18775-350-business.svb-00: | |[ Browsa.. ]
SYBACKUF _ 2010-8-4-14-35-23_18775-350-business.svb-01; | " ErE—— ]
SYBACKUP__2010-G-4-14-35-23_18775-350-business.svb-02: | " ErE—— ]
SYBACKUP__ 2010-5-4-14-35-23_18775-350-business.svb-03: | |[ Er— ]

Upload and Restore Backup

3. Click Upload and Restore Backup.
WARNING: When you restore a backup file the following things happen:

* Your current Switchvox configuration is overwritten with the contents of this backup file.

* All current calls will be dropped.

» All agents will be logged out of queues.

» All data created since the backup was created will be lost, including extensions and voicemail.

Soit is important to be absolutely sure that you want to restore your backup file.
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Deleting a Backup File

To delete a backup file from the list, click on its Delete button. Be sure that you do indeed want to permanently delete the
backup file, then click Yes, Delete Backup. That backup file is permanently deleted from the system is removed from the
list. The Backup page is displayed with a message indicating that the file has been deleted.

Updates

This shows you the following information about Switchvox:

» Current Switchvox software version number

* Maximum number of extensions and concurrent calls

»  Number of Phone Feature Packs (all, and unused)

» The expiration date for Subscriptions

* Any Switchvox software updates that are available for you to apply

Extensions PEx Features Systern Setup Diagnostics Machine Admin
ipdates

EI What is this for?

urrent Wersion: 4.,5.3 (18775) Release Notes
laximum User Extensions: 9999 [ourrently using 1)
laximum Concurrent Calls: a9

hone Feature Packs: 9999 [ourrently using 0)
ubscription Expiration: Maow 07 2020

/1 WARNING: Updating your systern will result in an automatic software restart of your phone systemn. Any current phone connections will be dropg
nd any agents logged in will be logoed out of their respective queues,

lpdates (1tol)ofl

Ipdate Description Apply

Upgrade to 24222 Upgrade the system to release 24222 more info... Download and Apply

Phone Feature Packs

Phone Feature Packs let you easily configure your phones for use with Switchvox, and offer great tools for customizing
your phones.

You need one Phone Feature Pack per SIP phone. Please see your reseller for instructions on purchasing and activating
more Phone Feature Packs. If you purchased your phones with Switchvox, then each phone already has its own Phone
Feature Pack, and is already configured for use with Switchvox. Phone Feature Packs are not necessary for any other

type of extension.

A Switchvox Phone Feature Pack offers the following features:
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» Customized phone displays
Customize some of the information displayed on your phone. See Phone Options.

+ Status Indicators
Set a line status indicator light on your phone. This can show whether a call is waiting in a parking lot, or whether you
are logged into a queue. See Status Indicator Entries.

» Distinctive Ringtones
Set the audio file of your choice to ring on incoming calls, depending on the caller. See Distinctive Ring Rules.

* Auto-answer
Set an automatic answer in Intercom mode, depending on your caller. See Distinctive Ring Rules.

» Combine Ringtones and Auto-answer
Combine a ringtone and auto-answer, depending on the caller. See Distinctive Ring Rules.

* Phone Applications
Access many of the Switchvox features right from your phone.

The Phone Features available on your phone will vary, depending on the type of phone you have.

» The General Options are available on snom and Polycom phones.

» The other features are only available on Polycom phones. If you have a newer Polycom phone with three or
more lines (e.g., the VVX 1500 or SoundPoint 450, 550, 560,650, or 670) you should be able to take full advantage of
your Phone Feature Pack. Other Polycom phones may not offer all of the features.

» If you use Switchvox remotely (your phone is not on the same network as Switchvox), you will not see
Switchvox Caller Profiles.

Subscription Expiration

If your Switchvox subscription is about to expire, then you will see alerts and options to renew your subscription. If you
renew your subscription those alerts will go away. Or, you can turn the alerts off at any time.

Switchvox Software Updates

If the Updates page says that no updates are available for your system, then you already have the newest version of the
software.

If there are one or more updates listed on this page, each one is listed with a more info... link that displays the release
notes for that update. The release notes describe the new enhancements in the update, and any issues that are resolved
in that update.

Each update has two actions: Download, and Download and Apply.

Updates (1tollofil

Update Cescription Apply

UJpgrade to 24222 Upgrade the system to release 24222 more info... Download and Apply

Download

If you click Download, that update is downloaded to Switchvox, with a progress indicator so that you can see how long it
will take. When the download is complete and the update is ready to be applied, that button becomes Apply This Update
. You can apply the update whenever it is convenient.
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Once you apply an update, the files for that update, and any previous updates that you may have downloaded, are
removed from Switchvox.

Download and Apply

If you click Download and Apply, that update is downloaded to Switchvox and immediately applied.

Before Applying an Update

Applying an update requires that Switchvox is unavailable for a period of time. Before you Apply an update, take the fol-
lowing precautions:

» Create a backup (see Backups) and make sure that it is easily accessible. (You could also ensure that your
automated backups are easily accessible, but we recommend that you create a new backup right before applying an
update.)

» Locate your Switchvox CD and have it easily accessible.

» Ensure that no one is currently using Switchvox, and that you have a reasonable amount of time to apply the
update before anyone begins using Switchvox again.

After Applying an Update

Once an update has been applied, be sure that the update completed successfully, and Switchvox is functioning as
expected:

» Check the Current Version to make sure that this update was applied.
» Make a call from a Switchvox extension to another extension, and to an external phone number.

» If possible, make a call into Switchvox (e.g., from a mobile phone), and ensure that your main IVR is responding
normally.

That's all you need to do.

Product Registration

This is used to register Switchvox. Usually registration is completed when the system is first installed. If this is the case,
this page displays the first few characters of your Registration Code, which you will need if you call Switchvox Technical
Support.

If you have not yet registered Switchvox, please do so.

Digium Addon Products

This lets you register and enable Digium addon products.

To add a product,
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1. Select the product from the dropdown
2. Enteryour License Key
3. Click Submit.
If you install a Fax license, you will be prompted to download and install the related fax software.

For information about what add-on products are available for your Switchvox system, click Switchvox Product Addons.
That includes freely available addon products, and other available addons that are specific to your Switchvox.

Manage Admins

This lets you change the main admin password (User Name 'admin'), and manage additional admin accounts.

Extensions PBEx Features System Setup Diagnostics

Manage Admins
APL Admin Password

Current Password for APL 69f4dfce 252479382 ce 7 df53f2e9969
@ What is this for?

Change Your &dmin Password

Create New Password: |"uunuu| |

[ Good ]

Retype New F'assw::nrd:| |

Change Password

Create/Edit &dmin Users
Admin Users (1to 2 )of 2

Admin Login Modify / Delete

adrmin | || |

Justine Modify
Create Hew Admin User
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Language and Locale

The Switchvox web-based tool suite is available in several languages:
&5 English for United States
&l% English for United Kingdom
=— Spanish for Spain
[:0 Spanish for Mexico
I 1 ltalian

To set your preferred language:

1. Select a language from the dropdown.

2. Select alocale for that language.

If you choose to use a language other than English for US, be aware that all other languages and locales handle dates
with the format of dd/mm/yyyy (as opposed to mm/dd/yyyy).

» Creating Extensions
By default, new extensions are created as English for US. If you want new extensions to default to your preferred
language, use Extension Templates.

The Main Admin Password

To change the password for the main admin account, enter a new password into the Create New Password field, and
then retype it in the Retype New Password field (for verification).

The password is case-sensitive, and it can contain special characters. The strength of your new password is indicated, to
help you create a good password. When you are happy with your new password, click Change Password.

SMB| Each time you change the main admin password, the Call API password is changed and displayed here. If you
change your password, be sure to put this new API password in place of the old password wherever you use the Call API
with admin authorization. Please see APl Admin Password.

sus Creating & Editing Admin Users

You can create multiple 'sub-admin’ users, each with their own permissions. This way, you can assign Switchvox
administrative tasks to various people, and limit their access to just the tasks they need to perform.

Click Create New Admin User to display the New Admin page. Enter a new Login name for the user, then enter and re-
enter a new password. The password is case-sensitive, and it can contain special characters. The strength of your new
password is indicated, to help you create a good password.

Leave the box checked for Force password change at next login, unless you really want your new sub-admin user to
use the password that you created. If the sub-admin creates a weak password, Switchvox notifies you with an alert.

You can set this sub-admin user’s access for each of the main sections in Switchvox. You can block the sub-admin user
from using a section at all, or let him or her see the information in that section, or make changes (which allows full access
for that section).
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Click Create Admin, and the Manage Admins page is redisplayed with the new sub-admin user included in the Admin
Users list.

To modify a sub-admin user, click Modify for that user. You can change the password (leave the password fields blank if
you do not want to change the password), and all of the access settings. If you want the sub-admin user to change his or
her password, make sure the box is checked for Force password change at next login. Click Update Admin to save
your changes and go back to the Manage Admins page.
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Extensions

Manage &dmins

PR Features

Systern Setup

T Login Information for Admin Login: justine

Password |

Retype Password |

Lege Sank F pou do not wish o change the passwond for this admin.

] Force password change at next login,

Pl Access Level

Section Mame
Extensions
Manage Extensions
Extension Templates
Extension Settings
Extension Groups

Extension Permissions

PBX Features
Music On Hold
IWR Editor
Sound Manager
Tirme Frames
Zall Recording

Switchboard Plugins

System Setup
Hardware Setup

Channel Admin

O noneg
O noneg
O none
O noneg
O none
O none

O noneg
O nong
O nong
O nong
O none
O none
O none

O noneg
{:} noneg
{:} noneg

Access Level

O read anly
@) read anly
® read anly
@) read anly
® read anly
® read anly

O read anly
@ read anly
® read anly
@ read anly
@ read anly
@ read anly
@) read anly

O read anly
) read anly
® read anly

O read/write
O readfwrite
O readfwrite
O readfwrite
O readfwrite
O readfwrite

O read/write
O read/write
O read/write
O read/write
O read/write
O read/write
O read/write

O read/write
O read/write
O read/write

Diagnostics
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APl Admin Password

The Call Creation API has been deprecated. Please use the Extend API (for details, go to the web site
developers.digium.com).

The Call Creation API offered a way for external applications to originate phone calls via the PBX. The API required
authentication, and used a modified version of the admin password.

System Reload

We recommend that you do not use these options unless instructed to do so by a Technical Support representative.
If you decide to use these tools to reload, restart, reboot, or shut down Switchvox, be prepared:

* Make a backup file (see Creating a Backup).
» Inform your Switchvox users that calls will be dropped and members will be logged out of their queues.
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The User Tool Suite
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Getting Started

Welcome to Switchvox, the world’s most powerful, yet easy to configure IP-PBX. This document describes how to use
the Web-based Switchvox User Tool Suite.

Throughout this document, we refer to the User Suite menu options as a path, using >’. Instead of saying “select the
Modify Account option from the Settings menu in the navigation bar, we say “select Settings > Modify Account.”

IMPORTANT: You may find some features described in this document that are not available to you. This is determined
by the version of Switchvox you are using, and what features your Switchvox administrator has given you permission to
use. Please contact your administrator if you have any questions.

About the User Suite

Each user has a Switchvox account that is his or her phone extension, and a password for that account. Ask your
Switchvox administrator for your extension number and password, and for the URL of your Switchvox User Tool Suite
(the User Suite).

Logging Into the User Suite

On a computer that is on the same network as Switchvox, open a Web browser and enter the URL of the User Suite:

https://YourServerIPaddress/main

The Login page is displayed.

Please Log In To Use the Tool Suite

Extension |‘I 01 |

Fassword |-----| |

Enter your extension and password (provided by your administrator). Once you are logged in, you may have to change
your password. If you do, the strength of your new password is indicated, to help you create a good password. The next
time you go to the User Suite, log in using your new password.

Tolog out of the User Suite, click Logout (located in the upper right-hand corner).

User Suite Navigation

The User Suite navigation bar contains the following dropdown menus:

Settings
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Set up your account, specify how you want to handle calls, manage your Phonebooks, and set up your own conference
room.

Voicemail / Fax
Manage incoming and outgoing voicemail and faxes, set up voicemail greetings, and customize email notifications for
voicemail.

Call History
See logs of all calls to and from your extension and run usage reports.

Getting Help

Click any help link to open a pop-up window with information about a particular tool. Help links are available as question-
mark icons and as text links.

EI How do I use this page?

If a pop-up window does not display, set your Web browser to allow pop-ups from the domain of your Switchvox server.
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Settings

The Settings area is where you set up your account, specify how you want to handle calls, manage your Phonebooks,
and set up your own conference room.

Modify Account

This section lists basic information about your Switchvox account.

Your administrator may have given you permission to change this information. If you do make changes, click Modify
Extension to save those changes. The page is refreshed, and a message indicates that your changes were successfully
saved.

If you are changing your password, the strength of your new password is indicated as you type, to help you create a good
password. The next time you go to the User Suite, log in using your new password.

Your Profile

An Extension Profile includes some or all of the following:

Justine Kilean

* Image . .

* First and Last Name teountManager

- Title Extension: 101 00 5§ 9
* Location Location: San Diego

e Extension Number

Profiles can be shown in the Switchboard and on a phone

that uses a Phone Feature Pack. For details, see Your
Phone Feature Pack.

Profile Picture
To add a picture:
1. Click Add an image.

2. Click Browse, and then find the image file on your computer.
Images must be at least 75x100 pixels, and must be in jpg format.

3. Click Upload.
The image is uploaded and displayed with the crop area that will be used to make a 75x100 image. You can move the
crop area around to choose the best portion of the picture. The Preview on the right shows you what the picture will
look like once it is cropped.

4. Click Save Image.
5. Click Save Extension Settings.
To upload a different picture, re-crop the existing picture, or delete the existing picture:

1. Click View Image.
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2. Click ReCrop, or Delete.
If you want to upload a different image, Delete this image now, and then click Add an image to start again.

3. Confirm your changes.

4. Click Save Extension Settings.

Language Setting

The Switchvox web-based tool suite is available in several languages:
S English for United States
&% English for United Kingdom
— Spanish for Spain
[:0 Spanish for Mexico
[ 1 ltalian

To set your preferred language:

1. Select a language from the dropdown.

2. Select alocale for that language.

If you choose to use a language other than English for US, be aware that all other languages and locales handle dates
with the format of dd/mm/yyyy (as opposed to mm/dd/yyyy).

Sound Prompt Language

If there are one or more sound packs available in different languages, those languages are available in this dropdown.
Select the language that this extension hears (e.g., when calling the voicemail access extension, the prompts are in
[talian).

Call Rules

Call Rules control how your calls are handled. Here are some examples:

*  When I’m on the phone, go straight to voicemail

» If I don’'t answer, ‘cascade’ calls to my mobile phone then my home phone
» Forward all my calls to another extension

* Onweekends and evenings, forward all my calls to another extension

» Hang up on calls from a certain phone number
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Settings Voicemail £ Fax Call History

Call Rules

I] Call Rule Sets |7/

Unanswered Call Rule Sets

Add Hew Rule Set

# Rule Set Information

Mame: Forward to ry mobile Time Frame: Outside Business Hours
1 1, Cascade direct calls to 916195551234 immediately and atternpt to preserve caller id.

2, Send direct calls to voicemail after 4 rings,

Busy Call Rule Sets

_OR_
Use my unanswered call rule sets m

You currently do not have any rule sets defined in this section,

EI Call Blocking |2

Add Call Block Rule

# Move Unanswered Call Rule Sets

) @ Block | Phore Number v | (918585551234 | &nd Then [ Send to Vaicemal |

when time is | Always w |

E Messages/Prompts

Secret Code  “Slease enter vour password followed by the pound key, ™ I
Secret Code  “Fassword incorrect, Blease enter your password followed by the pound I
kew,
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Call Rule Sets

Unanswered Call Rule Sets specify how a call is handled after a certain number of rings. Busy Call Rule Sets specify
how a call is handled when your line is busy. You can set up different rules for those situations, or use the same rules.

When a call is unanswered or your line is busy, Switchvox evaluates each of your Call Rules in the order listed. The first
set is evaluated in order, then the second set, and so on. That means that the ‘During Business Hours’ rule that forwards
a call to your mobile phone must come before the ‘Anytime’ rule that sends a call straight to your voicemail.

It's a good idea to test your rules by calling your extension from another phone.

Creating a New Call Rule Set

To create a new Call Rule Set under Unanswered or Busy, click the appropriate New Rule Set button. To create a new
Busy Call Rule Set, you must first un-check the box Use my unanswered call rule sets. That makes the Add New
Busy Rule Set button active (it turns blue), so you can click it and create a new rule set.

When the settings are correct, click on Save Ruleset Settings to create the new rule set and add its rules.
1. Select the type of rule to add from the dropdown
2. Click Add Rule.
3. Specify whether the rule applies to direct calls, queue calls, or all calls.
4. Depending on the type of rule you are adding, enter the appropriate extensions or phone numbers.
5. If you are adding a Secret Code rule, enter 1 to 10 digits.

6. If you are creating an Unanswered rule, specify the number of times to ring your phone before following this rule.
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[I Rule Set Rules|?

| Send ToVoicemail | Add Rule

# Move Call Rules

. D Cascade |drectcalls | to (916195551234 | after [ Immediately
P.tternpt to preserve caller id,

2 @ Send | direct call: % | to voicemail af'ter

El Rule Set Settings

Rule Set Mame |F|:|r'u'uard to my mu:ul:uile|

Example: On Vacation

Fule Set Time Frame | Outzide Business Hours |

wWhen is this rule set used?

Modify Ruleset Settings

Rule Set Name
Enter a unique name for this rule set.

Rule Set Time Frame
Select a time frame from the dropdown. Switchvox evaluates the current date and time against this time frame, and if they

match then the rule is followed. If they do not match, Switchvox moves on to the next rule. See Time Frames for more
information.

Send to Voicemail
This rule sends a call to your voicemail so the caller can leave a message.

Call Forward
This rule forwards a call to another Switchvox extension. The extension can be another phone, a call queue, or any other

type of extension. Once a call is forwarded to the extension, the call rules for that extension are followed.

Call Cascade
This rule rings another extension or an external phone number (i.e., your mobile phone), and if the call isn’t answered then

it is passed on to the next rule in the set. This action depends on your Outgoing Call Provider, but if your provider supports
it, you can stack several rules that try and reach you at several phone numbers. Note: If you are cascading a call to an
external phone number, be sure to add a ‘9’ or other necessary digits that you normally use to dial out.

Secret Code
This rule prompts the caller to enter a secret code, then passes the caller to the next rule in the set. If the caller cannot

enter the correct secret code after the specified number of tries, then you can specify what to do with the call.
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Ring All
This rule simultaneously rings up to 3 extensions or external phone numbers. Nofte: If you are ringing an external phone
number, be sure to add a ‘9’ or other necessary digits that you normally use to dial out.

Managing Call Rule Sets

If you have multiple Rule Sets, you can drag and drop them to prioritize them appropriately, or you can delete them and
replace them with new rules. Your rules need to be put in order because they are executed from top to bottom.

You can have different rule sets for different times, and activate or deactivate them as you see fit. In order to activate a
rule set, click on the Activate button to the right of the rule, and fill in the time you want the rule to occur. The active rule
set will be highlighted yellow and will display how long it will be active on the right side. This process is the same for
Unanswered or Busy Call Rule Sets.

Call Blocking

Switchvox lets you specify phone numbers that you do not want to accept calls from. You can block specific phone
numbers, or any numbers that begin with the same prefix, and you can block them at all times or during specified time
frames. You can also choose how Switchvox handles the blocked calls.

Click Add Call Block Rule and a new blank rule section appears. Select Phone Number or Prefix from the dropdown,
then enter the number. Be careful entering a prefix; if you put in the wrong prefix you might end up blocking more calls than
you expected. Select the action Switchvox should take with the blocked call, then select a Time Frame if you want to
control when these calls are blocked. Click Save to save your changes to the Call Block Rule.

Messages/Prompts

If you use the Secret Code feature in a Call Rule, the default sound prompts are provided here. You can change the
prompts by recording your own sound over your phone, or uploading a new sound file.

To add or change your own sound, click the prompt’s New button. To play the sound, click the prompt’s Play button. To
remove a sound that you created, and go back to the default sound, click the prompt’s Use Default button.

Time Frames

Switchvox can operate differently based on the date, day, and time.

A time frame is considered valid when the current date and time match any one of a Time Frame’s rules. Not all of the
rules have to match.

Creating a New Time Frame

To create a new time frame, enter a unique name and click Create New. Enter any appropriate Start and End Dates, Start
and End Days, and Start and End times, then click Add.

Continue adding rules until you have completed the Time Frame definition.
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The following are sample time frame definitions:

Start Date End Date Start Day End Day Start Time End Time
- - Monday Monday - -

- - Wednesday Wednesday - -
Mondays 12:00Am to 11:59PM, and Wednesdays 12:00AM to 11:59Pm

Start Date End Date Start Day End Day Start Time End Time
- - - - 3:00 AM 6:00 AM
Early Morning

Start Date End Date Start Day End Day Start Time End Time
07/01/2009 07/07/2009 - - - -
The First Week in July 2009

Start Date End Date Start Day End Day Start Time End Time
01/21/2009 - - - - -
After January 21, 2009

Start Date End Date Start Day End Day Start Time End Time
02/01/2009 02/28/2009 Monday Friday 6:00 AM 7:00 AM

Weekdays in February, 2009 between 6:00 and 7:00 in the morning

Editing a Time Frame

To change a time frame, click its Edit button. This displays the Manage This Time Frame page. Create a new rule, or
multiple rules, and delete any rules that you do not want to include in this time frame. (You cannot edit a rule.)
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Manage this Time Frame
IEI How does this worc?
Start Date End Date Start Day End Day Start Time End Time

- Monday Friday 2:00 am 5:00 pm

) S - o s S | N

Midnight = 12:00 AM

Moon = 12:00 PM

Deleting a Time Frame

To delete a time frame, click its Delete button. Be sure that you do indeed want to delete this time frame, then click Yes,
Delete Time Frame. The Time Frames main page is deleted with a message that the time frame was deleted.

Before you delete a Time Frame, be sure you do not have any IVR Menus or Call Rules that depend on it.

Phonebooks

Your Switchvox Phonebooks let you organize your contacts so that you can easily access them from your Switchboard.
Phonebooks can include your fellow Switchvox users, and external contacts.
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Settings Yoicemail / Fax Call History

Phonebooks

Add Phonebook Entries ll

Entry Type: | System Extension v|
Phoneboolk:

Extensionis): | | 2
Permission Type: 2] ® normal O Extended

Add to Phonebook

D Phone Provisioning Options 1'

Default New Phonebook

vour Default Phonebook (1 to 12 3 of 12

# = Mowe Murmber Marne Type Additional Mumbers
Ex

1 @ 102 Jane Doesan ZIP Extension m
2 & 103 John Smith SIP Extension E
3 & 104 Gilbert Brown SIP Extension | show |
5 @ 106 Spencer Flemming SIP Extension m
g @ 109 Posey Podolsky SIP Extension m
g £ 11w Ortiz Schuster SIP Extension | Show |
1z @ 113 Morris Madsen SIP Extension m
13 @ 114 Maoon Bradley SIP Extension m
13 @ 119 windham Stephens SIP Extension m
21 @ 611 Custorner Service Call Queues m
2z @ 61z Technical Support Call Queue m
25 @ g99 Yoicernail Yoicermail m

Adding Phonebook Entries

There are different types of Phonebook entries, depending on whether the entry is known within Switchvox, oris an
external phone number.
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System Extension Entries

System Extension Entries are other Switchvox extensions. You can add user-type extensions, and other types of
extensions such as queues or IVRs.

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

Extension(s)

Enter at least one extension here. To enter multiple extensions, put a comma (,) after each extension. Click the people
icon to see a directory of your Switchvox extensions. Hold down Ctrl to select many extensions, or hold down Shift to
select a block of extensions.

Permission Type
Normal: Shows the user's Presence, and whether or not he or she is on the phone. Also includes a dropdown that lets you
open a chat, call additional numbers, or Intercom the person.

Extended: Shows the Normal features, plus the caller ID name and number of the user’s active calls. It also includes
options to monitor, record, whisper, barge into, or pick up the user’s calls.

Only phone-type extensions can be Extended Permission entries. If you try to add any other type of extension (e.g., a Call
Queue), it is added as a Normal entry.

You can change an entry’s permission type at any time.

If you cannot see or use an option in an Extended Entry, your Switchvox administrator has not given you permission to do
so.

External Number Entries

External Number Entries are for names and phone numbers other than Switchvox extensions. Once you add an external
entry, you will also be able to put Additional Numbers into that entry.

Make sure to enter this number as you would dial it from your phone. For example, if you must dial 9 for an external
number, an external number here must begin with a 9.

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

Number
Enter the phone number.

Name
Enter a name.

SME| jabber ID
Enter this person’s Jabber ID to display his Jabber presence on your Switchboard in his Phonebook entry.

The Jabber ID has a user ID (the extension) and a Jabber Hostname. For example, 101@jabber.peeredswitchvox.com.

su| Status Indicator Entries

These entries are only available for Polycom and snom phones that Switchvox has configured in the Phone Setup tool. If
you don’t see this type of entry, check with your Switchvox administrator.

A Status Indicator entry controls a line status indicator light on your phone.

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.
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IMPORTANT: This must be the same Phonebook as the one in the Phone Features Options for this entry to affect your
phone. Also, it must be one of the first entries in the Phonebook if you want it to display without having to scroll through
the entries on your phone.

Entry Name
Enter a name for this entry. This isn’t required, as you don’t see the entry in your Switchboard.

Monitor Type
Parking Lot: This lights up the line status indicator on your phone when a caller is waiting in the specified Parking Lot

Extension.

Queue Login Status: This lights up the line status indicator on your phone when you are logged into the specified queue.
Enter the Agent Login Extension that you use to log into this queue, and the queue that you want to monitor.

Switchvox-Peer Entries

If your Switchvox is peered with another Switchvox, you can include the peered Switchvox extensions in your
Phonebook.

For peered extensions, use the External Number entry type (because this extension is not on your Switchvox).

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

Number
Enter the extension number from the peered Switchvox, just as you would dial it on your phone. Peered extensions might

start with a different number than yours, or have more digits.

Name
Enter a name for this entry.

SMB| Jabber ID
Enter this person’s Jabber ID to display his Jabber presence on your Switchboard in his Phonebook entry.

The Jabber ID has a user ID (the extension) and a Jabber Hostname. For example, 101@jabber.peeredswitchvox.com.

Managing Phonebooks

SMB| To create a new Phonebook, click the New Phonebook tab. Enter a unique name for this Phonebook, and click
Create New Phonebook. This Phonebook is created and is now available in the Phonebook dropdown when you create
anew entry.

To move an entry back and forth as a Normal or Extended entry, drag the entry’s green arrow icon.

To delete an entry, click its Delete button. Be sure that you do indeed want to delete this entry, then click Yes, Delete
.The Phonebook is refreshed, and this entry is gone.

SMB| To delete a Phonebook, click its X icon. Be sure that you do indeed want to delete the Phonebook, then click Yes,
Delete.

Phone Features Options

The Phone Features Options let you specify a Phonebook to push out to your phone. Your phone must have a Phone
Feature Pack, otherwise these settings are not available. For details, see Your Phone Feature Pack.
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When you make changes to a Phonebook, or you want to change the Phonebook that is already on your phone, click
Reboot Phone to send the correct Phonebook out to your phone. Rebooting your phone takes a few minutes, and you
will not be able to make or receive calls while it is rebooting.

Note: If the phone is not on the same network as Switchvox, the phone might not be rebooted. In that case, you must
reboot the phone manually.

Select a Phonebook: | Default s | LR (T
Reboot Phone El

Additional Numbers

Each Phonebook entry is based on one main extension or phone number, but it can have also have additional numbers
associated with it. This way, you can have one Phonebook entry for a person, and have all of their contact numbers

included in that entry. The Additional Numbers are available via a dropdown (the blue plus sign) in the Switchboard
Phonebook entry.

To see and modify Additional Numbers for an entry, click the entry’s Show button.

2 @ 104 Gilbert Brown SIP Extension m

Additional Numbers: @
Mave Icon  Title Mumber Edit Delete Hide Ce

£t 4 H Mabile 5552223456 OJ

@ Add A Number

Additional Numbers can be entered by an extension owner, or you can enter them in your Phonebook entry.

Additional Numbers entered by an extension owner are available when you add the extension to your Phonebook. These
numbers appear as locked and cannot be edited, but you can choose to hide them in the Switchboard.

Additional numbers that you add to your Phonebook entry can be edited and deleted. You can also copy any Additional
Numbers (including the owner's numbers), and then edit or delete the copy.

Additional Info

Your account and profile include Additional information that is used to help others in your organization find you when you
are away from your desk. For example, you can add your mobile phone number, your home phone number, or even
another extension that you use frequently. Numbers added here are shown in your co-workers’ Phonebook entries.
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Settings Voicemail £ Fax Zall History

Additional Info

(2] additional Numbers

Mave Icon Title Humber Edit Delete
ft [F  mobile 912225551234 o R
& O L s23 A, 1

@ Add A MNumber

To create a new number, click Add A Number. You can set anicon, title, and a phone number or extension. The icon and
title are displayed in your co-workers’ Phonebook entries. To change the icon for an entry, click the icon.

IMPORTANT: Make sure to enter the number as you would dial it from your phone. For example, begin with a 9 if that’s
how you would normally dial that number.

Click the pencil icon to change a number, or the red X to delete a number. Drag the green arrows to change the order that
your numbers are shownin.

s« Conference Setup

This section lets you create your own conference room. Ask your Switchvox Administrator for the main conference room
extension number. When a caller dials that number, he or she can access your conference room by dialing your
conference room number.
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Settings Voicemail £ Fax Call History

Conference Setup

I} General Settings
ﬂWhat is this for?

Your Conference Room Murmber: |:| "
5 digits

Play sound when people enter/leave

Sound type: | Sound with Caller Mame [user review option] Y| 2]

] Play Music On Hold when only 1 member is in the confarence

Conference members may press # and be sent to extension |:| 2

Fl  Admin Settings

il'l'ell me more about admins

all Available Accounts Conference Admins

103 "dahn Sroitk" 101 “Juszting Kilean"
104 "Gilbert Brown' 102 "Jane Doeson'
105 “Agner Wit

106 "Spencer Flemming'

107 "Mewton Degenhardt"

108 "webster Savage" b
109 "Pogey Podalsky"

110 "Ortiz Schuster”

111 "Harvey Culver

112 "wfebb Sandersan' W

|

L

Ll only allow conference admins to talk
[ Hang up conference when all conference admins leave

[] Users can not talk until a conference admin is in the conference room

Save Conference Settings
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General Settings

You can change the behavior of your conference room using several options.

Your Conference Room Number
Enter a unique 5-digit number for your conference room. This is the number that you give to callers so they can access
your conference room. Click the green arrow to have the system pick a random, unused room number for you.

Play sound when people enter/leave
Check this box and select a sound to play to all members of the conference room when a new caller enters the room.
There are three options for the sound type that is played when a caller enters and exits your conference room:

Only Sound: Only a sound is played, no information about the caller.

Sound with Caller Name: The caller is prompted to record his or her name. The recorded name is then played along with a
sound.

Sound with Caller Name (user review option): This is the same as Sound with Caller Name, but it gives the caller an
opportunity to listen to the recorded name, then accept or re-record it before joining the conference room.

Play Music On Hold when only 1 member is in the conference room
Check the box if you want this to be true.

Conference members may press # and be sent to extension []
Enter an extension here, so that when member hit the # key, they are transferred to that extension.

Admin Settings
Admins are special members of a conference room who have additional privileges. Use the lists in this section to identify

which extensions are treated as admins of your conference room, and set the options for your admins.

Only allow conference admins to talk
Check this box to make all non-admin callers listen-only.

Hang up conference when all conference admins leave
Check this box to ensure that your conference room is closed down after the conference is over.

Users cannot talk until a conference admin is in the conference room
Check this box to keep callers mute until an admin is in the room. Callers can join the room, but they cannot speak to
each other.

Phone Features

Use the Phone Features page to customize the way your phone works. Your phone must have a Phone
Feature Pack, otherwise these settings are not available. For details, see Your Phone Feature Pack.

[,

IMPORTANT: If you make changes to any of these settings, you must reboot your phone for the
changes to take affect.
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Phone Options

Phone Options let you set up the behavior of your phone. Your phone must have a Phone Feature Pack, otherwise these
settings are not available. For details, see Your Phone Feature Pack. Phone Setup

General Options

General options can be set for snom phones and Polycom phones.

Line Label
This is the set of letters and/or numbers that are shown on the line for your extension. By default, this is your extension

number.

Auto-answer Switchboard initiated calls
This sets your phone to automatically answer Switchboard-initiated calls. If you click on a Switchboard phonebook entry,

normally your phone rings and you have to pick it up, then Switchvox dials the number for that entry. If this box is
checked, your phone rings and then automatically goes to Intercom mode and answers the Switchboard, and you hear the
phone ringing for the call to your phonebook entry.

Hide missed calls
This turns off the missed calls notification. You can turn this back on but you will have to restart your phone, so any calls

you have missed in the meantime will be ignored, and you will not have a missed call notification after the phone is
restarted.

Polycom Options

Polycom Options are for Polycom phones only.

Line keys per registration
This sets the number of buttoned-lines on your phone that are set to this extension. For example, if you have a 3-line

phone, you can set all 3 lines to your extension. That way, you can have an active call and 2 calls on hold, and use the
buttons to manage those calls.

Any line on the phone that is not used for your own extension will be automatically filled with your Phonebook entries. For
details, see Phone Features Options.

Do not show caller profile on phone during incoming/outgoing calls
This turns off the Switchvox Profile feature. For details on profiles, see Your Profile.

Distinctive Ringtones

Switchvox can store and play distinctive ringtones that can be used on your Polycom phone. Your phone must have a
Phone Feature Pack, otherwise these settings are not available. For details, see Your Phone Feature Pack.

Add a Ringtone

You can add as many ringtones to Switchvox as you want. However, each phone has two important limitations for sup-
porting ringtones that do not come standard on the phone:Maximum disk-use of 300 kilobytes for all ringtonesMaximum of
8 ringtones
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Add a Ringtone
Ringtone File (owasy filed: | |[ Browse...

Marme: | |

Add Ringtone

To add a ringtone:
1. Click Browse, and find the file on your computer.
2. In the Name field, enter a name for this ringtone.
3. Click Add Ringtone.

The Distinctive Ringtones list is refreshed, with your new ringtone listed.

Distinctive Ringtones List

This list shows the ringtones that you have uploaded to Switchvox, and the ringtones that come with a Polycom phone. (If
you have added ringtones directly to your phone, those are not included in this list.) Depending on the permissions you
have on each ringtone, you can do the following:

*/ Play the ringtone.
The audio file is downloaded to your computer, then played using your default audio player for WAV files.

| Edit the ringtone.
You can upload a new file, or change the Name.

X Delete the ringtone.
You must verify that you want the ringtone deleted. If you delete a ringtone, every Ring-Rule that uses that ringtone is
also deleted.

Distinctive Ring Rules

These rules control what happens when you get an incoming call on your Polycom phone. Your phone must have a Phone
Feature Pack, otherwise these settings are not available. For details, see Your Phone Feature Pack.

Ring Rules define conditions for callers or kinds of calls, and then define what the phone does when those calls come in.
Here are the actions the phone can take if a call meets your conditions:

* Ring with the specified ringtone

* Auto-answer in Intercom mode

* Ring and auto-answer

* Mute the ring (your line still blinks)

To add a new Ring Rule:

1 Enter a Rule Name E Distinctive Ring Rules EI (erly avallable for Polycom phoras)

2. Select the action your phone should take (Ring  gdd a Ring Rule:

Type). I
ype) Rule Mame: | | sing &% of
3. Select a Ringtone, if you have chosen a Ring Ring Type: | Standard Ring v Bl
action. . 0% 0
Ringtone:

4. Click Add Ringtone Rule.

Add Ring Rule
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The new rule is created, with a link to Modify Rule Conditions.
5. Click Modify Rule Conditions.

The Rule Condition window is displayed.
6. Select a Call Type and set the Conditions

» Extension
If the incoming call is from any one of these extensions, the condition is met. This can be one or many extensions.

« Caller ID Number Range
If the incoming caller ID number is equal to one of these numbers, or it falls between them, the condition is met.
 Caller ID Number Pattern
If the incoming caller ID number matches this number pattern, the condition is met.
Use the asterisk (*) to indicate that "any number matches." For example, 619555* matches every call with area
code 619 and prefix 555.
* Caller ID Name Pattern
If the incoming caller ID name matches this text pattern, the condition is met.
Use the asterisk (*) to indicate that "any letter matches." For example, *Smith matches every call from a name that
ends with Smith.
* Ring Hint
If the incoming call has this Ring Hint associated with it, the condition is met.
Ring Hints are created and managed by your Switchvox administrator. They can indicate almost anything, so check
with your administrator before using this condition.
* Queue Calls
If the incoming call comes from any queue, the condition is met.
« Direct Calls
If the incoming call was made directly to your extension (or to a DID that is directly routed to your extension), the
condition is met.
* Internal Calls
If the incoming call originated in Switchvox, the condition is met.
» External Calls
If the incoming call originated outside of Switchvox, the condition is met.

When you have created the conditions that you want, click Close.
7. Restart the phone.

Once you have set up Ring Rules and restarted your phone, your ringtone disk space usage is displayed. This is specific
to your phone, and can help you decide which ringtones to use for your Ring Rules. You can add as many ringtones to
Switchvox as you want. However, each phone has two important limitations for supporting ringtones that do not come
standard on the phone:Maximum disk-use of 300 kilobytes for all ringtonesMaximum of 8 ringtones

To change existing Ring Rules or Conditions:

¢ Edit
Click the Edit button to change the details of a rule, or of one condition in a rule.

© save
Click the Save button to save the changes that you made.

X Delete
Click the delete button to delete a Ring Rule, or to delete one condition in a rule.
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Your Phone Feature Pack

If your phone does not have a Phone Feature Pack, please see your Switchvox administrator.

A Switchvox Phone Feature Pack offers the following features:

5,

"

» Customized phone displays
Customize some of the information displayed on your phone. See Phone Options.
» Status Indicators
Set a line status indicator light on your phone. This can show whether a call is waiting in a parking
lot, or whether you are logged into a queue. See Status Indicator Entries.
» Distinctive Ringtones
Set the audio file of your choice to ring on incoming calls, depending on the caller. See Distinctive Ring Rules.

* Auto-answer

Set an automatic answer in Intercom mode, depending on your caller. See Distinctive Ring Rules.
» Combine Ringtones and Auto-answer

Combine a ringtone and auto-answer, depending on the caller. See Distinctive Ring Rules.
* Phone Applications

Access many of the Switchvox features right from your phone.

The Phone Features available on your phone will vary, depending on the type of phone you have.

» The General Options are available on snom and Polycom phones.

» The other features are only available on Polycom phones. If you have a newer Polycom phone with three or
more lines (e.g., the VVX 1500 or SoundPoint 450, 550, 560,650, or 670) you should be able to take full advantage of
your Phone Feature Pack. Other Polycom phones may not offer all of the features.

» If you use Switchvox remotely (your phone is not on the same network as Switchvox), you will not see
Switchvox Caller Profiles.

Phone Applications

To use the Switchvox Applications on your Polycom phone:

1. Press the Applications key on your phone.
If your phone does not have that key, press the Services key.

2. If necessary, log into Applications by entering your password.
You will need to log into the Applications area if you have logged out, or if your phone has been logged into a different
extension.
Press the alpha/numeric soft key until it is set to numeric, then enter your password (the same numeric password that
you use to log into the Switchvox User Suite and your Voicemail). When your password is correct, press the Right
Arrow key to highlight Login, then press the Select key (this is probably a Checkmark on your phone).

3. Select the Application that you want to use.
Press the Arrow keys to move up and down in the list of Applications, and press the Select key for the Application
that you want to use.

4. You can log out of Applications at any time. Use the Arrow keys to navigate to Log Out, then press Select.
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Note: Depending on your phone, navigating with the arrow keys might work differently. Also, when you first press the
Applications key on your phone, the display will show the last page that was available. For example, you might see the
profile of your last incoming caller.

The following Switchvox Applications are available:

Directory Access

Directorio Access the Switchvox Directory right from your phone.

Parking Lots
PJ g

Estacionamients V€W @nd pick up parked calls.

@ Phonebooks
Access your Switchvox Phonebooks from your phone.

Agendas
Record Call
e s Record your active call. (Call recordings are found in your Mailbox).
ﬁ Voicemail

View and listen to your Switchvox voicemail.
Buzdn de voz

. Log Out
Diiresd Log out of these Switchvox Applications.

Within each Application, you can use your phone's soft keys.

Home | Exit Refresh Back |

Home
Return to the list of applications.

Exit
Exit Switchvox Applications and return to the default screen for your phone.
Refresh

Refresh the information on the screen. For example, you might press Refresh in Parking Lots, to see if a call was just
parked.

Back
Go back to the previous screen that you used. For example, if you navigated through your Phonebooks to a Phonebook
entry, Back would return you to the list of Phonebook entries.
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Voicemail / Fax

This area lets you set up your voicemail and fax options, and manage incoming and outgoing voicemail and faxes.

Mailbox

Your Mailbox lets you manage your voicemail and faxes in Switchvox.

Settings ¥Yoicemail f Fax Call Histary

Mailbox

Qrganize your voicemail as easily as you aorganize your email, Put voicemails into folders, forw
and delete voicermails from the system.

view Folder: [IMNBOR [2 v m

W& =) v L [agnerwitt 105) v
Recardings [0]
) . ok, [0]

voicemall in 1 Fax (0] o2 of 2

IE o Dirafts [2]

Original Outbos 1] [ Date £

] 101 Sent (0] o Doeson <1023 Thu Mar 19 2009, 10:10:16 AM
1] 101 John Smith <103 Wed Mar 18 2009, 2:10:16 PM

You can access your Mailbox here in the User Suite, or from your desktop email application. See Putting the Mailbox on
Your Desktop for more information about using your desktop email application.

Voicemail

Your voicemail comes into the INBOX folder. Each message displays the original mailbox the message was left in (the
message might have been forwarded to you by a co-worker), the caller ID of the caller (if it was available), the date and
time the message was left, and the duration of the message.

To play or download a message, click its Play button. This marks the message as Read (it is no longer shown as bold,
and the message-waiting indicator light on your phone would go off if this was your only unread message).

To delete messages, or mark them as read or unread, check the box for each message that you want to affect. Then,
click the appropriate icon (at the top of the list). If you delete messages, you are prompted to verify the action. Be sure
that you do indeed want to delete the messages, then click Yes, Delete.

To move messages to a different folder, check the box for each message that you want to move, select the folder where
the messages belong, then click Move To Folder.

To forward messages to another Switchvox user, check the box for each message that you want to forward, select the
extension to forward them to, then click Forward To.

To sort by column in the message list, click the column name.
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Note: You can also manage your voicemail from your phone by dialing the voicemail access extension (default is 899).
Follow the prompts to give your password and check your messages. Or, your phone may have a Messages button that
dials the voicemail access extension for you.

sms| Faxes

Your faxes come into the Fax folder. Your outgoing faxes are stored in the folders Drafts, Outbox, and Sent. The Drafts
folder includes the files that you have printed to your Switchvox fax printer. The Outbox folder includes faxes that
Switchvox is currently trying to send (or was unable to send). The Sent folder includes faxes that Switchvox has
successfully sent.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

To send a fax, check its box (you can only send one fax at a time) then click the fax machine icon (at the top of the list).
You are prompted to enter a fax number. Enter the number for the fax machine you want to send this fax to, then click
Send Fax.

IMPORTANT: When you enter the fax number, be sure to prefix any digits that you normally use to dial out.

Your fax is in the Outbox folder while it is being sent, and moved to the Sent folder when it has been successfully sent. If
Switchvox cannot reach the other fax number to send your fax successfully, it remains in the Outbox folder.

Note: Switchvox sends fax notification email messages. These notification messages show the status of your fax. A
Pending fax is still being sent (a fax may be Pending for a little while if Switchvox has to try multiple times), a Sent fax has
been sent successfully, and a Failed fax was never received by the fax machine at the number you indicated. For details
on setting up fax notifications, see Fax Options.

To preview page 1 of a fax, click Preview.
To view or download an entire fax, click Download. This marks the fax as Read (it is no longer shown as bold).

To delete faxes, or mark them as read or unread, check the box for each fax that you want to affect. Then, click the
appropriate icon (at the top of the list). If you delete faxes, you are prompted to verify the action. Be sure that you do
indeed want to delete the faxes, then click Yes, Delete.

To move faxes to a different folder, check the box for each fax that you want to move, select the folder where the faxes
belong, then click Move To Folder.

To forward faxes to another Switchvox user, check the box for each fax that you want to forward, select the extension to
forward them to, then click Forward To.

To sort by column in the message list, click the column name.

For more information about faxing, see Creating & Sending a Fax.

Putting the Mailbox on Your Desktop

Your Switchvox Mailbox uses IMAP, a protocol that lets your desktop email application access remote messages as if
they were stored on your computer. In this case, it means that you can access your voicemail and faxes in your
Switchvox Mailbox using your regular email application (e.g., Microsoft Outlook or Mozilla Thunderbird).

Your Switchvox Mailbox does not offer outgoing mail service, so if you want to forward a message or a fax, you need to
use your regular email account.

To set up your Switchvox IMAP Mailbox in your desktop email application, you'll need the following information:
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» The IP address or domain name of your Switchvox mail server. This is the same IP or name that you use for the
Switchvox User Suite.

* Your ‘email address,’ which in this case is your extension number, the @ sign, then your IP address or domain
name. For example: 101@ 192.168.0.100, or 101@pbx.mybusiness.com.

* Your‘user name’, which in this case is your extension number.

* Your password, which is the same password that you use to log into the Switchvox User Suite and to collect
your voicemail.

IMPORTANT: If you are having trouble using your Switchvox IMAP account in your email application, check with your
Switchvox administrator. It’s possible that you need to use a different port number than the default (143), or that you need
to set specific security options.

In your email application, start the process to create a new Internet email account. When you are prompted to enter the
type of incoming mail server for the account, choose IMAP. Enter the rest of the information as prompted.

Sample IMAP Setup

The following gives an example of creating an IMAP account in Microsoft Office Outlook 2007, running on the operating
system Windows XP Professional.

1. Open Microsoft Outlook, and select Tools > Account Settings.

The E-mail Accounts window is displayed.

Account Settings [E

E-mail Accounts
You can add or remove an account, You can select an account and change its settings,

E-mail | Data Files || R3S Feeds || SharePoint Lisks || Inkernet Calendars || Published Calendars || Address Eu:u:uks|

g Mew. .,

Marne Tvpe

Close

2. Click New to create a new e-mail account.

3. The Auto Account Setup window is displayed.
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Add Mew E-mail Account

Auto Account Setup

Manually configure server settings or additional server tvpes

< Back

X

[ MNext »

l [ Cancel

4. Check the box for Manually configure server settings or additional server types.

5. Click Next.

The Choose E-mail Service window is displayed.
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Add Mew E-mail Account

Choose E-mail Service

(%) Internet E-mail
Connect ko wour POP, IMAP, or HTTF server bo send and receive e-mail messages.,

() Microsoft Exchange
Connect ko Microsaoft Exchange For access to wour e-mail, calendar, contacts, faxes and woice mail.

) other
Connect ko a server bype shown below,

x]

« Back ” Mext = l [ Cancel

6. Select Internet E-mail.
7. Click Next.

The Internet E-mail Settings window is displayed.
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Add Mew E-mail Account

x]

Internet E-mail Settings
Each of these settings are required to get wour e-mail account warking.,

User Information Test Account Settings

Your Marme: |Ju5tine Kilean | After filling out the information on this screen, we
recommend wau kest your account by clicking the

E-mail Address: |1|:|1@192, 168.0.100 | button below, (Requires network connection)

Server Information

[ Test Accounk Setkings ...

Account Type: | IMAE F |

Incoming mail server: |192| 163.0.100 |

Outgaing mail server (SMTR: | 192.163.0, 100 |

Logon Information

Iser Mame: |1|:,1 |
Password; |***| |
Remember passward

[ ]require logon using Secure Password Authentication (SPA) Mare Setkings ...

< Back ” Mext = l[ Cancel ]

8. Enter your name and your email address in the User Information section.

9. Select the Account Type IMAP, and enter the IP address or domain name of your Switchvox mail server in the Server
Information section.

10Enter your user name and password in the Logon Information section.

Check the box Remember password if you don’'t want to have to enter your password each time you access your
email.

11Click Next.

You're finished adding this account.

Subscribing to Folders

When you have your Switchvox IMAP account set up in your desktop email application, you can manage the same
folders that are in the Switchvox User Suite Mailbox (Voicemail / Fax > Mailbox).

You can ‘subscribe’ to all of the folders, or just the ones you want to use. If you ‘unsubscribe’ to a folder, it still exists in
your IMAP account, it just isn’t shown in your email application. You can always subscribe to it again later.

You can also create folders using your desktop application, and those folders are accessible in your User Suite Mailbox.

To subscribe to your IMAP folders in Microsoft Outlook, highlight your Switchvox IMAP Inbox and select Tools > IMAP
Folders... The IMAP Folders window is displayed, shown here:
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B [MAP Folders B3

Display folders whose names conkain;

| T

Al | Subscribed | Stop
Folders §
Fax (-'\
Faw.Diraftz
Fawx. Outbos
Fau.Sent

oo
nbos P

Inbow. Friends
Inbow. Fecordings
[nbo. ok,

When displaving hierarchy in Outlook, show only subscribed Folders,

[ (04 ] [ Zancel ] Apply

In Mozilla Thunderbird, highlight the account and select File > Subscribe. In either case, a list of folders is displayed that
lets you subscribe and unsubscribe.

Voicemail Options

Your Voicemail Options include setting up your voicemail greetings and defining how you want to receive notifications of a
new voicemail message.

Managing Greetings

Manage Voicemail Greetings lets you set up all of your greetings that might be played to a caller when you don’t answer
the phone. You can upload a sound file from your computer, or record a greeting using your phone.

The default greeting, in every situation, is for Switchvox to read your extension digits and then let the caller record a
voicemail message. You can record or upload your name, and multiple custom messages for when you don’t answer the
phone, or you are already on a call and don’'t answer the phone. If you don’t want to distinguish between those situations,
make sure you have created an Unavailable Voicemail greeting, then check the box under the “Busy” voicemail greeting,
Use Unavailable voicemail greeting.
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Il Manage Voicemail Greetings

Full name.
Thiz recording is used in the cormmpany directory and by the default Unavailable and Busy greetings.

In Use Greeting Mare
{:} Gead Fxtension Digits
® Standard DA .

Record Hew Greeting

"Unavailable" voicemail greeting.

This recording iz plaved to prampt callers o leave you 2 voicernail message when vou do not answer vou

In Uze Greeting Marme
{:} Default Unaraiizbls Message
® Standard DA,

Record Hew Greeting

"Busy" voicemail greeting.
This recording iz played to prompt callers to leave you a voicemail message when vou are already on a ¢

call waiting.

I:l Uze Unavailable voicernail greeting.

In Use Greeting Marme

® Default Busy Message

Record Hew Greeting

Setting Notifications

Voicemail notification options let you customize how you want to receive a notification when you get a voicemail
message. You can set up multiple email addresses, each with an email template and instructions for attaching the
voicemail as a WAV file.

Note: Notification email messages do not synchronize with your Switchvox Mailbox. That means that if you listen to a
voicemail WAV file attached to a notification message, Switchvox does not know that you have ‘read’ the voicemail.
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ﬂ Voicemail Motification Options

El Tell me more about this

Add Hew Hotification Email

# Template Ernail Attach war File Madife/C
1 Default lozal copy Tes m|
2 External justine@mvyhiz.carm Tes m|

I:l Celete local copy of waicernail. IETE“ me more about this

To add a new notification option, click Add New Notification Email. Enter your Email address, select a template, and
select Yes or No to indicate whether or not to attach the voicemail WAV file to the email message.

To edit a notification option, click its Edit button.

To delete a notification option, click its Delete button. You cannot delete the local copy option (that is the copy in your
Switchvox IMAP mailbox), but you can change the template. This is the template that you will see if you subscribe to your
Switchvox IMAP mailbox using your desktop email application.

Delete local copy of voicemail

To delete the Switchvox copy of the voicemail once its sent to your email address(es), check the box Delete local copy
of voicemail. This option lets you handle your voicemail entirely through your own email account.

Managing Notification Templates

Voicemail Email Templates let you customize your voicemail notification email messages. You can create multiple
templates and tailor them to different types of email accounts. These custom templates are available (along with default
templates) when you create or edit a Voicemail Notification Option.

E Voicemail Email Templates

El Tell me more about this
Create & New Yoicemail Email Template

Template Mame: | | Create Hew

View Default Yoicemail Email Templates
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You can use variables in your template that are substituted with real values when the email gets sent. For example, %VM
_CALLERID% in a template prints as the caller's name and phone number. There is a full list of these variables on the
pages where you create or edit a template.

Settings Yoicemail / Fax Call History

Modify Voicemail Email Template {'personal’)
Below you can the customize the email template that gets sent to the user when they reciew

Subject: | SWM_CALLERIDS [eftwou a new WM _DURS: long message

B 7 U =

Crear HWM_MAMESL:

Faormat ~ | Fonk Family = Font size -

tLHTmL|Av—

-—
—

-—

14

Uy

RILAN
"l

You just received a WVYM_DURY long ressage in mailbox 3WM_MAILB DK from %VM_CALLERIDY:, on
You can get this message via the phone, or uze the links below to download the meszage.

Caownload the rmeszage and mark it as read,
DS MLCAD LIRS
Mate: This will rmark it az read in the system,

Download the message and delete it

Irmportant: Thizs will completely rermove the message fram the systern and this link will no langer work,
Do MLCAD_LIME_AND_MARK_DELETED %

Thank you!

--Switchuox

Path:

You can use wariables in yvour template that will be substitued with the real values when the email gets

wariables and a description of their substituted wvalue,

Ta¥WM_MAME%o - Recipient's firstname and lastnare

Sa¥M_DUR% - The duration of the voicermail message

Ta¥WM_MAILBOX% - The recipient's extension

%a¥M_CALLERID® - The caller id of the person who |eft the message

%a¥M_DATE®s - The date and time the rmessage was left

SeDOWNLOAD _LIMK®a - 4 URL to the web admin to download the message

SDOWNLOAD _LINK_AMD_MARK_DELETED % - 4 URL to the web admin to download the messags
recipient's mailbox,

Save Template
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sus| Automatically Forwarding Voicemail

You can automatically forward all of this extension’s voicemail messages to other extensions in Switchvox. This is
helpful for generic extensions such as ‘Accounting,” or ‘Shipping,’ or for queue extensions such as ‘Customer Service.’
Callers can leave messages on one extension, then all of those messages are forwarded to the appropriate people. This
is also useful internally, if you want to send a message to everyone in a group.

To define a specific set of extensions to receive the forwarded voicemail, select Individual Extensions, and move the
appropriate extensions into the box on the right.

To specify an Extension Group to receive the forwarded voicemail, select Predefined Group, then choose an Extension
Group from the dropdown.

To delete each message from this extension’s Mailbox after the message is forwarded, check the box Delete on
Forward.

To send forwarded messages to all of the recipients, choose Send to All from the Forwarding Type dropdown. To send
forwarded messages to one recipient at a time, choose Round Robin. With Round Robin, Switchvox forwards each
message to the next recipient, moving through the list of recipients in the same order as they are listed (in the extensions
box above, orin the Extension Group).

ﬂ Yoicemail Forwarding

IEI Tell me more about this

[] Enable voicemail Forwarding
Individual Extensions

all &vallable Accounts Farward to Mermbers

101 "“Justing Kilean"

102 “Jane Doeson”

103 "John Smith"'

104 "Gilbert Brown'

105 “Agrer Wit

106 "Spencer Flemming'
107 "Mewton Degenhandt
108 " ebster Savage"
103 "Pogep Podolzky'

110 "Orhiz Schugter W

_|:|R_
Predefined Group: | Default Group

TIN5

L

Delete on Forward
Forwarding Type: | Send ba Al
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s Fax Options

Fax Options let you set up your faxing environment. You can enter multiple email addresses to receive notifications of a
new incoming fax, create a fax header, and define this extension as only sending faxes.
You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

Settings ¥Yoicemail f Fax Call History

Fax Options

[I Fax Motification Options (=l

Add Hew Hotification Email

# Ernail Modify/Delete

1 justine@rmvyhiz.com m

E-I Receiving f Sending Options (2]

Ll This extension only sends faxes.

Fax Header |Digur‘n, Inc-T:877.546.8063, F-858.555.1212]

[* Show Advanced Options

$ave Fax Options

Fax Notification Options

Add, Edit, or Delete the email addresses that you want to receive notifications of a new incoming fax.

This is useful if you want to be notified at both your work and personal email addresses, or if you want your administrative
assistant to be notified.
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This extension only sends faxes

If this extension is really a fax machine and won’'t make any voice calls, check the box This extension only sends
faxes.

Switchvox handles all outgoing activity as a fax:

e Print a fax-file
e Putit in the Fax.Outbox folder in that extensions’s Mailbox
» Sendthe fax

Fax Header

Enter a Fax Header to be sent with each fax that you send. For example:

Digium, Inc. | 877.546.8963 | Fax: 858.555.1212

This is the information that is printed along the very top of your fax pages (not to be confused with a cover page).

Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an Advanced
Option, click Show Advanced Options.

Local Station ID
Text string that identifies the sender identification to the remote side of the fax transmission. Default is to leave blank.

Disable Error Correction Mode (ECM) for G711 fax sessions
Disable error correction mode (ECM). The default is to leave this feature enabled.

SMB| Minimum transfer rate for fax transmissions
Minimum transfer rate used during fax rate negotiation. The default minimum transfer rate is 2400.

SMB| Maximum transfer rate for fax transmissions
Maximum transfer rate used during fax rate negotiation. The default maximum transfer rate is 14400.

Number of maximum expected T38 packet delay
Maximum expected T38 packet delay in milliseconds. The result of this specification is all T38 packets are padded to

prepare the fax stack for the specified delay. As long as the packet delay is less than or equal to the specified value, the
fax stack will not realize that there is an actual packet delay because of the packet padding. The default value of 800
milliseconds should cover most use cases.

sws Creating & Sending a Fax

Sending a fax from your desktop computer using Switchvox is a two-step process:
1. Open afile in any application and print it to the Switchvox fax printer.

This stores a copy of the file in your Switchvox Mailbox Fax Drafts folder.
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2. Go to the Switchvox User Suite Voicemail / Fax > Mailbox, select the Fax Drafts folder, and click the fax machine
icon (at the top of the list) to send that file to a fax machine. For details, see Faxes.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

Setting up a Fax Printer

To make faxes for Switchvox, you need to first set up a generic printer that you can use from any application. You only
have to do this once.

Depending on your desktop environment there are many ways to set up a printer, but there is some specific information
that you need to set up a Switchvox Fax Printer:

* ForWindows-based operating systems, the URL is
http://YourDomain:631/printers/faxprinter

Where YourDomain is the domain that you normally use to go to your Switchvox User Suite. This may be an IP
address or a domain name.

» ForLinux- or Macintosh-based operating systems, the URL is
http://ext:password@YourDomain:631/printers/faxprinter

Where ext is your extension, password is the password that you use to log into the Switchvox User Suite or to
collect your voicemail, and YourDoma1in is the domain that you normally use to go to your Switchvox User Suite.
This may be an IP address or a domain name.

» Forany operating system, use a generic postscript printer driver.

Our suggestion for Windows-based operating systems is the driver from

IBM: IBM Network Printer 17 PS. For Linux- and Macintosh-based operating systems you should choose a generic
postscript printer driver.

Sample Printer Setup

The following gives an example of setting up a Switchvox fax printer for a computer running a Windows XP Professional
operating system.

1. From the Start menu, go to Printers and Faxes.

The Printers and Faxes window is displayed.
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‘® Printers and Faxes |-_||

File Edit ‘“iew Faworites  Tools  Help -#

@Back - ,J L‘ﬁ; pﬁearch [EL' Folders *

Address | % Printers and Faxes - | =7

T @
Printer Tasks @ @

Adobe POF Dell Printer 5100cn PS

&dd a Erintet{b
& Set up Faxing

Skark the Add Prinker Wizard, which helps you install a prinker, k

2

Microsoft #PS Docurment
Writer

See Also

2] Troubleshoot printing
Q} et help with printing

Other Places

E» Conkral Panel

'”_-'-l‘h Scanners and Cameras
[E] My Diocurnenks

[ﬂ My Pickures
i My Computer

Details

2. Click Add a Printer.
The Add Printer Wizard is displayed.

Switchvox Administrator Manual



Add Printer, Wizard

Welcome to the Add Printer
Wizard

Thiz wizard helps you install & printer or make printer
connechions.

throwgh & JSE port [or any ather hot pluggable
port, such az [EEE 1394, infrared, and zo on], pou
do not reed to use thiz wizard. Click Cancel to
cloze the wizard, and then plug the printer's cable
into your computer or point the printer toward pour
computer's infrared port, and turn the printer on.
Windowes will automatically install the printer for pou,

\]::J [f wou have a Plug and Play printer that connects

To continue, click Mest,

Mest » l[ Cancel

3. Click Next.

The Local or Network Printer windows is displayed.

Add Printer Wizard

Local or Hetwork Printer
The wizard needs to know which twpe of printer to zet up.

Select the option that describes the printer you want to uze;

() Local printer attached to this computer

(%) & network printer, or a printer attached to another computer

- To zet up a network, printer that iz ot attached to a prink zerver,
\]}) uze the "Local printer option.

< Back ” M et » l [ Cancel

4. Select A Network Printer...
5. Click Next.
The Specify a Printer window is displayed.
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Add Printer Wizard

Specify a Printer
If you don't know the name or address of the printer, you can search for a printer
that meets vour needs.

Wwhat printer do you want to connect to?

) Browse for a printer

() Connect ko this printer [or to browse for a printer, select this option and click Nest):

I arne; | |

Example: Y\serversprinter

(%) Connect ko a printer on the Intamet or on a home or office network:

LURL: |htt|:-: Afpbs. rybiz. com: 5231 .-"printers.-"fa:-cpr|

Example: http://zerver/pnnters/myprinter/. printer

< Back ” M et » l[ Cancel

6. Select Connect to a printer on the Internet or on a home or office network, and enter the following URL:
http://YourDomain: 631 /printers/faxprinter

Where YourDomain is the domain that you normally use to go to your Switchvox User Suite. This may be an IP
address or a domain name.

7. Click Next.

The Configure Internet Port window is displayed.
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Configure Internet Port

Security options

X

() Use anonymaous account

() Automatically uze the windows logon name and password (and
domain if any]

(%) Use the specified user acoount

Uzer Mame |-||:|1 |

FPaszword ||-|||-||| |

[] Use the zame security setting for all users

k. ] [ Cancel

8. Select Use the specified user account, and enter your extension number and your password. This is the same pass-
word that you use to log into the Switchvox User Suite or to collect your voicemail.

9. Click OK.

The manufacturer and model window is displayed.

Add Printer Wizard

‘-. A\ Select the manufacturer and model of vour printer. IF pour prinker came with
an inztallation dizk, click Have Disk. If vour printer iz not lizted, consult pour
printer documentation for a compatible printer.

M anufacturer A Printers e
GCC 5 |BM MNetwark Printer 24 [PCL

g:ztztlﬁer y 3&' |B Metwork Color Printer

HP 5 IBM Network Printer 12 PS5 =
IBM "

infatec b 3&' |Bk Metwark Printer 24 PS5 b

Tell rie why driver sighing is imparkant

Ok, H Cancel ]

10Select IBM from the Manufacturer list on the left, then select IBM Network Printer 17 PS from the Printers list on the
right.
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We suggest this printer driver because it is a widely available, standard printer driver. If you are using a different oper-
ating system, choose a generic postscript printer driver.

The Printer Wizard copies the appropriate files for you and sets up your new printer.
Wait until the Default Printer page is displayed, then go on.

11Select Yes or No, depending on whether you want this to be your default printer. (You probably want to select No).
The final page of the Printer Wizard is displayed.

12Click Finish.

In the Printers and Faxes window, you can see the new printer
faxprinter on http:// YourDomain:631

Sending a Fax

Now that you have your fax printer set up, you can create a fax from any application.

1. Select the Print option from the application that you are using to view this document. (Or any open file that is handy.)
In the Print dialog box, select the new ‘faxprinter’ as the printer to use, and print the file.

2. In your Switchvox User Suite, go to Voicemail / Fax > Mailbox. Select Fax:Drafts from the View Folder dropdown.

Your Fax.Drafts folder is opened, and your drafts are listed. The test page that you printed is in the list, and you can
preview the first page, or download a PDF of the entire fax.

Check the box for your fax, then click the fax machine icon (at the top of the list). You are prompted to enter a fax
number. Enter the number for the fax machine you want to send this fax to, then click Send Fax.

Your fax is in the Outbox folder while it is being sent, and moved to the Sent folder when it has been successfully
sent.

Settings Yoicemail f Fax Call History

Mailboz

Organize your fax as easily as you organize your email, Put faxes into folders, forward fax me
from the system,

view Faolder: | Draftz (1) v|m

W & = L%\ﬂj S Fan ) v| L[ Agnerwit (105) v
Send Fax
Fax in Fax.Drafts fomer—TTto 1)1 of 1
IE Date Created & Source # Pages Preview
Wl wWedMar 18 2009, 2:14:29 PM Fax Printer 1 =] Preview
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Call History

Under the Call History tab are two sections, Call Log and Call Reporting. These allow you to track your phone use.

Call Log

The Call Log is a simple list of the calls that have been made to or by your extension. You can select a date range by
setting the From and To dates. Click View Report to see log in the User Suite, or click Output to .xlIs file to download
an xls file.

By default, a list of all incoming and outgoing calls is displayed. The list includes the call date, who the call was from and
to, the type of call (incoming or outgoing), the call time, and the talk time. If you are viewing the log in the User Suite, you
can mouse over the Call Details to see more details about the call.

Settings Voicemail £ Fax Call History

Call Log

Use this form to view the call history of this extension for a range of dates,

From Date: 03772008 | 75 To Date:|0311 82009 | [

rornyd ddif gy rorny ddfyypy

Yiew Report Quput to .xls file

Calllog (1toa)ofa

Call Date & Call Fram Call Ta Call Type <all Time
03/18/09 3:253:19 PM Justine Kilean <101 Gilbert Brown <104 = outgoing  39s
0371809 3:22:30 PM John Srmith <103 = Justine Kilean <101 outgoing 4=
031809 2:10:15 PM John Smith =103 = Justine Kilean <101 outgoing  53s
03/18/09 2:09:05 PM John Smith =103 = Justine Kilean <101 outgoing  1m, Os
0371809 2:08:00 PM John Smith =103 = Justine Kilean <101 outgoing  1ds
0371809 1:18:25 PM Jane Doeson <102 = Justine Kilean <101 outgoing  10s

Call Reporting

This lets you generate a report about call activity. Call reports are generated for the date-range and criteria that you
specify, and include the information that you specify.
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In the Report fields section you select one or more of the fields you would like included in the report or graph. After you

have chosen the desired fields you

can choose how you want the report broken down. By default the reports are broken

down by date such that a data point is displayed for each day between the From and To date.

You can instead opt to have the report broken down by the Hour of Day, the Day of Week or just one data point for the
whole range by selecting Total Cumulative. When you have finished specifying your criteria, you can opt to have the
report printed to the screen, sent to your desktop as an .xls file or view it in graphical form in a chart.

Settings

Call Reporting

Report Breakdown:

Report Fields:

Woicemail /£ Fax Call History

se this form to generate custorm statistical reports about this extension's call histary.

From Date: (031772008 | 7 To Date: (031872008 | 7

rarnd ddd ey o ddd gy

Tatal Humber of Calls

Total Talking Time
Tatal Call Diuratian

T otal Cumulative {5

By Date
By Hour of Diay
By Day of Week

Total Hurnber af Incaming Callz
Toatal Hurnber af Outgaing Calls

Average Talk Time per Call
Awerage Call Time per Call

Hold down CTRL to select rmultiple items

Yiew Report Quput to .xls file Chart Report
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«» 1he Switchboard

The Switchboard is a graphical display of what’s happening on Switchvox. It shows your own calls, your coworkers’ calls,
call-queue activity, and your parking lot. You can drag and drop to transfer calls, and one click lets you make a call, pick
up calls, record or monitor calls, log in and out of call queues, and more.

In addition to all of the Switchvox interaction, the Switchboard is also ‘Web Aware,” which means that you can integrate
other web applications with your call activity. Built-in panels bring SugarCRM, Salesforce, and Google Maps to the
Switchboard, and you can build custom panels that use the URL of your choice.

To open your Switchboard, click Launch Switchboard (in the upper right corner of your User Suite).

In the upper right of the Switchboard, you can see the number of voicemail messages that you have, new and old. There
is also an Options menu that lets you control your Switchboard.

Your Switchboard lets you have up to 6 active lines on your extension (in the Current Calls panel), regardless of your
phone’s capabilities.

About the Options Menu

The Options menu lets you control what is on your Switchboard, and how it is laid out. It also let you set your status for
your fellow Switchvox users.

Save Layout

Save Layout lets you save your Switchboard layout. The next time you open the Switchboard, the window is the same
size, and the same panels are open in the same place.

Panels

Panels let you open and close all of your Switchboard panels. Each of your Phonebooks is available as a separate panel.

Your Switchvox administrator must give you permission to use many of the features available in the Switchboard Panels.
If you see a feature described here that is not available to you, please ask your administrator.

My Presence

My Presence lets you set your Switchboard presence so that your co-workers can see your status and decide how to
communicate with you.

The Away and Extended Away options let you include a comment so that you can let people know when you might be
back.
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Panels

The Switchboard panels let you see into the activity on Switchvox and manage your calls.

Current Calls Panel

The Current Calls panel displays all of the active calls on your extension, and gives you many options for handling those
calls. You can have as many as six current calls in the Switchboard, even if your handset does not support that many.

Send Call
If you choose not to answer a call, click Send to send the call to your Call Rules. The default rule is to send your calls to
voicemail, so most likely Send means the caller is sent to your voicemail.

Hold & Resume
When you are on a call, one click puts that call on Hold, or Resumes the call.

Note: Resume is not available until you put the call on Hold.

Take Another Call
You can put your active call on Hold, and then answer another incoming call. You can have as many as six current calls in
the Switchboard, even if your handset does not support that many.

Transfer: Assisted & Blind
To transfer a call to someone in your Phonebook, just click the call and drag it from Current Calls to the Phonebook entry.
You can transfer a call at any time, even if you have the call on hold, or the other extension is on an active call.

In an assisted transfer, you would put the caller on hold, call your co-worker to let him know you’d like to transfer a caller,
then complete the transfer. In a blind transfer, you would just drag the call to the Phonebook entry.

Transfer to Voicemail
To transfer a call to your coworker’s voicemail, just click the call and drag it from Current Calls to the Phonebook entry’s
envelope icon. This is handy if you know your co-worker isn’t able to take the call.

Record

When you are on a call, you can click to start and stop a recording of your call. The recording is sent to your voicemail
Mailbox, where you can save or forward it. Don’t forget, it’s up to you to let the other party know that you're recording the
call.
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Current Calls B 2 3 Phonebook E S
Bunches of Flowers <3555373333 = (active) Extended Entries
L Gilbert Brown
l' hald a record L—} (104 |:|'}:|
Inactive Line John Smith <103= @0
& Conway Magee
(115) Ik
d John Smith
(103 dh
Gilbart Brown 104> @0
C_} Jane Doeson
(102) ok
Intercom oy
chat )
m i Call Mobile {a
o ok
& Murphy McCaig
Status: Extended Ssvway (118) s
Yoicemail
Message: Please do not disturb unless it's the President. (333)

Directory Panel

Customer Service
(511]

Add Phonebook Entry

The Directory panel offers you access to all of the extensions in Switchvox. You can click and drag a call to an entry in
the Directory Panel to transfer the call to that extension.

Parking Lot Panel

The Parking Lot panel lets you ‘Park’ a call so that the call can be picked up at a different extension. To Park a call, just
click and drag the call to the Parking Lot panel. Then, you or any of your coworkers can pick up a phone and dial the
Parking Lot extension to be connected to the caller.

An extension must have permission to pick up a parked call.

Profile Panel

The Profile Panel shows you the profile of the extension-owner you are talking to. Profile information can be entered by
the Switchvox administrator, or by the extension owner.

An Extension Profile includes some or all of the following:

Switchvox Adini

Justine Kilean

Account Manaoger

Extension: 101 2 5F
| ocatinn: San Diedn




* Image

* Firstand Last Name
o Title

* Location

» Extension Number

Profiles can be shown in the Switchboard and on a phone that uses a Phone Feature Pack. For details, see Your Phone
Feature Pack.

This panel also offers several one-click options to reach this person:

e Chat
Start a chat with this extension.
- Call

Call this extension. The Switchboard rings your phone, and then when you answer it rings this extension. (You may
be able to set up your phone so that it automatically answer calls from the Switchboard; see Phone Options.)

* Voicemail
Call the voicemail for this extension. The Switchboard rings your phone, and then when you answer it rings this
extension's voicemail box so that you can leave a message. (You may be able to set up your phone so that it
automatically answer calls from the Switchboard; see Phone Options.)

Phonebook Panels

Each Phonebook panel displays the entries in that Phonebook. You can click on any entry to dial that number. Some
extensions can display as Extended Entries, to help you communicate more effectively with that person.

Normal Entries
Normal Phonebook entries show your coworkers’ extensions or your frequently dialed external phone numbers. Each

extension is shown with its Presence information, and you can click on any of these to dial them, like a speed dial button.

Also, Normal entries provide a ‘plus’ icon that includes options to dial that person’s Additional Numbers, chat with him, or
Intercom to him.

You must have permission to use Chat and Intercom. Chat may not be available if for some reason you can’t chat with
that person.

Extended Entries
Extended Phonebook entries have all of the normal extension options, but they also let you do the following with that

extension’s calls:

* Pick up an incoming call

» See who the caller is

» Record the call

» Monitor the call (the callers do not hear you)

* Barge into the call (both callers hear you)

* Whisper on the call (only your co-worker hears you)
You must have permission to use each of these options.

Presence
All Phonebook entries display the person’s Presence, which helps you and your coworkers be selective about what calls

to transfer to each other. An Away or Extended Away Presence can include comments.

Intercom
All Phonebook entries can include the Intercom option, which lets you talk to a coworker through the speaker on his

phone. With Intercom, your recipient doesn’'t even need to pick up the handset to answer your call.
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You must have permission to use this.

Pickup
Extended Phonebook entries can include the Pickup option (the green ‘up’ arrow). One click and your coworker’s
incoming call rings your extension also.

You must have permission to use this.

Record
Extended Phonebook entries can include the Record option. One click records the call, and sends the recording to your

voicemail Mailbox.
You must have permission to use this.

Monitor
Extended Phonebook entries can include the Monitor option. If you monitor a call, the callers cannot hear you.

You must have permission to use this.

Barge
Extended Phonebook entries can include the Barge option. If you barge into a call, both of the callers can hear you.

You must have permission to use this.

Whisper
Extended Phonebook entries can include the Whisper option. If you whisper into a call, the caller cannot hear only (only
the extension owner can hear you).

You must have permission to use this.
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Current Calls @- o Parking Lot
Bunches of Flowers <8535373333 > (holding) Parked At caller Parked
201 Freewave Surfboard:
[l resume (8055551212}
Jane Doeson <10Z> (holding)
ﬂﬂ rezume
Acme Builders =16057223333= (ringing)
CDF send

Inactive Line

Phonebook

Extended Entries

E_} Agner Witt E_]:l Jane Doeson d Morris Madsen
(105) e (102] dk (113) dh

" Justine Kilean <101 =

L'jl Conway Magee E_’; John Smith E_’g Murphy McCaig

(115) b (103 b (116 oL
Gilbert Brown <1 04> @0
E_]:] Gilbert Brown E_]; Moon Bradley ibﬂrtiz Schuster
(104 b (114) b {110) b
John Smith <1 03= @)

Mormal Entries

Yoicemail Customer Service Sales
(599 (611) (612)
E_} Mewton Degenhardt E.]ﬂ Posey Podolsky _5 Harvey Culver
(107] o (109 e T o

add Phonebool Entry

Chat Panel

The Chat panel lets you chat with your Switchvox co-workers. The main page of the Chat Panel offers a list of people you
can double-click to start a chat. Or, enter a Jabber ID and click Start Chat.

You must have permission to use this.

Queue Panels

Each Call Queue panel in your Switchboard contains views into that queue’s activity and statistics for the day.

For queue members, you can log into or out of each queue with one click. Or, you can pause your status and add a
comment, letting your co-workers know why you’re unavailable and when you'll be back.

You must have permission to use this.
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Cuslomer Service 6117 - Todays Call Guevwe Informalion = 9k

Members [ Callers - 1 callers waiting, 2 members an a eall, 2/3 members logged in

Queue Members

semher Caller Call Duration Stabus
1. Justing Kilaan <101 "

2. Jane Doeson <102 Freawave Surfboards <8055551212> 2 mins, 14 secs ="

3. John Smith <103= Acrme Builders <16057223333> 1 rnins, 49 secs ="
Queue Callers

Pl Caller 1D Walt Timea Entered Position

1 Bunches of Flowers <8585373333> 1 rins, 33 secs 1

My Status - Status: Not Logged In, Calls Taken: 0 a2

) This Queua O i Queuas

CRM Panels

These time-saving panels integrate with your CRM application. When a call rings your phone, all of the information for this
customer is displayed immediately, before you even answer the phone!

You must have permission to use this.

Google Maps Panel

The Google Maps panel shows you where your caller is on a map based on area code and prefix. A popup window lets you
scroll through previous callers’ locations.

You must have permission to use this.

Custom Panels

Your Switchvox administrator may have set up custom panels that integrate with Web applications. Ask your
administrator for more information.

Popup URLs

Your Switchvox administrator can write external applications that set a display URL for each incoming call. If this value is
set, then the URL button lights up and clicking it opens a new window with the specified URL. If you want that window to
automatically open when a call comes in, click the green plus sign at the top-right of the panel.
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